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About Introduction
This wiki provides instructions for the installation, conﬁguration and operation of the BlackTrax system.
This version is current as of May 2019.

© CAST Group of Companies Inc., 2002-2019 All rights reserved. BlackTrax, WYSIWYG, CAST Software,
and Autofocus are trademarks of the CAST Group of Companies Incorporated. All other trademarks and
logos are the property of their respective owners. Depending on your product/version, CAST incorporates
source code or libraries which are licensed to CAST and copyright protected. For more information, go to
http://cast-soft.com/third-party-libraries/. 
A BlackTrax License will authorize the use of the BlackTrax system for a restricted number of output
connections based on the type of License that was purchased. For more information, go to Licensing.
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About this Manual
Table of contents:
1 Introduction :
2 Text Conventions :
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Text Conventions
The following text conventions are used in this wiki:
Instructions titles appear in Bold and Orange. For example, "To view a BTCamera’s video feed
in the visible spectrum"
Menus and menu commands appear in Bold and Navy. For example, “To open the window if
closed, go to the View menu and click Cameras.”
User interface elements such as buttons, tools, shortcuts, and dialog boxes appear in Italics and
Medium Blue. For example, “To close the project, click Yes.”
Keyboard keys are indicated in CAPITALS AND BLUE. For example, “To call up the save menu, enter
in the command CTRL+SHIFT+B.”
References to manuals appear in Italics Underlined in Blue. For example, “For an in depth
understanding on BTWYSIWYG and its capabilities, please refer to the WYSIWYG Reference Guide.”
Instructions to direct you to diﬀerent features of the BTSystem or areas in the physical Space are
indicated by being Green and Underlined. For Example “In the Physical Space, take the BTBeacon.”
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6.1.1 Compatible DMX/Ethernet nodes :
6.1.2 Luminex Node Settings :
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BTSensor Installation
Table of contents:
Environment Considerations for BTSensor Installation
Installing a BTSensor Lens
BTSensor Placement and Orientation
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Environment Considerations for
BTSensor Installation
The environment of the Space has a great impact on the capacity of BlackTrax to function as intended.
When you install the BTSystem, always remember the following precautions to limit interference and
make the ideal tracking environment.
Infrared interference: External infrared sources and reﬂections may cause interference with
BTSensors. For best results, ensure the venue is free from sunlight, lights which emit infrared
spectrum, infrared based devices, ﬁre, and highly reﬂective materials. For infrared sources and
reﬂections which cannot be removed from the venue, there are provisions within the software to
mask out the aﬀected areas of the BTSensor's ﬁeld of view.
Note: Infrared interference is more critical during the BTSensor calibration than during
tracking operation. Since the BTSystem looks for a unique signal during tracking, there is
some tolerance for other infrared sources.
Reﬂective surfaces: Reﬂective materials that are present in a venue might reﬂect and mimic a
BTBeacon’s unique LED pulse, creating errors with tracking. Complex objects inside the tracking
area must be covered to block reﬂections. Reﬂective objects outside the tracking area can be
blocked out.
Cabling: Ethernet connected BTSensors are subject to the limitation of Ethernet communication
standards. The total Ethernet connection between any component to the BTServer can not be
longer than 91.44m for BlackTrax to function correctly. This range may be extended with a PoE
switch to link cables together.
Sensor stability: Ensure that the location where you choose to install BTSensors is stable, sturdy
and always stationary. Any movement of a BlackTrax sensor will require recalibration of the entire
sensor system.
Example: If a BTSensor is hung on a truss system which sways, the accuracy and
performance of the BTSystem will be aﬀected. If the sway is small, you can decrease
accuracy in the system and may be able to track with lesser accuracy.
Sensor blocking: Ensure that BTSensors have an unimpeded view of the intended tracking area.
Multiple BTSensors need to see the same area at the same time for tracking to occur. Care should
be taken to ensure temporary objects do not obscure tracking.
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Installing a BTSensor Lens
To install a BTSensor lens
Note: Only used on s250e and Slim 13E sensors.
1. Screw the lens onto the BTSensor with the included plastic lens tensioner between the M12 lens
adapter and the lens itself. Tighten until proper focus is achieved.
2. Once you achieve the desired focus, hold the lens in place while you tighten down the lens
tensioner.

Note: The s250e comes with a spring for the lens instead of a tensioner. No tightening is required for
this lens.
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BTSensor Placement and Orientation
In order for tracking to function correctly, multiple BTSensors must be arranged to have overlapping
ﬁelds of view of the Space. A BTSensor's ﬁeld of view is the part of the Space that is visible through the
BTSensor while the BTSensor is in a ﬁxed position and orientation.
Attention: Sensors must not be installed closer than 1m apart to help ensure optimal sensor calibration.
Good sensor placement and orientation are absolutely critical to proper operation of the BTSystem!
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BTSystem Hardware Conﬁguration
Table of contents:
BTSystem Conﬁguration
Optional Equipment Conﬁguration
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BTSystem Conﬁguration
System Conﬁguration Overview
Hardware modules that connect directly to the BTServer should be located in the same location outside
of the tracking area. BTSensors must be positioned where they will not be disturbed and have the best
unblocked view of the tracking area. TimeKeeper, BTRouter and eSync 2 Controller can be positioned
closer to the tracking space.
The following diagram outlines a typical hardware conﬁguration and demonstrates how all BlackTrax
hardware modules are connected together.
Attention: The Timekeeper and BTRouter Ethernet port are designed only to connect to a commercially
available Power over Ethernet (PoE) network switch. The TimeKeeper and BTRouter are not designed to
be a peripheral device to a Class B personal computer. As such, the Ethernet port shall not be connected
to a Class B personal computer in any operating conﬁguration.

BlackTrax System Conﬁguration Diagram
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Optional Equipment Conﬁguration
Optional Equipment Overview
Depending on your tracking needs, additional components must be connected with the BTSystem. The
following outlines how to connect this optional equipment with the BTSystem.

Tracking with Moving Light Fixtures Diagram
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BTSystem Components
Table of contents:
Standard System Components
BTServer
TimeKeeper
BTRouter
Ferrite Filter
eSync 2 Controller
BTSensors
SLIM 13E
PRIME 41
BTBeacon
BT Smart Charger
Calibration Kit
Calibration Kit functions
Wand Head
Triangular Wand Holder
Telescopic Wand Handle
Ground Plane
Hybrid Power Supply Unit (HPSU)
Lighting Wand
BTCalibration Kit Case
Stringer
Discontinued
eSync Controller
S250e Slim
Power Supply Unit (PSU)
BTServer (Legacy)
TimeKeeper (Legacy)
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Standard System Modules
List of Standard System Components
Note: The quantity of BTSensors, BTBeacons, BTSmart Chargers, and Stringers delivered with a
BTSystem are dependent on each user’s needs and on the individual sale.
(1) BTServer (pre-installed software below)
Hardware secured inside the server
BTX Dongle
Motive Dongle
Pre-installed software
BTWYSIWYG
Motive for BlackTrax
BlackTrax Software Suite
Device Manager
(1) BTRouter
(1) TimeKeeper
Ferrite ﬁlters
(1) eSync 2 Controller*
BNC/RCA Adapter
BTSensors
BTBeacons
Stringers
BTSmart Charger
(1) BTCalibration Kit
(1) BTCalibration Wand Head
(1) BTCalibration Triangular Wand Holder
(1) BTCalibration Telescopic Wand Handle
(1) BTCalibration Ground Plane
(1) BTCalibration Hybrid Power Supply Unit
(1) BTLighting Calibration Wand
(1) Carrying case
Attention: *The original eSync Controller is discontinued.

Not Included Mandatory Components
Category 6 Ethernet cable
Power over Ethernet (PoE) gigabit Switch

Optional Components
DMX/Ethernet Node (for tracking with moving lights)
Additional Power over Ethernet (PoE) gigabit Switches
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BTServer
BTServer 2.0 (Rev 5)

Product ID
Model: BTServer 2.0 (Rev 5)

Physical Characteristics
Width: 48 cm (19")
Height: 9 cm (3.5")
Depth: 48.5 cm (19")
Weight: 15.2 kg (33.5 lb.)

Operating Temperature
0°C - 40°C

Technical Speciﬁcations
BTServer 2.0 (Rev 5):
(2x) Inter Xeon Silver 4110 @ 2.1GHz (3.00 GHz Turbo, 2400 MHz, 11M L3 Cache, 8 Core, 85W)
(2x) 2.5" 480GB SSD SATA in RAID1 on LSI MegaRAID SAS 9341-4i
32GB (8x4GB) RAM (DDR4, ECC, 2666 MHz)
Nvidia GeForce GTX1060 with 6GB GDDR5
100-240VAC, 800W redundant power supply with IEC
(2x) Intel I350 Quad-Port Gigabit Ethernet Controller (1 dedicated, 1 deﬁnable)
Windows 10 IoT Enterprise LTSB 2016

Default User Login
User name: btuser
Note: There is no password associated with the default user account for the BTServer

Default Network Address (Main)
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Default Network Address (Backup)
Note:
The BTServer is built with 2 Network Interface Cards (NIC) with 4 ports on each card, and the
functions are: (see BlackTrax detailed system diagram)
Port 1: BTNet (PoE Switch - Tracking, BTSensors, BT Smart Chargers)
Port 2: RTTrPL and Lighting Input (Network Switch - Lighting)
Port 3: RTTrPM (Network Switch - 3rd Party)
Port 4: BTLink (links to BTServers)
Port 5-8: (User Deﬁned)
Lighting Input and RTTrPL are combined into the RTTrPL port.
BTLink is the network connection link to the other BTServers.
Attention: Windows Remote Desktop Connection should not be used with a BlackTrax system. Security
measures on the BTX dongle installed in the BTServer will prevent it from working. Users should use
TeamViewer or VNC if remote access to a BTServer is required.
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TimeKeeper
TimeKeeper (Rev J) Diagram

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number: BTTKV01

Physical Characteristics
Width: 6.46 cm (2.545")
Height: 7.50 cm (2.951")
Depth: 2.50 cm (0.968")
Weight: 86.64 g (3.056 oz)

Operating Temperature
0°C to +40°C (32°F to 104°F)

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

Status LEDs

Note: The Ethernet status lights on the TimeKeeper are not enabled while the TimeKeeper is in use.
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TimeKeeper Functions
The TimeKeeper is a single wireless access point that uses a proprietary radio system running on the 2.4
Ghz frequencey to send data to all BTBeacons. Data sent includes a signal used to synchronize the
BTBeacons with the BTSensors and conﬁguration commands sent to the eSync Controller via a BNC
cable.

TimeKeeper Transmitter Characteristics
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BTRouter
BTRouter Diagram

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number BTTKV01

Physical Characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)

Operating Temperature
0°C to +40°C (32°F to 104°F)

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoE Network Switch via Ethernet port (No input power via USB port)

Status LEDs
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BTRouter Functions
The BTRouter is a single wireless access point that uses a proprietary radio system running on 2.4 Ghz
frequency to receive data from all BTBeacons. Data received includes BTBeacon button presses, battery
status, conﬁguration details as well as inertial measurement unit (IMU) data. IMU data can be used to
calculate the BTBeacon’s orientation.
Note: Upon delivery of a new BTSystem shipment, the IMU on most of the Beacons included are disabled
by default, and the IMU of the Beacon with ID 1 will be switched on by default to help with Fixture
Calibration.

BTRouter Transmitter Characteristics
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Ferrite Filter
Ferrite Filter Diagram

Product ID
Manufacturer: API
Model number: BF1835

Physical Characteristics
Width: 1.8 cm (0.709”)
Height: 1.96 cm (0.776”)
Depth: 3.48 cm (1.378”)
Center diameter: 0.89 cm (0.354”)
Weight: 15 g (.53 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)
Impedance: 172 Ohm

Ferrite Function
The ferrite ﬁlter is a cylindrical clamp fastened over cables to conform with regulatory standards. A
ferrite ﬁlter must be clamped over any cables connected to the TimeKeeper and BTRouter. Ferrite ﬁlters
should be fastened on any connected cables as close to the respective device as possible.
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eSync 2 Controller
eSync 2 Controller Diagram

Physical Characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/Output & Power
PoE: IEEE 802.3af-2003
Adapter: 12V @ 0.6A power supply
Data: Ethernet

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

eSync 2 Controller Functions
The eSync 2 Controller synchronizes BTSensors so that the shutters of BTSensors open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

eSync 2 Controller Connection to the TimeKeeper
The eSync 2 Controller connects to the TimeKeeper over RCA cable. A BNC/RCA adapter is used to plug
the RCA BlackTrax
into input
Wiki3 of the eSync 2 Controller.
23 of 298
5/14/2019

BTSensors
Table of contents:
SLIM 13E
PRIME 41
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SLIM 13E
SLIM 13E Diagram

Product ID
Model number: CAM-CAM-S13

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 6.86 cm (2.7”)
Height: 6.86 cm (2.7”)
Depth: 2.3 cm (0.9”)
Weight: 320 g (11.29 oz)

Lens & Filter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 56°
Vertical FOV: 46°
Optional Lens: 8.0 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°
Optional Lens: 3.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 82°
Vertical FOV: 70°
Adjustable focus with wave spring assist
850nm band-pass ﬁlter
850nm (Infrared) / 700nm (Visible) Filter Switcher

Image Sensor
Resolution: 1280 × 1024
Frame Rate: 30–240 FPS (100 FPS average usage)
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Accuracy: Sub-millimeter
Latency: 4.2 ms
Shutter type: global
Shutter speed:
Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.9 ms (3,900 µs) at 240 FPS

Input/Output & Power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 8.0 watts

Sensor Status
Front Light Status
The Slim Series sensors have a front LED status light to indicate their current state in relation to the
BTServer. The following table lists the default status light colors.

Back Light Status
The Slim Series sensors also have a status indicator on the back panel and indicates the state of the
sensor only. When updating the software on your BTServer, the sensor may need a ﬁrmware update in
order to communicate to the new version. Firmware updates are automatic when starting the connection
to the BTServer. If you revert back to an older version of the ﬁrmware as well. This process is automatic.

BTSensor Functions
BTSensors are used to view BTBeacon positions in the Space. A BTBeacon's position in 3 dimensions (X,
Y, and Z) can be determined when two or more BTSensors simultaneously have a direct line-of-sight to a
connected Stringer’s LED. This information is then sent to the BTServer.

Attention:
The switch must provide consistent power to every port simultaneously in order to power each
sensor.
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Standard PoE switches must provide a full 15.4 watts to every port simultaneously.
Note that PoE Midspan devices or power injectors are not suitable for Ethernet camera systems.
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PRIME 41
PRIME 41 Diagram

Product ID
Model number: CAM-CAM-P41

Physical Characteristics
Mounting: 0.635 cm (1/4")-20 tripod thread (x2)
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 12.6 cm (4.96”)
Height: 12.6 cm (4.96”)
Depth: 13.6 cm (5.34”)
Weight: 1.45 kg (3.2 lb)

Lens & Filter
Stock lens: 12 mm F#1.8 (wide band AR coated)
Horizontal FOV: 51°
Vertical FOV: 51°
Adjustable focus and f-stop
850nm band-pass ﬁlter

Image Sensor
Resolution: 2048 x 2048
Pixel Size: 5.5 µm x 5.5µm
Frame Rate: 30–180 FPS (adjustable)
Latency: 5.5ms
Shutter type: global
Shutter speed:
Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum:
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8.1ms (8100 µs) at 120 FPS
5.3 ms (5300 µs) at 180 FPS

Input/Output & Power
Data: GigE (1000BASE-T)
Synchronization: Ethernet
Power: PoE or PoE+¹

Attention:
The switch must provide consistent power to every port simultaneously in order to power each
sensor.
Standard PoE switches must provide a full 15.4 watts to every port simultaneously.
Note that PoE Midspan devices or power injectors are not suitable for Ethernet camera systems.
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BTBeacon
BTBeacon Diagram

Product ID
FCC ID: RKT- BTBCV01
IC: 10858A- BTBCV01
Model: BTBCV01P

Physical Characteristics
Case: Plastic with Velcro strap attachments
Width: 4.94 cm (1.945”)
Height: 8.08 cm (3.18”)
Depth: 1.87 cm (.737”)
Weight: 70 g (2.5 oz)

Input/Output & Power
Data: USB, Radio 2.4 (GHz) 10Hz
Power: Rechargeable Lithium-ion Battery, charged by 5V USB
Watt hour: 4.44 Wh normal operation, 5.04 Wh while charging

Operating Temperature
0°C to +40°C (32°F to 104°F)

BTBeacon Status LEDs (During Operation)

Warning: If a BTBeacon experiences a charge error, there could be a potential issue with the Lithium-ion
BlackTrax Wiki

30 of 298

5/14/2019

battery. Discontinue use immediately. For more information about Lithium-ion battery safety see “Health
and Safety Information”. Alternately, no battery may be in the BTBeacon.

BTBeacon Status LEDs (During Boot
Loader Mode)

BTBeacon Functions
Each BTBeacon has three ports, each of which can power a single connected Stringer. When a Stringer is
connected to a BTBeacon’s LED port, the Stringer’s LED will emit infrared light in a unique pattern. These
infrared pulses create a unique ID used to identify BTBeacons. When the LED infrared pulse is seen by 2
or more BTSensors, the positional coordinates (XYZ) for the Stringer LED is calculated by the BTServer.
Position is based on the location of visible Stringer LEDs connected to a BTBeacon. Orientation data (roll,
pitch, yaw) is determined by an internal inertial measurement unit (IMU). The IMU also functions as a
backup for determining the BTBeacon's position. The IMU measures acceleration and rotation.
The BTBeacons have a red power and reset button, and two white auxiliary buttons. The auxiliary buttons
are used during ﬁxture calibration.
The BTBeacon transmits the following data over radio to the BTRouter, which is relayed to the BTServer:
IMU data, button presses, battery status, conﬁguration details, and Stringer IDs.
To enter the BTBeacon into Boot Loader Mode, turn the beacon oﬀ and hold A or B while inserting the
BTBeacon into the BTSmart Charger. This mode is used to update ﬁrmware.

BTBeacon Transmitter Characteristics

BTBeacon Charging Information
A BTBeacon’s rechargeable lithium-ion battery is not fully charged when shipped. Please read the
following instructions carefully:
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Never charge BTBeacon near heat or ﬂammable objects.
The temperature range which the BTBeacon can be charged is 0°C to 40°C (32°F to 104°F).
Charging outside the recommended temperature range may automatically be blocked by the
protection circuitry of the device.
Do not charge or use the BTBeacon if any damage has occurred to the device.
The temperature range over which the BTBeacon’s battery can operate is 0°C to 40°C (32°F to
104°F). Operation outside of this temperature range may damage the performance of the battery
or may reduce its life expectancy.
Battery performance will naturally decay over time. If a battery can not maintain charge for long
periods, even when it is being charged correctly, this may indicate it is time to replace the battery.

BTBeacon Battery Replacement
After a period of time the battery of the BTBeacon will naturally decay through normal use and require
replacement. Contract your BTE for details on replacing the BTBeacon battery.
Attention: Any unauthorized modiﬁcation to the BTBeacon or its battery will invalidate any warranty
claim and may damage the device.
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BT Smart Charger
BTSmart Charger Diagram

Size and Weight
Case: Steel
Width: 15.5 cm (6.1”)
Height: 8.47 cm (3.33”)
Depth: 36 cm (14.17”)
Weight: 2440 g (86.07 oz)

Input/Output & Power
Data: Ethernet, USB
Power: 20 Watt
Voltage range: 100V - 240V
Note: BTSmart Charger Rev 6 is built with a momentary contact type power button with the blue LED
that will light up only after the "boot up" is complete. To turn the device power oﬀ, press the power
button, then wait until the blue LED light turns oﬀ before you disconnect from the power source.

BTSmart Charger Functions
The BTSmart Charger is a device used to recharge the battery of a BTBeacon. BTBeacons are connected
to the BTSmart Charger using the BTBeacon’s USB port. While connected, the BTSystem can read the
status of the battery, regulate charging and maximize battery life. The BTSmart Charger can hold a
maximum of 6 BTBeacons at one time.

BTSmart Charger Conﬁgurations
The BTSmart Charger can be conﬁgured to either be horizontal and sit ﬂat on a desk, or be vertical and
be mounted on a wall.
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Horizontal Conﬁguration Diagram
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Calibration Kit
Table of contents:
Calibration Kit functions
Wand Head
Triangular Wand Holder
Telescopic Wand Handle
Ground Plane
Hybrid Power Supply Unit (HPSU)
Lighting Wand
BTCalibration Kit Case

BlackTrax Wiki

35 of 298

5/14/2019

Calibration Kit functions
BlackTrax Calibration Kit Functions
The Calibration Kit is used for calibrating the BTSensors and Lighting Fixtures position in the Space. The
function of each equipment in the Kit are:
1. The Wand Head is attached to the Wand Handle and connected to the Power Supply Unit.
2. When you move the Wand Head inside the Space, the BTSensors look for active LEDs located on
the Wand Head.
3. When multiple BTSensors see the LEDs on the Wand Head, the BTSystem is able to generate a
measurement point for BTSensor calibration.
4. BTSensors use the measurement point data to determine their position relative to each other.
5. The Ground Plane is connected to the Power Supply Unit and placed in the designated origin of the
Space.
6. The Ground Plane LEDs are used in the BlackTrax system to calculate the BTSensor positions
relative to the origin and the orientation of the Cartesian axes.
7. The Lighting Calibration Wand is used for ﬁxture calibration.
8. The Lighting Calibration Wand can be attached to a BTBeacon instead of a Stringer to extend the
range of a BTBeacon LEDs. This is used to calibrate ﬁxtures in areas that are diﬃcult to reach.
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Wand Head
Wand Head

Size and Weight
Width: 105.92 cm (41.7”)
Height: 26.92 cm (10.6”)
Depth: 2.03 cm (0.8”)
Weight: 715 g (25.22 oz)
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Triangular Wand Holder
Triangular Wand Holder

Size and Weight
Length: 24 cm (9.45”)
Height: 17.5 cm (6.89”)
Width: 4.45 cm (1.75”)
Weight: 420g (14.82 oz)
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Telescopic Wand Handle
Telescopic Wand Handle
Size and Weight
Length: 2.03 cm (0.8”)
Height: 149.86 cm (59”)
Width: 2.03 cm (0.8”)
Weight: 365 g (12.86 oz)
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Ground Plane
Ground Plane

Size and Weight
Width: 76.96 cm (30.3”)
Length: 98.04 cm (38.6”)
Depth: 5.08 cm (2”)
Weight: 1905 g (67.2 oz)
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Hybrid Power Supply Unit (HPSU)
Hybrid Power Supply Unit (HPSU)

Size and Weight
Width: 1.35 cm (0.5")
Height: 0.45 cm (0.2")
Depth: 1.1 cm (0.4")

Power Run Time
High: 1:00
Med: 2:45
Low: 3:15

Notes
1. Most applications (comparable to the previous PSU) use Medium, depending on the size of the
venue and how far the sensors are. You may try out low or high to conserve power or boost the IR.
2. A USB port is available where you can use to charge an external Beacon.
An External Beacon can be charged approximately 90% if the HPSU is fully charged, and the
Beacon Battery is completely out of charge. This assumes no Stringers are attached to the
Beacon.
The HPSU can also be used to extend the life of a Beacon Battery if it is required to run past
its normal usage time. A Beacon with 1 Stringer has approximately 7.5 hours of additional
usage time. Beacons with either 2 or 3 Stringers attached have approximately 1 hour of
additional usage time.

Changing Internal Batteries in the HPSU
Attention: Please use an anti-static mat while being grounded.
Tool Required: *1/16 hex bit key.
To add batteries to the second pack
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Side A

1.
2.
3.
4.

Side B

Remove the 4 screws from Side A using the 1/16 hex bit.
Once the screws are removed, pull the panel away to reveal the interior of the HPSU.
Remove the board half way to expose the attachment for the power switch.
Carefully remove the power switch pin. Pull the pin straight upwards.

Attention: AVOID MOVING THE PIN IN THE DIRECTION SHOWN IN THE PICTURE WITH
ARROWS (below).

5.
6.
7.
8.
9.
10.

Once the pin is removed, push the board back into the HPSU.
Turn the HPSU to Side B and remove the screws.
Remove the HPSU all the way to expose the second battery pack.
Add the batteries.
Tighten the straps.
Reattach the power switch on Side A. Carefully pushing down the pin until it is locked in place.

11. Push the board back into the case, making sure not to pinch any wires on Side B.
12. Close Side A.
To change the pre installed HPSU batteries
1. Remove the 4 screws from Side A using the 1/16 hex bit.
2. Once the screws are removed, pull the panel away to reveal the interior of the HPSU.

Note: HPSU board slides into the bottom slot of the interior.
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3. Carefully pull the board out from the HPSU. You only need to remove the board half way to replace
the batteries.

4. Once you have replaced the batteries, tighten the Velco straps on the batteries.
5. Slowly and carefully push the board back into the HPSU.
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Lighting Wand
Lighting Wand

Size and Weight
Size: 2 m (6.56’)
Weight: 235 g (8.29 oz)
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BTCalibration Kit Case
BTCalibration Kit Case
Outside dimensions: 134.6 x 40.6 x 15.5 cm (53” x 16” x 6.12”)
Weight: (with foam lining only): 11.6 kg (25.57 lbs.)
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Stringer
Stringer Diagram

Physical Characteristics
Cable length: 1.37 m (4.5') Custom sizes are available
Cable thickness: 2.9 mm (0.11")
LED Diﬀuser diameter: 7.93 mm (5/16")
Strain relief: 30 mm (1.18")
Male SMA Connector: 9 mm x 8 mm (0.35" x 0.32")
Male SMA Connector diagram

Stringer Functions
When a Stringer is connected to a BTBeacon LED port, the LED portion of a Stringer will pulse that
BTBeacon’s unique ID signal. The pulse is viewed by BTSensors, sent to the BTServer and used to
calculate the BTBeacon position in the Space.
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Discontinued
Table of contents:
eSync Controller
S250e Slim
Power Supply Unit (PSU)
BTServer (Legacy)
TimeKeeper (Legacy)
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eSync Controller
eSync Controller Diagram

Physical Characteristics
Width: 13.89 cm (5.47”)
Height: 4.09 cm (1.61”)
Depth: 9.25 cm (3.64”)
Weight: 368.54 g (13 oz)
Operating temperature: 0°C to +40°C (32°F to 104°F)

Input/Output & Power
PoE: IEEE 802.3af-2003
Adapter: 12V DC and 3 Amps
Data: Ethernet

Status LEDs
Per port activity status
Master time
External lock
Ethernet link status
Ethernet activity

eSync Controller Functions
The eSync Controller synchronizes BTSensors so that the shutters of BTSensors open and close
simultaneously and in synchronization with the pulsing of LED Stringers attached to BTBeacons.

eSync Controller Connection to the TimeKeeper
The eSync Controller connects to the TimeKeeper over RCA cable. The RCA cable is plugged into the RCA
port of the eSync Controller.
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S250e Slim
S250e SLIM diagram

Product ID
Model Number: BT-S250-15

Physical Characteristics
Mounting: 0.635 cm (1/4”)-20 tripod thread
Operating temperature: 0°C to +51°C (32°F to 123.8°F)
Case: Aluminum and Polycarbonate
Width: 8.1 cm (3.19”)
Height: 8. cm (3.16”)
Depth: 6.76 cm (2.66”)
Weight: 430.91 g (15.2 oz)

Lens & Filter
Stock lens: 5.5 mm F#1.8 (wide band AR coated)
Horizontal FOV: 56°
Vertical FOV: 46°
Optional lens: 8 mm F#1.8 (wide band AR coated)
Horizontal FOV: 42°
Vertical FOV: 34°
M12 Lens Mount
Adjustable focus with wave spring assist
800nm IR long pass ﬁlter with Filter Switcher

Image Sensor
Resolution: 832 × 832
Frame Rate: 30–250 FPS (100 FPS average usage)
Accuracy: Sub-millimeter
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Latency: 4 ms
Shutter Type: global
Shutter Speed:
Default: 0.5 ms (500 µs)
Minimum: 0.01 ms (10 µs)
Maximum: 3.8 ms (3,800 µs) at 100 FPS

Input/Output & Power
Data: Ethernet
Synchronization: Ethernet
Power: (PoE) 15.4 watts
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Power Supply Unit (PSU)
Power Supply Unit (PSU)

Size and Weight
Width: 10.5 cm (4.1”)
Height: 9.8 cm (3.8”)
Depth: 4.57 cm (1.8”)
Weight: 335 g (11.82 oz)

Power
Power: 10 Watt
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BTServer (Legacy)
BTServer (Rev 1-4) Diagram

Physical Characteristics

Technical Speciﬁcations
BTServer Rev 4:
(2x) Intel Xeon Processor E5-2620 v4 (8C, 2.1GHz, 3.0GHz Turbo, 2133MHz, 20MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1
16GB (4x4GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Intel I350 Quad-Port Gigabit
Ethernet Controller
Windows Embedded 8.1 Industry Pro

BTServer Rev 3:
(2x) Intel Xeon Processor E5-2620 v3 (6C, 2.4GHz, 3.2GHz Turbo, 1866MHz, 15MB, 85W)
(2x) 2.5" 512GB SSD SATA in RAID 1 -or- (2x) 2.5" 500GB HDD SATA in RAID 1
64GB (8x8GB) 2400MHz DDR4 RDIMM ECC
NVidia GeForce GTX 1060 -or- NVidia GeForce GTX 960 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Integrated Intel I350 (4x1Gbit) Quad Port Network Card + Additional Broadcom BCM5719 Quad-Port
Gigabit Ethernet Controller
DVD-ROM Optical Disk Drive
Newer Systems: Windows 8.1 Pro; Legacy Systems: Windows 7 Professional

BTServer Rev 2:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 2.5" 500GB HDD SATA in RAID 1
16GB (4x4GB) 1866MHz DDR3 ECC RDIMM
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Intel X520-T2 Dual Port 10GbE Network Interface Card
DVD-ROM
Optical Disk Drive
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Windows 7 Professional

BTServer Rev 1:
(2x) Intel Xeon Processor E5-2620 v2 (6C, 2.1GHz, 2.6GHz Turbo, 1600MHz, 15MB, 80W)
(2x) 3.5" 500GB HDD SATA in RAID 1
4GB RDIMM, 1600MT/s, Low Volt, Single Rank, x8 Data Width
NVidia GeForce GTX 760 -or- Earlier
Dual, Hot-plug, Redundant Power Supply (1+1), 1100W
Broadcom 5720 Quad Port 1Gb Network Interface Card
DVD-ROM Optical Disk Drive
Windows 7 Professional
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TimeKeeper (Legacy)
TimeKeeper (Rev G) Diagram

Product ID
FCC ID: RKT-BTTKV01
IC: 10858A-BTTKV01
Model number: BTTKV01

Physical Characteristics
Width: 5.7 cm (2.245")
Height: 7.11 cm (2.8")
Depth: 2.57 cm (1.013")
Weight: 125 g (4.41 oz)

Operating Temperature
0°C to +40°C (32°F to 104°F)

Input/Output & Power
Data: Ethernet, Radio 2.4(GHz) 10Hz
Power: 48VDC/15.6W from PoeE Network Switch via Ethernet port (No input power via USB port)

Status LEDs

Note: The Ethernet status lights on the TimeKeeper are not enabled while the TimeKeeper is in use.
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TimeKeeper Functions
The TimeKeeper is a single wireless access point that uses a proprietary radio system running on the 2.4
Ghz frequencey to send data to all BTBeacons. Data sent includes a signal used to synchronize the
BTBeacons with the BTSensors and conﬁguration commands sent to the eSync Controller via an RCA
cable.

TimeKeeper Transmitter Characteristics
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General System Information
Table of contents:
BTSystem Information Flow and Connections
BTX Dongle
Saved System Data
FCC Information
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BTSystem Information Flow and
Connections
Introduction
The following diagram outlines how the components of the BTSystem are connected and how data ﬂows
between the diﬀerent modules of the system.

BlackTrax Detailed System Diagram
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BTX Dongle
Embedded inside each BTServer is a BTX dongle which serves two principal uses. The primary function of
a dongle is to act as a key. The dongle is the only way that BlackTrax software will open and operate. The
dongle has dynamic embedded information that controls the level of the software you can open/use, as
well as the expiry date of the Membership Period. A BTX Dongle grants the server access to the
BlackTrax software package as well as a custom version of WYSIWYG for BlackTrax. The expiry date for
the BTX dongle is set for April, 2021.
Secondly, a dongle is a security device used by CAST to prevent unauthorized use of the software and
protects an End User's work as well as their investment in the Product.
Attention: Windows Remote Desktop Connection should not be used with a BlackTrax system. Security
measures on the BTX dongle will prevent it from working. Users should use TeamViewer or VNC if remote
access to a BTServer is required.
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Saved System Data
In BlackTrax, when system information is saved, the information is saved to a general folder on the
BTServer. Information saved this way includes conﬁguration ﬁles and system lists from sub-processes.
By default this folder can be found at the following location, depending on your server version and
BlackTrax release version:
All BlackTrax Servers running v2.0.0 or later - C:\bt_run_time
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FCC Information
Important FCC Information
These devices comply with Part 15 of the FCC Rules. Operation is subject to the following conditions:
1. This device must not cause harmful, interference, and
2. This device must accept any interference received, including interference that may cause
undesired operation.
This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to Part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference. This equipment generates, uses and can radiate radio frequency energy and, if not installed
and used in accordance with the instructions, may cause harmful interference to radio communications.

Certiﬁcate Numbers
Model BTTKV01: Radio Cert. No.: IC: 10858A-BTTKV01
Model BTBCV01P: Radio Cert. No.: IC: 10858A-BTBCV01
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Not Included Mandatory Components
Attention: BlackTrax requires additional components to function which are not included with purchase
of the BTSystem.
Category 6 Ethernet Cabling
Power Over Ethernet Gigabit Switch for BTSensors
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Category 6 Ethernet Cabling
All Ethernet cabling used to connect the system components together must be of Category 6 (Cat6)
quality or greater. Cat6 is necessary for the transmission of data at gigabit speeds, which is required by
BlackTrax. The amount of cable needed will vary depending on the Space dimensions and user needs.
Attention: The maximum allowed length of a Cat6 cable is 91.44 meters. Cat6 standards should be
followed when connecting modules together to ensure the BTSystem operates as intended. This range
can be extended by using Gigabit switches to connect Cat6 cable of 91.44 meter length or less.
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Power Over Ethernet Gigabit Switch for
BTCameras
BlackTrax requires a dedicated Power over Ethernet (PoE) gigabit switch or dedicated virtual local area
network (VLAN) to connect all the BTSensors with the rest of the system. The switch should have the
following:
A PoE gigabit switch.
A PoE port for each BTSensor, plus 4 extra to connect to the TimeKeeper, BTRouter, eSync
Controller and BTServer.
PoE switches must support 15.4 watts per Ethernet port.
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Optional Components
Depending on the purpose of tracking, you may need additional hardware components that are not
included with the BTSystem.
DMX/Ethernet Node for Tracking with Moving Lights
Compatible DMX/Ethernet nodes
Luminex Node Settings
Common ArtGate Node Setup Guide
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DMX/Ethernet Node for Tracking with
Moving Lights
Table of contents:
Compatible DMX/Ethernet nodes
Luminex Node Settings
Common ArtGate Node Setup Guide

Merging Channel:
The merging channel is a single DMX channel that is patched into your lighting console to
enable the control of moving ﬁxtures from BlackTrax.
The merging channel can be a dimmer channel that controls intensity fading between BlackTrax
and the lighting console, or as a simple non-dim On/Oﬀ control.
The merging channel must be patched in your console and set as the trigger channel in your merge
node.
When the merging channel is at full (100%) intensity, BlackTrax has complete control over the
channels connected to the BlackTrax project. When the merging channel is at zero (0) intensity, the
lighting console has full control over the channels in the BlackTrax project.
In the Project Properties widget in BlackTrax, you can activate and set the monitoring of the Merge
Channel that was set in your merge node.
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Compatible DMX/Ethernet nodes
To connect BlackTrax downstream to a lighting console, a DMX to Ethernet/Ethernet to DMX node is
required. The following nodes have been tested and are approved to work with BlackTrax:

Luminex
Luminex Ethernet-DMX2/Truss MkII
Luminex Ethernet-DMX4 MkII
Luminex Ethernet-DMX4/ Truss MkII
Luminex Ethernet-DMX8 MkII
Luminex Ethernet-DMX8/ Truss MkII

Sundrax
Sundrax ArtGate Pro
Sundrax ArtGate DIN
Sundrax ArtGate Board
Sundrax ArtGate Compact
Sundrax ArtGate Solid
Sundrax ArtGate Arma
Sundrax ArtJet Pro
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Luminex Node Settings
The Luminex Ethernet DMX nodes must be conﬁgured to work with your BlackTrax system.
Attention: The following guide outlines how each variable should be set for use with BlackTrax. Each
BlackTrax event is unique. There are circumstances where these settings need to be modiﬁed based on
factors such as the rig, cabling, and patching.
Setup the node through the web interface. Please ensure your IP settings match that of the node(s) you
wish to conﬁgure. There are 2 ways to conﬁgure your node to work with BlackTrax:
1. To merge RTTrPL with an Art-Net or sACN universe via the 5-pin DMX ports.
2. To have the merged data be rerouted to another universe over the network (for example, when
other nodes are being used downstream of your Luminex nodes).
To conﬁgure a node to merge and send data via the DMX ports
1. To navigate to the web interface, enter the IP address of the node in your browser window.
2. Under Setup, click on the desired node you wish to conﬁgure.
Note: The 8 port nodes will appear as multiple 4 port nodes in the interface.
3. For the desired ports, choose Output as the Direction, and Custom for IP Merging.

Result: A blue box appears beside the number for the output after IP Merging is set to
Custom.
4. Click on this blue box beside the number for the output.
Result: The Conﬁg Outlet window for that output appears.

5. Set the universes you wish to merge. Source one chooses the DMX protocol, with a universe, and
source two chooses the RTTrPL universe.
Notes:
RTTrPL universes start from universe 0 instead of 1.
RTTrPL must be source 2.
6. Change the Mode to be X-Fade, set the trigger channel to be the same as your merging channel,
and then click Set default mode.
7. Click Submit Changes.
Result: That output will be conﬁgured as expected. If you select Show table, you should see
the channels have all changed to X-Fade, with a trigger of the speciﬁed channel.
8. Repeat the above for all outputs you wish to conﬁgure on the node.
9. Click Submit Changes.
10. Navigate to the Global tab under Setup. Set Enable Trigger to DMX, and the universe to whichever
universe your Merging Channel is patched to, with the desired DMX protocol.
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To conﬁgure a node to reroute merged data to send to other DMX nodes
Note: It is recommended that the reroute is done to a universe which is diﬀerent than the universes from
the console and BlackTrax. For example, if you are merging sACN universe 1, with RTTrPL universe 1, you
might re route the merged data to sACN universe 101.
1. To navigate to the web interface, enter the IP address of the node in your browser window.
2. Under Setup, click on the desired node you wish to conﬁgure.
Note: The 8 port nodes will appear as multiple 4 port nodes in the interface.
3. For the desired ports, choose Output as the Reroute, and Custom for IP Merging.

Result: A blue box appears beside the number for the output after IP Merging is set
to Custom.
Result: The port will now have an arrow leading to a box to specify the new universe to
reroute the merged data on.
4. Click on this blue box beside the number for the output.
Result: The Conﬁg Outlet window for that output appears.

5. Set the universes you wish to merge. Source one chooses the DMX protocol, with a universe, and
source two chooses the RTTrPL universe.
Notes:
RTTrPL universes start from universe 0 instead of 1.
RTTrPL must be source 2.
6. Change the Mode to be X-Fade, set the trigger channel to be the same as your merging channel,
and then click Set default mode.
7. Click Submit Changes.
Result: That output will be conﬁgured as expected. If you select Show table, you should see
the channels have all changed to X-Fade, with a trigger of the speciﬁed channel.
8. Repeat the above for all outputs you wish to conﬁgure on the node.
9. Click Submit Changes.
10. Navigate to the Global tab under Setup. Set Enable Trigger to DMX, and the universe to whichever
universe your Merging Channel is patched to, with the desired DMX protocol.
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Common ArtGate Node Setup Guide
DMX nodes of the ArtGate family of models must be conﬁgured to work with your BlackTrax system.
Attention: The following guide outlines how each variable should be set for use with BlackTrax. Each
BlackTrax event is unique. There are circumstances where these settings need to be modiﬁed based on
factors such as the rig, cabling and patching.
Setup the node through a web interface, or setup the node through a BlackTrax server. Please ensure
your IP settings match that of the node(s) you wish to conﬁgure.
To conﬁgure a node
1. To navigate to the ArtGate model's web interface, enter the IP address of the node in your browser
window.
Result: The Main Settings window of the ArtGate model appears.

2. On the Main tab, scroll down to the Ports section.
3. For each DMX port that you want to use:
1. Set Mode/merging column to Out/ComXFade.
2. Set Pri.unv.protocol column to the desired protocol (Art-Net or sACN).
3. Set the Pri.unv.number column to the desired universe.
4. Set the Sec.unv.protocol to RTTrPL.
5. Set the Sec.unv.number to the corresponding RTTrPL universe.
4. Click Save Settings at the bottom of the page.
5. Click the Advanced tab on the main toolbar at the top of the page.
Result: The Advanced port settings window appears.

6. Scroll down to the Advanced Port Settings section.
7. For each DMX port that you set on the Main tab:
1. Set the Trigger/XFade unv.protocol column to the desired protocol for the merge channel
(Art-Net or sACN).
2. Set the Trigger/XFade unv.number column to the universe which contains the merge
channel.
3. Set the Common Trigger/XFade control channel to the chosen DMX merge channel in the
above universe.
8. Click Save Settings at the bottom of the page.
Notes:
RTTrPL universes start from universe 0 instead of 1.
Information updated as per ArtGate Pro ﬁrmware version 4.06.
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System Procedures
Table of contents:
Licensing
Charging BTBeacons
Replacing a BTBeacon's Lithium-Ion Battery
Installing Third Party Software
Server Failover
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Licensing
Licensing Overview
BlackTrax includes a licensing security system to authorize hardware devices on the BlackTrax Network.
Unrecognized devices on the BlackTrax Network are not compatible with the software. An unrecognized
device is any device on the BlackTrax Network that was not sold directly to you by CAST Software.
A BlackTrax License will authorize the use of the BlackTrax system for a restricted number of output
connections based on the type of License that was purchased. The number of output connections allowed
for each type of License varies from a minimum of 1 output connection and up to a maximum of 12
output connections, or the non-restricted Unlimited License.
The number of output connections that is authorized with the BlackTrax License is indicated in the About
BlackTrax dialog box.

Notes:
The default License Folder location is: C:\bt_run_time\license. Licenses can be downloaded from the
BlackTrax Members Only Downloader which can be found at this link. 
You need to update your license if you have added new hardware devices to the network and
received an error message in BlackTrax.
You need to upgrade your license if you want to add output connections for additional unicast
outputs.
Attention: BlackTrax Licenses purchased before BlackTrax Release Version 2.2.3 will automatically
convert to the Unlimited License.
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Charging BTBeacons
Charging Overview
BTBeacons are charged using the BTSmart Charger. BTBeacons can be connected to the BTSmart
Charger using the Mini USB port found on the side of the BTBeacon.
Attention:
The Mini USB port of the BTBeacon is not designed to be a peripheral device to a Class B personal
computer. As such, a user shall not connect the USB port to a Class B personal computer during
normal operation.
The sole power source of the BTBeacon is the internal 3.7V rechargeable Lithium-ion battery. The
BTBeacon does not require a connection at the Mini USB port to operate.
To charge a BTBeacon using the BTSmart Charger
Connect the BTBeacon to the charge station via the Mini USB port found on the side of the BTBeacon.
Result: The BTBeacon is charging. To determine when the BTBeacon is fully charged, see BTBeacon
status LEDs (During operation).
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Replacing a BTBeacon's Lithium-Ion
Battery
BTBeacon Lithium-ion Battery Overview
After extensive use the lithium-ion battery in a BTBeacon may no longer operate and be unable to power
the BTBeacon. The lithium-ion battery’s life cycle is at its end if the lithium-ion battery will not hold a
charge and the BTBeacon will not power on. When this occurs, it is recommended that the lithium-ion
battery inside the BTBeacon be carefully replaced with a new lithium-ion battery.
Attention:
Only use lithium-ion batteries supplied by CAST. It is recommended that batteries be changed
every 6 months to ensure optimal performance.
The following are required when replacing a BTBeacon’s battery:
Replacement battery
3/8” Hex key
Adhesive tape
To replace a BTBeacon’s battery
1. On the BTBeacon, hold down the red Power button for 2 seconds.
Result: The BTBeacon will power oﬀ. No lights on the unit will be on.
2. Turn the BTBeacon over. Using a hex key, remove the 3/8” screws holding the case together.
3. Carefully separate the two halves of the BTBeacon case. There is a ribbon cable connecting the
motherboard in one half of the case, to the lithium-ion battery in the other half of the case.
4. Disconnect the ribbon cable from the motherboard.
5. The lithium-ion battery is attached to the case with adhesive tape. Gently remove the battery free
from the case.
Attention: When removing the battery, use soft tools and take care to not puncture or
damage the battery casing.
6. Properly dispose of the old battery.
7. Take a new battery and adhere it to the inside of the case.
Note: The adhesive tape must be heat resistant to function properly.
8. Connect the ribbon of the new battery to the motherboard.
9. Join the halves of the BTBeacon case and close the unit.
10. Fasten screws to the back of the BTBeacon case, sealing it.
11. Press the Power button down.
Result: The lights of the BTBeacon will ﬂash and the unit will turn on. The BTBeacon’s
battery has successfully been replaced.

Opening the case to remove the battery
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Disconnecting the ribbon cable

Adding new double sided tape, and insert new battery

Reconnecting the ribbon cable

Closing the case
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Installing Third Party Software
The BTServer is a closed system. Circumventing the security measures in place on the BTSystem for any
reason, including the installation of third party software on the BTServer, is explicitly not permitted.
Circumventing the security of the BTSystem will immediately void the warranty.
This policy is in eﬀect to protect the performance and stability of the BTSystem. Having third party
software installed might adversely aﬀect the BTSystem.
Note: If third party software must absolutely be installed on the BTSystem, please contact CAST or your
local BTE for a possible solution. If a BTE or CAST deems the software acceptable, they may arrange to
install it for you.
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Server Failover
In the event a user needs to switch from their main BT Server, to a backup BT Server, the following
procedure should be followed.
Note: Users should keep a backup of their related show ﬁles in the event they need to switch servers
during operation. Users can easily do this using BTBackup on their servers, or by manually copying the
ﬁles to a USB stick.
1. Only 1 instance of Motive, as well as BTEngine should be present on the network at any given time.
Therefore, the backup server should not have these modules open, or be disconnected from all
networks until needed.
The BlackTrax GUI, and BTWYG can be opened, with their ﬁles loaded on both servers at the
same time.
2. In the event of needing to switch servers, ensure the main BTServer has been disconnected from
it's associated networks.
3. On the Backup server, Launch Motive, with the correct ﬁle.
4. In the BTGUI launch BTEngine and Apply Changes.
From this point the show should be running as expected from the Backup Machine. Optionally, users
could have all modules and ﬁles running on the Backup Machine, with it completely disconnected from all
networks until the time of failover.
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BTWYSIWYG For BlackTrax
Table of contents:
1 Preparing the BTWYG ﬁle :
1.1 Introduction :
1.2 Creating a BTWYSIWYG Project :
1.3 Saving the BTWYSIWYG Project :
1.4 Requirements for Creating the Space in BTWYSIWYG :
1.5 Deﬁning a Common Origin in BTWYSIWYG :
1.6 Creating the Venue in BTWYSIWYG :
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BTWYG Introduction
BTWYSIWYG is an award-winning program that oﬀers lighting designers a customized 3D CAD, reporting
and pre-visualization application which is included in the BlackTrax software suite. Using BTWYSIWYG will
let you create a virtual representation of the Space.
BTWYSIWYG exports this information as a .btx ﬁle, which is then used by BlackTrax as a blueprint for
tracking in the Space. If you are tracking with moving ﬁxtures, ﬁxture position and patching must also be
included in the .btx ﬁle.
When connected to BlackTrax, BTWYSIWYG can act as a visualizer for what is happening in the Space.
Trackable and ﬁxture movement can be fully simulated, using information from BlackTrax or other data
sources.
The following section on BTWYSIWYG covers only the features directly related to BlackTrax. For an indepth understanding of BTWYSIWYG and its full capabilities, please refer to the current WYSIWYG
Reference Guide.
Tip: A registered BlackTrax Expert can be consulted to assist with any portion of a BlackTrax project,
including transferring information from BTWYSIWYG to BlackTrax.
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Creating a BTWYSIWYG Project
Creating a BTWYSIWYG Project from BlackTrax
When a new BlackTrax project is launched from the Portfolio Manager for the ﬁrst time, a new
BTWYSIWYG project associated with the launched BlackTrax project is automatically created and opens
by default.
When a new BTWYSIWYG project is created from BlackTrax, all necessary settings and conﬁgurations are
automatically applied to that new BTWYSIWYG project. These template projects simplify the setup
process for BTWYSIWYG on new installations.
Creating and launching the new BTWYSIWYG project from the BlackTrax Portfolio Manager will
automatically start BTWYSIWYG in a state that is ready for BlackTrax use.
In the Editing section of the System Conﬁguration widget in BlackTrax, you can set the BTWYSIWYG ﬁle
to automatically open after the associated BlackTrax ﬁle launches from the Portfolio Manager.
See Editing section for more details.
Notes:
We recommend creating and launching the new BTWYSIWYG project from the BlackTrax Portfolio
Manager which is more convenient than having to manually create the new project and settings in
BTWYSIWYG.
The BTWYSIWYG ﬁle associated with a BlackTrax project can also be launched via the BTWYG
option under the Modules menu.

Creating a New BTWYSIWYG Project
in BTWYSIWYG
The New command creates a new show document and will be saved as a ".wyg" ﬁle.
To create a new BTWYSIWYG project
1. In BTWYSIWYG, on the Welcome Screen, click File to choose New.
Result: The BTWYSIWYG opens a new show ﬁle in CAD.

BTWYG Welcome Screen
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Saving the BTWYSIWYG Project
Once you have all the information on the Space that was created in BTWYSIWYG, the information must
be saved as a BTWYSIWYG project ﬁle (.wyg). Save will save the open BTWYSIWYG project to the same
ﬁle name and location under which it was previously saved. If you are saving the project for the ﬁrst
time, this command will perform Save As..., which will save the current project with a new ﬁle name
and/or a new destination.
To save the BTWYSIWYG project using Save
1. In BTWYSIWYG, from the File menu, choose Save.
Result: The Save as window appears.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
To save the BTWYSIWYG project using Save As...
1. In BTWYSIWYG, from the File menu, choose Save As.
Result: The Save as window appears.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
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Requirements for Creating the Space in
BTWYSIWYG
To use BlackTrax you are required to create a virtual representation of the Space in BTWYSIWYG. This
virtual Space will possess vital information that BlackTrax requires as follows: what the dimensions and
tracking area of the Space are, what objects or people you want BlackTrax to follow (Trackables), and
information on devices in use (e.g., ﬁxtures). This section will guide you on creating the Space in
BTWYSIWYG and aspects that must be included.
To create the BTWYSIWYG ﬁle for tracking with moving ﬁxtures in BlackTrax, follow these
mandatory steps
1. Deﬁne a common origin position in the Space. (Default set in template ﬁle.)
2. Create and patch Trackables to a motion universe and assign avatars. (Default set in
template ﬁle.)
3. Hang moving ﬁxtures approximately where they will be in the venue with the correct orientation.
4. Patch ﬁxtures to DMX universe and assign Spot IDs.
5. Patch DMX universes to console. (Default set in template ﬁle.)
6. Patch all created universes to BlackTrax. (Default set in template ﬁle.)
7. Save the BTWYSIWYG project.
8. Export the BTWYSIWYG project for use with BlackTrax. (Default set in template ﬁle.)
Tip: Some of the required steps are set by default when the BlackTrax Template ﬁle is used in
creating a BlackTrax Portfolio, or from the Templates section in BTWYSIWYG.
To create the BTWYSIWYG ﬁle NOT for tracking with moving ﬁxtures, follow these mandatory
steps
1. Deﬁne a common origin position in the Space. (Default set in template ﬁle.)
2. Create and patch Trackables to a motion universe and assign avatars. (Default set in
template ﬁle.)
3. Patch all created universes to BlackTrax. (Default set in template ﬁle.)
4. Save the BTWYSIWYG project.
5. Export the BTWYSIWYG project for use with BlackTrax. (Default set in template ﬁle.)
Tip: Some of the required steps are set by default when the BlackTrax Template ﬁle is used in
creating a BlackTrax Portfolio, or from the Templates section in BTWYSIWYG.
BTWYG ﬁle with patched ﬁxtures and a trackable
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Deﬁning a Common Origin in
BTWYSIWYG
Origin Introduction
Most objects in BTWYSIWYG are drawn as 3D objects, with width, depth, and height values using the
Cartesian coordinate system of 3 working axes, X, Y, and Z. The point where the 3 axes meet is called
the origin and the value of X, Y, and Z is 0 respectively (0,0,0).
By default, the origin will be in the center of the WYSIWYG project. This default origin is called the
Document Origin. It is possible to move the origin from its default location to a new position. This origin is
called the User Origin.
CAD mode with a frame representing the default origin

Origin Requirements
The location of the origin is recommended to be inside the Space.
The origin should be easy to see and determine in the Physical Space.
The origin in the Physical Space needs to be visible to at least 2 BTSensors for BTSensor calibration
to function.
The location of the origin needs to be consistent. The origin needs to be the same in the
BTWYSIWYG virtual Space, in Motive, in the Physical Space and any Third Party Programs
connected to BlackTrax. Inconsistencies will cause errors in the BTSystem and any connected
downstream technologies.
The alignment of the ground plane in relation to the axes needs to be the same in the BTWYSIWYG
virtual Space, in Motive, and in the Physical Space. It is recommended that the following
conventions are followed when aligning the origin:
The +Y axis directed Upstage.
The +X axis is directed Stage Left.
The +Z axis is directed vertically towards the ceiling.

Ruler Tool
The Ruler Tool helps you design your show ﬁle in the Wireframe views of the CAD mode, providing a
visual aid for coordinate reference and measurement. By default, the ruler is aligned with the document
origin and displays coordinate information along the top and left side of the view. Its scale matches the
default grid scale. The ruler has diﬀerent colors to represent diﬀerent axes (X=Red, Y=Green, Z=Blue).
X Axis Ruler
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Y Axis Ruler

Z Axis Ruler

Ruler Icons
Document Origin: The document origin icon appears when the Ruler’s zero position (origin) is aligned
with the Document Origin, which is set by default to be the center point of the BTWYSIWYG venue
deﬁned for the event.
Document Origin Icon
User Origin: The user origin icon appears when you have set a new User Origin for the ﬁle.
User Origin Icon
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Creating the Venue in BTWYSIWYG
Using the tools in BTWYSIWYG’s CAD mode, create an accurate scale representation the venue Space is
in. The suggested minimum level of detail is that it contains the ﬂoor, the walls and any pipes, trusses or
structural frames in which BTSensors or moving ﬁxtures will be attached. The more detailed the venue,
the better looking and accurate the visualization will be.
Attention: Fixtures need to be attached to pipe or truss to be inserted. You may also insert ﬁxtures on
the ﬂoor, but you won't be able to spin them using Fixture Properties.
Note: Due to the complexity of recreating an accurate representation of a venue, refer to the WYSIWYG
Reference Guide’s chapter on The CAD environment for a thorough understanding.

BlackTrax Wiki

85 of 298

5/14/2019

Creating Trackables in BTWYSIWYG
Trackables are objects or people that are to be tracked. A Trackable can be represented by a library
object from the Library Browser, or on a drawn object like a sphere or riser. Trackables are created on
the Trackables/Motion layer by default.
Important Notes:
Trackables are automatically named and patched when created.
By default, when a New Portfolio is launched from BlackTrax, BTWYSIWYG opens with 12
Trackables.
To create a trackable in BTWYSIWYG
1. In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BT Trackable.
Result: The Enter new Axis name window appears.

2.
3.
4.
5.

In the Enter new Axis name window, click the layer for the Trackable from the Layer drop-down list.
You can also select the checkboxes to enable the other options for the layer display.
Click OK.
On your drawing, click where you wish to place your Trackable.
Result: A Trackable object appears where the mouse was clicked. The Trackable object is
represented as a Cartesian axis.

To add a library object to your trackable
1. In BTWYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.
2. From the LIBRARY menu, choose Browse Library.
Result: The Library Browser window appears.
3. At the bottom of the Library Browser window, click the Library items tab to display the contents.
4. Navigate to the desired object you wish to represent a Trackable.
Note: The actual look of the Trackable is purely cosmetic and will only represent the
Trackable's position in the visualization.
5. At the top of the Library Browser, click the Insert tool.
Tip: You can also double-click the object name.
6. To insert the object, click on your drawing to place the object where you want in relation to the
Trackable.
Tip: You should place the object relative to the drawn Trackable where the stringers will be
on your physical tracked object. The object will then move and rotate around the centroid of
the Trackable.
7. To stop inserting the object, right-click on the drawing and select Finish Library Item from the
menu that appears.
8. Right-click on the Trackable object you inserted on the drawing.
9. From the menu that appears, select Properties.
10. On the General tab, from the Attach to Axis drop-down list, select the Trackable object you wish to
assign the Library object to.
11. Click OK.
Result: The Trackable is represented as the inserted object and its motion is associated with the
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BTTrackable.

Trackable object with a person attached

Note: The BlackTrax Template ﬁle has one Trackable and avatar created and patched by default. It is
possible to create multiple Trackables at once using the array tool in BTWYSIWYG, and this created
Trackable. See the Array section in the WYSIWYG Reference Guide for more information.
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Patching Trackables in BTWYSIWYG
Patching Trackables Introduction
Important Note: As of BlackTrax v2.2, the Quick Motion Patch Tool is no longer required to patch
Trackables because Trackables are automatically named and patched when inserted.
Trackables that are created need to be patched to a Motion Universe. The patch allows the visualization
of Trackable movement in BlackTrax. This section shows how to easily patch Trackables using the Quick
Motion Patch Tool, as well as the manual way to patch each Trackable.
Note: Read the WYSIWYG Reference Guide’s chapter on Data mode for a complete understanding of
patching manually assigned Trackables.

Quick Motion Patch Tool

Patching Trackables Using Quick Motion Patch Tool
To patch all trackables using the quick motion patch tool
1. From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.
2. Under the Auto-Patch Motion section, ensure that All Trackable/Axes is selected.
3. Click Patch.
Note: If the motion universe BT-Trackables does not yet exist in the ﬁle, BTWYSIWYG will
ask in a dialog box if you wish to create it. In the dialog box, click Yes to create the motion
universe.
Result: The Trackables are patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.
4. Click Close.
To patch only selected trackables using the quick motion patch tool
1. Select all Trackables you wish to patch in one of the wireframe views.
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not
the Trackable object itself.
2. From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.
3. Under the Auto-Patch Motion section, ensure that Only Selected Trackable/Axes is selected.
4. Click Patch.
Note: If the motion universe BT-Trackables does not yet exist in the ﬁle, BTWYSIWYG will
ask in a dialog box if you wish to create it. In the dialog box, click Yes to create the motion
universe.
Result: The Trackables are patched to the motion universe. The total number of Trackables
patched will be reported at the bottom of the window.
5. Click Close.
To clear all trackables' patch using the quick motion patch tool
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1. From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.
2. Under the Clear Motion Patch section, ensure that All Trackable/Axes is selected.
3. Click Clear.
Result: All Trackables are unpatched from the motion universe. The total number of patched
Trackables removed will be reported at the bottom of the window.
4. Click Close.
To clear only selected trackables' patch using the quick motion patch tool
1. Select all trackables you wish to clear patch info for in one of the Wireframe views.
Tip: Remember that the Trackable is the Cartesian axis associated with the Trackable, not
the Trackable object itself.
2. From the Tools menu, choose Quick Tools and then choose Quick Motion Patch Tool.
3. Under the Clear Motion Patch section, ensure that Only Selected Trackable/Axes is selected.
4. Click Clear.
Result: All selected Trackables are unpatched from the motion universe. The total number of
patched Trackables cleared will be reported at the bottom of the window.
5. Click Close.
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Hanging Moving Fixtures in BTWYSIWYG
If you want moving ﬁxtures to follow a Trackable, you must place and hang the moving ﬁxtures in
BTWYSIWYG. When a moving ﬁxture is placed in BTWYSIWYG, BlackTrax collects valuable ﬁxture
information such as the properties, range of capabilities, orientation and position in the venue.
Moving ﬁxtures must be placed on the ﬂoor or hung onto pipes or trusses. The position and orientation of
the ﬁxtures in BTWYSIWYG must be close to their location in the actual Space for tracking to work
correctly.
Attention:
Calibration can resolve the ﬁxtures' incorrect locations or backward orientation, but the calibration
process is tedious. The ﬁxtures in the actual Space should match their virtual ﬁxture orientation
and location to make calibration easier.
Library objects that are classiﬁed as moving lights are capable of following Trackables.
Tip: To keep ﬁxture orientation consistent, make a note on the orientation of the ﬁxture’s tail. This
provides an accurate indication of the ﬁxture's orientation.
Note: Read the WYSIWYG Reference Guide’s chapter on Hanging and focusing ﬁxtures for a complete
understanding on how to hang ﬁxtures.
To insert ﬁxtures in BTWYSIWYG
1. In BTWYSIWYG CAD mode, at the bottom of the screen, click the Wireframe view tab.
2. From the Library menu, choose Browse Library.
Result: The Library Browser window appears.
3. At the bottom of the Library Browser click Fixture Tool.
4. On the menu that is now visible, double-click Manufacturer to select ﬁxtures by manufacturer
name, Type to select by ﬁxture type, or All to see all the ﬁxtures in alphabetical order.
Note: Alternately, you can use the Library Browser's search function to locate the ﬁxture that
you want to insert. Simply type the name of the ﬁxture (or a partial name) in the search box
at the top of the Library Browser, and then click the Search icon.
5. Double-click the ﬁxture name.
Result: A ﬁxture with default settings for this type attaches to the cursor.
6. To change the properties of the ﬁxture before inserting, in the Library Browser right-click on the
ﬁxture name. On the menu that appears, click Properties.
Result: A dialog box opens with a shaded view of the ﬁxture on the left and an image of its
symbol on the right. Change the properties as needed.
7. To place the ﬁxture, click over a hang structure.
Result: Copies of the ﬁxture attaches to hang structures when clicked. Continue placing this
type of ﬁxture by clicking on the other hang structures as desired.
8. Right-click to ﬁnish placing this ﬁxture type. On the menu that appears select Finish placing
ﬁxtures.
Note: Alternately, clicking ESC will ﬁnish placing ﬁxtures.
9. To place other ﬁxture types, repeat the above steps for each type.
Attention: Fixtures intended for tracking must not hang directly over the Space.
When placing moving ﬁxtures that are to follow Trackables, it is recommended that ﬁxtures
are not hung directly above the Space. Fixtures hung above the Space may run into pan and
tilt range limitations when attempting to follow a Trackable.
Fixtures placed on a pipe
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Best Practices for Moving Fixture
Placement
To obtain precise tracking in BlackTrax, the limitations of moving ﬁxtures must be taken into account.
The following section will guide you through known limitations of moving ﬁxtures in BlackTrax and
provide smart practices used to overcome these limits.
Attention: Do not place ﬁxtures that will track directly above the Space.
A number of issues can occur if ﬁxtures are directly above the Space. If ﬁxtures are placed above the
Space and are following a Trackable which moves in a circular path underneath, this can cause ﬁxtures
to spiral and reach a pan stop.
Note: BlackTrax has a feature where if a ﬁxture pan-ﬂips, the ﬁxture will dim while performing the ﬂip.
This is in place to reduce the disruption caused by the pan-ﬂip during operation.
Tips:
Prediction algorithms can be selected when tracking to try and achieve speciﬁc tracking needs. See
Fixture Sensitivity for more information.
To avoid these problems, it is recommended that moving ﬁxtures are instead placed in front,
behind, or on the sides of the Space. This will limit the range of both pan and tilt movement needed
by ﬁxtures to follow a Trackable and avoid these potential problems.
If tracking must occur below a ﬁxture, a possible solution is to hang the ﬁxture sideways.
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Patching and Assigning an ID to Fixtures
in BTWYSIWYG
Patching Fixtures to BTWYSIWYG Introduction
When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched 1:1 by default.
When tracking occurs, BlackTrax uses the DMX values generated by the console, but overrides the pan
and tilt channels with new values. These new values direct the ﬁxture to aim and follow a Trackable. If a
ﬁxture was edited to have a constant beam size, the zoom and iris values will also change. The patching
must be the same so that BlackTrax can override the correct DMX universe and channels.
In BTWYSIWYG, you can create and patch a DMX universe using the spreadsheet in DATA mode or Quick
Tools.
To create a DMX universe
1. In BTWYSIWYG DATA mode, click the Patch layout tab at the bottom of the screen.
2. Right-click on the patch shortcut area on the right of the screen.
3. On the menu that appears click New Patch.
Result: The Enter new Patch Universe name dialog box appears, prompting for the type of
universe that you want to create and the name of the new universe.
4. Type the name of the patch universe.
5. Under Patch Universe Type, select DMX.
6. Click OK.
Result: The patch shortcut appears in the Patch tab.
DATA Mode with one DMX universe created

Assigning Spot ID Numbers to Fixtures
An individual Spot ID number must be assigned to every single ﬁxture in the project in BTWYSIWYG. This
Spot ID number will map to a ﬁxture ID on a connected lighting console. The Spot ID is used by the
BTSystem to diﬀerentiate between ﬁxtures in the project.

Fixture Patching Methods
There are multiple ways to patch ﬁxtures in BTWYSIWYG. The following section will guide you through
some of the simplest methods. For more information see the WYSIWYG Reference Guide’s chapter on
Data mode.
To patch ﬁxtures and assign spot IDs using quick tools
Use Quick Tools and click on the ﬁxtures in Wireframe view to patch and assign spot IDs. The ﬁrst ﬁxture
clicked will be assigned the patch and ID as conﬁgured in Quick Tools. The next ﬁxture clicked will be
assigned the next available channel in the patch and the next ﬁxture ID in the sequence until you are
ﬁnished using Quick Tools.
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1. In BTWYSIWYG CAD mode Wireframe view, from the Tools menu, choose Quick Tools and then
choose Quick Tools. Alternately click the Quick Tools icon in the Tools toolbar.
Result: The Quick Fixture Tool window appears.
2. In the Quick Fixture Tool window, in the Fixture Attributes section, select the Spot checkbox.
3. In the Spot ﬁeld, enter a number which will be the ﬁrst ﬁxture ID used in the sequence.
4. In the Fixture Data section, select the Patch checkbox.
5. In the Patch ﬁeld, enter the universe and channel the ﬁrst ﬁxture will patch to, separated by a
period.
Example: “A.1” would patch to universe A, address 1.
6. Click Ok.
Result: When a ﬁxture is selected, it will be assigned a Universe and channel to operate on.
The ﬁrst ﬁxture selected will be assigned the to the channel number entered in Quick Tools.
Subsequent ﬁxtures selected will be assigned the next sequential channel and Spot ID
number.
7. Click on a ﬁxture to patch it to a universe and channel. Click on each ﬁxture that you want to be
patched and assigned a spot ID.
8. To stop patching ﬁxtures, right-click.
9. On the menu that appears, click Finish Quick Tools.

Quick Tools

To patch ﬁxtures and assign spot IDs using the data spreadsheet
The Spreadsheet view In DATA mode displays information on all ﬁxtures created in the BTWYSIWYG
project. You can edit the patch information and Spot ID directly in the spreadsheet table.
1. In BTWYSIWYG DATA mode, click on the Spreadsheet tab.
2. In the Columns section on the left side of the window, click All Data (Sortable).
Result: All ﬁxture data are displayed in the spreadsheet.
3. In the Patch column, enter the appropriate patch information for each ﬁxture.
4. In the Spot column, enter a unique Spot ID for each ﬁxture.
Tip: It is possible to assign sequential values to ﬁxtures quickly by selected all ﬁelds for the
ﬁxtures you wish to edit (for example all spot ID ﬁelds for all ﬁxtures) and type the spot ID of
the starting ﬁxture and a '+' and hitting enter. For example, 101+ will set the ﬁrst ﬁxture to
spot 101, and every ﬁxture after that will increase by 1. If this method is used to assign
values, it is recommended that ﬁxtures are ﬁrst sorted so ﬁxtures are organized. Fixtures can
be sorted in order of position, or Unit # along a pipe/truss. This can also be used for patching
ﬁxtures as well.
DATA>Spreadsheet with ﬁxtures patched for BlackTrax
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Patching DMX Universes to a Console
BlackTrax requires that the patching information of the connected console be recorded in BTWYSIWYG.
This will inform BlackTrax which console is in use and which ports will transmit information.
When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched 1:1 by default.
You can also patch the DMX universes to a DMX console in the Device Manager window in BTWYSIWYG.
Note: The DMX console used in BlackTrax and displayed in the Device Manager window in BTWYSIWYG is
an sACN device. This device will also work with Art-Net without any changes.
To patch the DMX universe to a console
1. In BTWYSIWYG LIVE mode, from the Managers menu, choose Device Manager.
Result: The Device Manager window appears.
2. In the Device Manager window, click New.
Result: The Library Selection window appears.
3. Navigate through the console library until you ﬁnd the console or device that you are connecting
to. Click the console name to highlight it.
4. Click Insert.
Result: The console appears in the Device Manager window.
5. With the console name still selected, click Properties.
Result: The Properties window appears.
6. From the Protocol drop-down list, select the protocol used by the console.
Result: The console model is displayed in the Model ﬁeld. The name of the console is
displayed in the Name ﬁeld.
7. In the Address ﬁeld, type the designated address of the console, if applicable.
8. You must bind output ports from the console to BTWYSIWYG patch universes. Bind a Port output to
the appropriate universe by clicking the Universe ﬁeld next to the output.
Result: A drop-down list of available Universes is displayed.
9. Select the appropriate Universe from the list.
10. Repeat the above steps to bind all ports to their appropriate patch universes.
11. Click Close to close the Properties window.
12. Click Close to exit the Device Manager window.
Result: BlackTrax will know which console will be connected and which ports will transmit
information

Device Manager with an Art-Net device and a BlackTrax console

Art-Net Device Properties with patched universes
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Patching Universes to BlackTrax
When a new BTWYSIWYG project is created from BlackTrax, DMX universes are automatically created
and patched to BlackTrax 1:1 by default.
You can also patch the DMX universes to the BlackTrax Network in the Device Manager window in
BTWYSIWYG.
After universes are created, be it motion or DMX, this information will need to be patched to BlackTrax.
This will inform BlackTrax which of its ports are in use and which ports will transmit information.
To patch universes to BlackTrax
1. In BTWYSIWYG LIVE mode, from the Managers menu, choose Device Manager.
Result: The Device Manager window appears.
2. In the Device Manager window, click New.
Result: The Library Selection window appears.
3. In the Library Selection window, in the Search ﬁeld, type BlackTrax Network and then click the
Search icon.
Result: The device BlackTrax Network will be displayed in the search results.
4. Click on BlackTrax Network from the list to highlight it, then click Insert.
Result: The BlackTrax Network appears in the Device Manager.
5. With the BlackTrax Network name still selected, click Properties.
Result: The Properties window appears.
6. You must bind output ports from the BlackTrax Network to BTWYSIWYG patch universes. Bind a
Port output to the appropriate universe by clicking the Universe ﬁeld next to the output.
Result: A drop-down list of available Universes is displayed.
7. Select the appropriate Universe from the list.
8. Repeat the above steps to bind all ports to their appropriate patch universes.
9. Click Close to close the Properties window.
10. Click Close to exit the Device Manager.
Result: BlackTrax will know what ports are in use.

Device Manager with an Art-Net device and a BlackTrax console

The BlackTrax Console with Motion and DMX universes patches
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Applying BTX information to BlackTrax
from BTWYSIWYG
After a project is created, modiﬁed and saved in BTWYSIWYG, the new information must be sent and
applied to the BlackTrax Project.
There are three methods for sending BTX information to BlackTrax from BTWYSIWYG:
BTX Apply in LIVE mode
BTX Export in CAD mode
BTX Apply in CAD mode
To send BTX information with BTX Apply in BTWYSIWYG LIVE mode
1. In BTWYSIWYG LIVE mode, open the BlackTrax window.
2. Ensure that the BlackTrax Portfolio is open, and BTWYSIWYG is connected to it.
3. In the BlackTrax window of BTWYSIWYG , click BTX Apply.
Result: BTWYSIWYG sends the BTX information to the BlackTrax Project.
To send BTX information with BTX Export in BTWYSIWYG CAD mode
1. In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BTX Export.
Result: A Save as window appears.
2. In the window, navigate to where you want to save the project ﬁle.
3. In the File name ﬁeld type in the name of the project.
4. Click Save.
Result: The BTX information from BTWYSIWYG is exported and saved as a separate ﬁle
which can be used to manually update your BlackTrax Project.
Note: If there are errors in the export, BTWYSIWYG will display the errors after the export is
completed.

BlackTrax Menu found in CAD mode

To send BTX information with BTX Apply in BTWYSIWYG CAD mode
1. Ensure that the BlackTrax Portfolio is open, and BTWYSIWYG is connected to it.
2. In BTWYSIWYG CAD mode, from the BlackTrax menu, choose BTX Apply.
Result: BTWYSIWYG sends the BTX information to the BlackTrax Project.
LIVE mode showing the BlackTrax panel with BTX Apply
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Optional .BTX Information
Table of contents:
BlackTrax Zones
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BlackTrax Zones
Three-dimensional areas called Zones, can be drawn inside the virtual representation of the Space
in BTWYSIWYG. Zones are an incorporeal volume and can only be viewed in BTWYSIWYG, but if created,
exists simultaneously in the virtual and physical Space. Zones are available in rectangular, cylindrical
and spherical shapes of any size.
BlackTrax has a number of preset interaction between Zones and ﬁxtures, which can be accessed in the
Chapter section in BlackTrax. For more information see To enable a Zone for a Fixture.
To draw a rectangular zone
1. In BTWYSIWYG CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, choose BT Zone and then choose Rectangular Zone.
Result: The New Rectangular Zone window appears.
3. In the New Rectangular Zone window, in the Width ﬁeld, enter in the width of the Zone.
4. In the Depth ﬁeld, enter in the depth of the Zone.
5. In the Height ﬁeld, enter in the depth of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
6. In the Zone Name ﬁeld, enter a unique name for the Zone.
7. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

BTWYG drawing with a Rectangular Zone selected

To draw a cylindrical zone
1. In BTWYSIWYG CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, choose BT Zone and then choose Cylindrical Zone.
Result: The New Cylindrical Zone window appears.
3. In the New Cylindrical Zone window, in the Height ﬁeld, enter the height of the Zone.
4. In the Horizontal Radius ﬁeld, enter in the horizontal radius of the Zone.
5. In the Vertical Radius ﬁeld, enter in the vertical radius of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
6. Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,
clear the Lock Ratio checkbox.
7. Number of Segments controls how many segments make up the radius of the cylindrical Zone. The
default is set to 16. To change the number of segments, clear the Use Document Defaults
checkbox. Enter the new segment number in the ﬁeld.
Note: The maximum number of segments allowed is 40.
8. In the Zone Name ﬁeld, enter a unique name for the Zone.
9. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
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dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

BTWYG drawing with a Cylindrical Zone selected

To draw a spherical zone
1. In BTWYSIWYG CAD mode, click the Wireframe view tab.
2. From the BlackTrax menu, choose BT Zone and then choose Spherical Zone.
Result: The New Spherical Zone window appears.
3. In the New Spherical Zone window, in the Horizontal Radius ﬁeld, enter in the horizontal radius of
the Zone.
4. In the Vertical Radius ﬁeld, enter in the vertical radius of the Zone.
Note: Alternately, Zone dimensions can be created by selecting Interactive. The Zone is then
drawn in Wireframe view, and dimensions are automatically recorded.
5. Lock Ratio controls the aspect ratio of the radius. This feature is enabled by default. To disable,
clear the Lock Ratio checkbox.
6. Number of Segments controls how many segments make up the radius of the spherical Zone. The
default is set to 12. To change the number of segments, clear the Use Document Defaults
checkbox. Enter the new segment number in the ﬁeld.
Note: The maximum number of segments allowed is 40.
7. In the Zone Name ﬁeld, enter a unique name for the Zone.
8. Click OK.
Result: The Zone will be inserted into the Space. It can be repositioned by dragging and
dropping where needed. The dimensions of the Zone can be altered by manipulating the
Zone directly, or by right-clicking the Zone and selecting Properties.

BTWYG drawing with a Spherical Zone selected
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Planning BTSensor Placement
Table of contents:
Introduction
BTSensor Placement
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Introduction
Tracking only occurs in BlackTrax if two or more BTSensors can see a BTBeacon at the same time.
Therefore, when placing BTSensors, there must be some overlap between what each BTSensor sees.
Place and aim BTSensors in BTWYSIWYG ﬁrst before setup in the physical Space. This step is optional and
will not aﬀect your BlackTrax project. Planning BTSensor placement in BTWYSIWYG helps you test the
BTSensor’s coverage of the venue and determine how best to position them. BTSensors must not be
placed any closer than 1m apart to help ensure optimal sensor calibration.
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BTSensor Placement
To place a BTSensor in BTWYSIWYG
1. In BTWYSIWYG CAD mode, click the Wireframe view tab.
2. From the Library menu, choose Browse Library.
Result: The Library Browser window appears.
3. At the bottom of the Library Browser window, click the Fixture tool.
4. In the search box, type BlackTrax.
5. Double-click on the name of the BTSensor that you want to insert.
Result: A ﬁxture with default settings for this type attaches to the cursor.
6. To change the properties of the ﬁxture before inserting, such as the lens size, right-click on the
ﬁxture name, and then click Properties.
Result: A dialog box opens with a shaded view of the BTSensor on the left and an image of
its symbol on the right. Use the Appearance tab to change the lens settings for the BTSensor.
Options are 5.5 mm, 8.0 mm, 3.5 mm for Slim 13E. For s250e BTSensor options are 5.5 mm,
8.0 mm.
7. To place the BTSensor, move the mouse over a hang structure, and then click. Continue placing
this type of ﬁxture by clicking on the other hang structures as desired.
Note: BTSensors can be hung in Space without a hang structure.
8. Right-click and select Finish placing ﬁxtures from the menu to ﬁnish placing the ﬁxture.
Result: BTSensors will be hung in virtual space. BTSensors will emit a red beam to represent
their ﬁeld of vision.
To aim a BTSensor in BTWYSIWYG
1. In BTWYSIWYG CAD mode, click the Wireframe view tab.
2. In the Wireframe view, select a BTSensor.
Tip: You can also use the Fixture Selection Tool to select a single sensor or multiple sensors.
3. Use the Fanning Tool to aim the BTSensor(s) to the desired location.
Tip: You can also use the Cuts and Adjustments tool or the Focus menu to aim BTSensors in
BTWYSIWYG.
Result: The BTSensor will orientate itself based on the new Pan and Tilt values. The
BTSensor’s new ﬁeld of view will be shown. See the section on Quick focus in the WYSIWYG
Reference Guide for more information.

Example of BTSensor Placement
In CAD mode, BTSensors can be hung in the venue exactly the same as ﬁxtures, from any pipe or truss.
In this example BTSensors are hung around the perimeter on pipes represented in yellow, a mannequin
in orange is at the origin of the room.
When BTSensors are hung, the BTSensor’s ﬁeld of view will correctly project in the visualization. A
BTSensor ﬁeld of view of in BTWYSIWYG is depicted as a red beam Everything in the red beam is what
the BTSensor can see.
Tracking can only occur when two or more BTSensors see the same area at the same time. By selecting
multiple BTSensors, we can see their ﬁeld of view and where their vision overlaps. Overlapping views are
depicted in BTWYSIWYG as a deeper red then an individual view.
Two BTSensors whose ﬁeld of view are overlapping. The deeper red in the center is the overlapping area
where tracking can occur.
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By placing BTSensors in BTWYSIWYG and viewing their projected ﬁeld of view, it is easy to determine
where BTSensors should go and how they should be aimed to maximize the tracking area in the venue.
Any gaps in coverage where tracking cannot occur will also be shown. Once the position and orientation
of BTSensor have been determined, you can record the data to reproduce the BTSensor placement in the
actual venue.
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BlackTrax Visualization
Table of contents:
Introduction
Using BTWYSIWYG as a Tracking Visualizer
Using Calibration Data to Adjust Visualization in BTWYSIWYG
Using Stick Beams for Fixtures in BTWYSIWYG
Shaded View Camera Control
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Vis Introduction
BlackTrax projects can be visualized within BTWYSIWYG where ﬁxture and Trackable interactions are
simulated in the BTWYSIWYG virtual Space. Fixtures or Trackables that are selected in BlackTrax will be
selected in BTWYSIWYG depending on the settings deﬁned in the BlackTrax System Conﬁguration
widget. BTWYSIWYG, Motive, and BlackTrax must be open and running the project ﬁle for visualization to
work correctly.
To visualize BlackTrax activity in BTWYSIWYG
1. In BlackTrax, open the BlackTrax project ﬁle.
2. In BTWYSIWYG LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, choose BlackTrax from the Live menu.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.
3. In the BlackTrax panel, select the BTX Mode checkbox.
4. In the BlackTrax panel and with BlackTrax running, click Connect.
Result: Activity in BlackTrax will now be visualized in BTWYSIWYG.
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Using BTWYSIWYG as a Tracking
Visualizer
Tracking data can be visualized in BTWYSIWYG. Viewing tracking data is useful for troubleshooting.
Seeing ﬁxtures and Trackables move in BTWYSIWYG based on the data helps determine if data is actually
being transmitted. There could be problems in the BTSystem connections if there is no activity
in BTWYSIWYG.
To visualize tracking data in BTWYSIWYG
1. In BTWYSIWYG LIVE mode, from the Live menu, choose BlackTrax Panel to open the BlackTrax
panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.

2. In the BlackTrax panel, select the BTX Mode checkbox to enable the option to connect with
BlackTrax.
3. Click Connect to activate the connection with BlackTrax, or click Disconnect to deactivate the
connection to BlackTrax.
Note: The BlackTrax template ﬁle connects automatically to BlackTrax when opened.
4. To customize how you interact with Trackables within Shaded view, select from the following
options:
Display Mode: On this drop-down menu, select Beacon Focused or Trackable Focused.
Beacon Focused: Displays all LEDs and Centroids regardless of the Trackable patch in
BlackTrax. This mode hides all objects attached to Trackables in BTWYSIWYG.
Trackable Focused: Displays only LEDs and Centroids that are actively patched to a
Trackable in BlackTrax. This mode also displays objects attached to the Trackable in
BTWYSIWYG.
Select Trackable Objects Only: Select this checkbox to choose only Trackable objects in the
Shaded view of BTWYSIWYG.
Prefer Frame LEDS: Select this checkbox to display only Rigid or Soft Frame's LEDs and
Centroids. When enabled, Classic and Mini Beacons will not be displayed in the Shaded view
if they are currently assigned to a Rigid or Soft Frame.
5. To set how the ﬁxtures and their beams are displayed and selected in Shaded view, select from the
following options:
Show Lighting For: On this drop-down menu, select which beams of the ﬁxtures will be
displayed.
All Fixtures: Displays all the beams of the ﬁxtures in the BlackTrax project.
Tracking Only: Displays only the beams of the ﬁxtures that are currently following
Trackables.
No Fixtures: No beams of the ﬁxtures will be displayed.
Calibrated Fixture Position: Select this checkbox to show the position of the ﬁxture as
calibrated by BlackTrax instead of using the BTWYSIWYG drawn position.
Show Beams With Stick: Select this checkbox to display the beams of light produced by the
ﬁxtures as stick beams with the corresponding colors indicating their tracking status.
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Currently Tracking (Green): Select this checkbox to display only the stick beams of the
ﬁxtures connected and actively following a Trackable in a BlackTrax chapter. This stick
beam appears in green color.
Currently Standby (Blue): Select this checkbox to display only the stick beams of the
ﬁxtures that are connected to the system and are set to follow a Trackable in a
BlackTrax chapter. This stick beam appears in blue color.
Unassigned (Yellow): Select this checkbox to display only the stick beams of the
ﬁxtures that are connected to the system but not set to follow a Trackable in any
BlackTrax chapter. This stick beam appears in yellow color.
6. Select the Enable Message Log checkbox to activate the message logging options.
Log To File: Select this checkbox to record the log information and automatically store into a
ﬁle in the "bt_run_time" folder of your local drive.
Log Data: Select this checkbox to record the motion tracking information as it is displayed in
the message box.
Clear Log: Click this button to clear the message box.

Viewing LEDs and Centroids in Shaded View
of BTWYSIWYG
How LEDs of a Beacon are displayed in Shaded view:
An LED appears as a solid circle when in front of everything in Shaded view.
An LED appears as a circle outline when behind an object in Shaded view.
An LED appears in the color that is identical to the Beacon color in BlackTrax.
When an LED is selected, its color turns to white and the text label identiﬁcation appears. For
example, the screenshot (above) shows "L:101.4" which indicates LED of Beacon 101 and LED no.
4.

How Centroids are displayed in Shaded view:
A Centroid appears as a solid square object when in front of everything in Shaded view.
A Centroid appears as a square outline when behind an object in Shaded view.
A Centroid appears in the color that is identical to the Beacon color in BlackTrax.
When a Centroid is selected, its color turns to white and the text label identiﬁcation appears. For
example, the screenshot (above) shows "C:Whiteboard(101)" which indicates the Centroid
associated with Beacon 101 is patched to the Whiteboard trackable.
When a Centroid is selected, the LEDs associated with the Centroid are automatically selected.
The Centroid appears with only a number if it is not patched to a Trackable.

Using the Trackables and Beacons Widget
The Trackables and Beacons widget is an easier, convenient and faster way to ﬁnd and select LEDs and
Centroids in the Shaded view of BTWYSIWYG.
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To use the trackables and beacons widget
1. In BTWYSIWYG LIVE mode, from the Live menu, choose Trackables and Beacons to open the
Trackables and Beacons panel.
Result: The Trackables and Beacons panel appears and displays the list of Trackables,
Beacons, and Frames associated with the connected BlackTrax project.
2. In the Trackables and Beacons panel, click on the arrow at the far left of the list of Trackables,
Beacons or Frame to expand or collapse the corresponding list below them.
3. On the Trackables and Beacons panel, click on a single or multiple Trackables, Beacons or Frame to
select in the Shaded view.
Result: In the Shaded view, the selected Trackable(s) or Beacon(s) or Frames will turn to
white with the corresponding text label identiﬁcation.
Note: You can activate Shaded View Selection by pressing TAB while in CAD, Design or Live mode >
Shaded View. Once you press TAB, a purple message at the top right-hand corner of the Shaded view
window appears: "Shaded View Select ON", and you may click on the objects in Shaded view to select.
Please refer to the "Using Shaded View Selection" section in the current WYSIWYG Reference Guide.
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Using Calibration Data to Adjust
Visualization in BTWYSIWYG
Once ﬁxtures have their position calibrated in BlackTrax, this information can be used to improve
visualization in BTWYSIWYG. The position of ﬁxtures in BTWYSIWYG will change to the calibration
locations, creating a more accurate visualization.
To use calibrated ﬁxture positions in BTWYSIWYG
1. In BlackTrax, open the BlackTrax project ﬁle.
2. In BTWYSIWYG LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, from the Live menu, choose BlackTrax Panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.
3. Select the BTX Mode checkbox.
4. Click Connect.
5. Select the Calibrated Fixture Position checkbox.
Result: The position of ﬁxtures in BTWYSIWYG changes to reﬂect the calibration data created
in BlackTrax.
Note: For details on how to calibrate ﬁxtures, see Fixture Calibration page.
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Using Stick Beams for Fixtures in
BTWYSIWYG
When you visualize in BTWYSIWYG, stick beams can represent the beams of light produced by ﬁxtures.
This reduces clutter and confusion in the visualization and helps determine where ﬁxtures are aiming and
which ﬁxtures are selected.
To use ﬁxture stick beams in BTWYSIWYG
1. In BlackTrax, open the BlackTrax project ﬁle.
2. In BTWYSIWYG LIVE mode, go to the BlackTrax panel.
Note: To open the BlackTrax panel if closed, from the Live menu, choose BlackTrax Panel.
Result: The BlackTrax panel appears on the right side of the BTWYSIWYG window.
3. Select the BTX Mode checkbox.
4. Click Connect.
5. Select the Show Beams With Stick checkbox.
Result: Fixture beams will be represented as sticks in BTWYSIWYG.
6. To toggle speciﬁc stick beams on or oﬀ, clear the checkbox next to the desired stick beam status
(Currently Tracking (Green), Currently Standby (Blue), or Unassigned (Yellow)).

Understanding Stick Beam Colors
The color of a stick beam communicates information about the parent ﬁxture at a glance.
A Green stick beam means a ﬁxture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable and it is currently following a Trackable - Currently Tracking
(Green).
A Blue stick beam means a ﬁxture is connected to the system, there is a chapter created in
BlackTrax where it follows a Trackable, but it currently is not set to follow a Trackable - Currently
Standby (Blue).
A Yellow stick beam means that a ﬁxture is connected to the system, but there is no chapter in
BlackTrax where that ﬁxture is told to follow Trackables - Unassigned (Yellow).
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Shaded View Camera Control
The default camera control in the Shaded view of BTWYSIWYG is set to Other 3D Applications where
commands and behavior are identical to other 3D applications instead of the traditional WYSIWYG
standard.
Mouse Actions

*Aﬀected by View Option, "Pan tool moves objects".

Keyboard Actions

Note: In the Application Options window, you can choose Traditional WYSIWYG on the Shaded View
Camera Control list if you want to use the standard WYSIWYG camera control in Shaded view.
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Motive for BlackTrax
Table of contents:
1 Initial Setup :
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Initial Setup
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Motive Introduction
The Motive module is used to manage and control BTSensors. Motive is part of the BlackTrax software
suite that is already installed on the BTServer and is ready for you to use. The following section will guide
you through speciﬁc steps on how to use Motive to conﬁgure BTSensors to work in the Space and
function with the BTSystem.
Attention: Users should only install versions of Motive included in BlackTrax System Update packages.
Failure to do so could result in your BlackTrax system not functioning correctly.
The Motive splash screen appears upon launch and it will display a notiﬁcation if the Motive license is
about to expire or if the Motive license has expired or if the Motive license is not found. Motive will still
run with an expired license if the version was released at any time before the license expired.
If your license is expired, please contact BlackTrax Support .
Motive opens and ready for use.
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Layout Presets in Motive
Custom preset layouts in Motive were created for BlackTrax and set as preset layouts which can be
restored quickly from the Layout menu or from the Main Toolbar drop-down menu. The custom preset
layouts for BlackTrax are:
Layout Preset

Description

Keyboard Shortcut

Running

Opens the windows that will be used when a BlackTrax project is running.

CTRL+1

Aiming

Opens the windows that will be used for the aiming of BTSensors.

CTRL+2

Calibration

Opens the windows that will be used for the conﬁguration of BTSensors.

CTRL+3

Conﬁguration

Opens the windows that will be used for the conﬁguration of a BlackTrax project.

CTRL+4

Recording

Opens the windows that will be used for the recording of motion data in a BlackTrax
project.

CTRL+5

The GUI layout in Motive can be customized. All windows can be docked and undocked from the GUI.
Each window can be positioned and organized by drag-and-drop using the on-screen docking indicators.
Windows may ﬂoat, dock, or stack. Windows form a tabbed window when stacked together. The custom
layouts in Motive can be saved and loaded, allowing for the quick switching between default and custom
conﬁgurations suitable for diﬀerent needs.
Note: Layout conﬁgurations from older versions will not load in Motive 2.
To restore a preset layout
1. In Motive, click the drop-down box at the right-hand side of the main toolbar and click the layout
preset from the drop-down menu of layout presets.
Result: Motive opens the preset windows in the selected layout.
Tip: You can also restore a particular layout from the Layout menu.
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BTSensor Diﬀerences in Motive
Depending on your tracking needs, the type of BTSensors used in your BTSystem will vary. Each model of
BTSensor has slightly diﬀerent settings in Motive. Due to these diﬀerent settings, steps outlined in this
manual may be slightly diﬀerent depending on what BTSensor is in use.
Diﬀerences include speciﬁc properties of the BTSensor found in Motive in the Devices window, and the
BTSensor’s view found in the Camera Preview window.
Note: All BTSensors purchased from CAST are capable of tracking.
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BTSensor Presets
BTSensor Introduction
BTSensors are required to be conﬁgured in certain ways to complete speciﬁc tasks: tracking objects,
referencing the BTSensor’s real-time location or aiming BTSensors. These settings can be entered in
manually, or automatically conﬁgured in Motive by selecting a preset from the Preset drop-down menu
on the Devices window. The following tables explain what BTSensor settings are changed when you
select a preset.

SLIM 13E Presets

S250e SLIM Presets

Prime 41 Presets

Note: Prime 41 BTSensor does not have a Filter Switch.

To select a preset setting for a BTSensor
1. In Motive, go to the Devices window.
Tip: To open the window, from the View menu, choose Devices Pane.
2. In the Devices window, select a single BTSensor, or select all BTSensors in the group by clicking the
group name.
3. At the top of the Devices window, click the Preset drop-down menu and select the desired preset.
Result: The selected BTSensors will have their settings changed to that of the selected
preset.
Note: BTSensors have been custom designed for BlackTrax, which removes the illumination ring.
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Checking the Connectivity of BTSensors
BTSensors must be connected to the BTSystem for tracking to occur. The connection status of BTSensors
can be determined in the Devices window in Motive.
To determine if BTSensors are connected
1. In Motive, click the drop-down box at the right-hand side of the main toolbar and click Running from
the drop-down menu of layout presets.
Result:
Motive opens the preset windows in the Running layout.
In the Devices window, all connected BTSensors will be displayed under the Cameras
group.

Note: If a BTSensor is not visible in the Devices window, check the physical connections to
see if any BTSensors are disconnected.
Tip: To help identify BTSensors, you can click the Aim Assist button on a BTSensor in the
Devices window, and the corresponding BTSensor will ﬂash yellow in the Camera Preview
window.
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Using Motive to Aim BTSensors
For tracking to occur, BTSensors must be positioned around the perimeter of the tracking area and aimed
towards the area. Tracking occurs in an area when 2 or more BTSensors view the same area at the same
time. A video feed of what BTSensors see is shown in Motive. By viewing the BTSensor’s video feed in the
visible spectrum, BTSensor positioning can be evaluated.
Attention: The Space origin must be visible to at least 2 BTSensors for sensor calibration to function
correctly.
Note: To quickly see a BTSensor’s video feed in the visible spectrum, change the preset setting of the
BTSensor to Reference. See To select a preset setting for a BTSensor for more information.

Motive 2
To view a BTSensor’s video feed in the visible spectrum
1. In Motive, click the drop-down box at the right-hand side of the main toolbar and click Aiming from
the drop-down menu of layout presets.
Result: Motive opens the preset windows for the aiming of BTSensors.
2. In the Devices window, click the group name to select a single BTSensor, or select all BTSensors in
the group.
3. With the BTSensor(s) selected, look below to the Properties section of the Devices window.
4. On the Camera Settings section, set the Filter Switch ﬁeld to Visible Spectrum.
5. On the Camera Settings section, set the Video Type ﬁeld to MJPEG Mode and select the range of
MJPEG Quality from the drop-down menu. The range of MJPEG Quality is between 1 (minimum) and
up to 4 (maximum).

Result: The video displayed from the BTSensors will appear as a grayscale image in the visible
spectrum.

Motive 1.10 or lower
To view a BTSensor’s video feed in the visible sprectrum
1. In Motive, click on the box at the right hand side of the main toolbar and click Aiming from the
drop-down menu of layout presets.
Result: Motive opens the preset windows for the aiming of BTSensors.
2. In the Cameras window. click the group name to select a single BTSensor, or select all BTSensors in
the group.
3. With the BTSensor(s) selected, go to the Properties section of the Cameras window.
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4. Under the Camera Settings heading, set the Filter Switch ﬁeld to Visible Spectrum.
5. Set the Video Type ﬁeld to one of the MJPEG mode options.

Result: The video displayed from the BTSensors will appear as a grayscale image in the visible
spectrum.
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BTSensor Aim Assist Feature
BTSensors have an Aim Assist button to help with aiming BTSensors. When you press the Aim Assist
button, the BTSensor video feed is selected and prominently displayed in Motive. The BTSensor video
feed changes to show the Space in the visible spectrum, and the exposure increases to brighten the
image. This helps aiming the BTSensors correctly. Pressing the Aim Assist button a second time will
return the BTSensor’s video feed to its previous settings.
To toggle aim assist on BTSensor
With the BTSensor connected to the BTSystem, and with Motive operating, press the Aim Assist button on
the BTSensor.
Result: In Motive, the BTSensor will be selected and its live video feed prominently displayed. The
BTSensor’s video feed will be toggled between its current settings and Aim Assist mode.
Aim Assist location
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Motive Project File
A BlackTrax project requires speciﬁc information (BTSensor, calibration and conﬁguration) from Motive,
that is unique to every BlackTrax project. This information is required every time BlackTrax operates.

Motive 2
In Motive, recorded motion capture data is stored as a Take (.tak) ﬁle format, all application-related
conﬁgurations are saved onto Proﬁle XML (.xml) ﬁles, and calibration data for each BTSensor position,
orientation and lens parameters are saved as standalone calibration CAL (.cal) ﬁle format.
In Motive, proﬁle and calibration data are automatically saved into the ProgramData folder and
automatically reloaded when Motive is opened again.
In Motive, proﬁle data is automatically saved once every ﬁve minutes and calibration data is
automatically saved whenever calibration is updated (such as in Continuous Calibration).
Multiple Take (.tak) ﬁles are automatically saved in a Session Folder which can be accessed from the
Data window.
To save a Take to a new location and/or using a new ﬁle name
1. In Motive, from the File menu, choose Save Current Take As.
Result: The Save Current Take As dialog box appears.
2. In the File Name ﬁeld, type the name of the Take ﬁle.
3. Click Save.
Result: The renamed Take ﬁle will be saved in the selected location.
To save an existing Take ﬁle using the same location and ﬁle name
1. In Motive, from the File menu, choose Save Current Take.
Result: Only the recording of the wanding is saved after calibration.
Notes:
Save current take is automatically applied after ground plane calibration.
Use Export Camera Calibration from the File menu to save the calibration data.
See To export a calibration CAL ﬁle.
To save a Proﬁle to a new location and/or using a new ﬁle name
1. In Motive, from the File menu, choose Save Proﬁle As.
Result: The Save Proﬁle dialog box appears.
2. In the File Name ﬁeld, type the name of the Proﬁle XML ﬁle.
3. Click Save.
Result: The renamed Proﬁle XML ﬁle will be saved in the selected location.
To save an existing Proﬁle using the same location and ﬁle name
In Motive, from the File menu, choose Save Proﬁle.
To load a Proﬁle
1. In Motive, from the File menu, choose Load Proﬁle.
Result: The Load Proﬁle dialog box appears.
2. In the Load Proﬁle dialog box, navigate to where the desired .xml ﬁle was saved and click on the
ﬁle to select it.
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3. Click Open.
Result: The .xml ﬁle will load all application-related conﬁguration settings into Motive.

Motive 1.10 or lower
New Project will create a new Motive project folder with the new project document (.ttp ﬁle) and all its
associated ﬁles automatically stored within the speciﬁed folder. Specify the name and save the new
Motive project.
Notes:
When a new Motive project is created from BlackTrax, all necessary settings and conﬁgurations are
automatically applied to that new project. These template projects can be used to simplify the
setup process for Motive on new installations.
We recommend to creating and launching the new Motive project from the BlackTrax File menu
which is more convenient than having to manually create the new project and settings in Motive.
Save Project will save the open Motive project to the same ﬁle name and location under which it was
previously saved. If you are saving the project for the ﬁrst time, this command will perform as Save
Project As... . Save Project As... is used to save the current project with a new ﬁle name and/or a new
destination.
To save a Motive project to a new location and/or using a new ﬁle name
1. In Motive, from the File menu, choose Save Project As....
Result: The Save As dialog box will appear.
2. In the File Name ﬁeld, type the name of the project.
3. Click Save.
To save an existing Motive Project using the same location and ﬁle name
In Motive, from the File menu, choose Save Project.
To load a Motive Project
1. In Motive, from the File menu, choose Open....
Result: The Open dialog box will appear.
2. In the Open dialog box, navigate to where the desired .ttp ﬁle is saved. Click on the ﬁle to select it.
3. Click Open.
Result: The .ttp ﬁle will load. Its information and settings will load into Motive.
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BTSensor Calibration
Table of contents:
BTSensor Calibration Settings
Masking Infrared Interference for Calibration
Calibrating a BTSensor
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BTSensor Calibration Settings
After BTSensors are placed and orientated with overlapping views around the Space, BlackTrax requires
that all BTSensors be calibrated. Calibration enables BlackTrax to know BTSensor positions relative to
each other and the ﬂoor. This spatial awareness of the Space is required for tracking to be accurate.
Before BTSensor calibration can occur, certain settings in Motive must be conﬁgured.

Motive 2
In Motive, calibration data for each BTSensor position, orientation and lens parameters are saved as
standalone calibration CAL (.cal) ﬁle format which can be exported to a desired location for later use.
See To export a calibration CAL ﬁle below.
Motive can be set for Continuous Calibration where the system continuously monitors BTSensor
movements and readjusts the BTSensor calibration accordingly. See To conﬁgure Motive for continuous
calibration below.
To conﬁgure BTSensors for calibration
1. In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Calibration from the drop-down menu of layout presets.
2. Go to the Devices window.
Note: To quickly conﬁgure a BTSensor for calibration, change the preset setting of the
BTSensor to Tracking then proceed to Step 7 in this section.
3. In the Devices window, select the camera group by clicking on the group name.

4. While the sensor group is still selected, click the Properties section for the sensor group.
5. Click the Camera Settings section and set the Video Type ﬁeld to Object Mode for tracking and
calibration.
6. Set the Filter Switch ﬁeld to Visible Spectrum.
7. Go to the Application Settings window and click the Live Reconstruction tab.
8. On the Live Reconstruction tab, click the Marker Labelling Mode drop-down box and select Active
and Passive Markers or Passive Markers Only to set for calibration.

Note: Select Active Markers Only or Active and Passive Markers to set for tracking.
To conﬁgure Motive for continuous calibration
BTSensors must have already been calibrated if Continuous Calibration will be used.
1. In the Calibration preset layout, go to the Application Settings window.
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2. On the Application Settings window, click the Live Reconstruction tab.
3. On the Live Reconstruction tab, click Continuous Calibration.
4. On the Continuous Calibration drop-down menu, select Continuous.
Result: Motive will continuously monitor and update the BTSensor calibration.
To export a calibration CAL ﬁle
1. In the Calibration preset layout, click the File menu.
2. From the File menu, choose Export Camera Calibration.
Result: The Export Camera Calibration window appears.
3. Navigate to the location where the calibration ﬁle will be saved.
4. In the File name ﬁeld, type the name of the calibration .cal ﬁle.
5. Click the Export button.
Result: The calibration results are preserved as a .cal ﬁle which can be loaded into Motive.
To open and restore a calibration CAL ﬁle
1. In Motive, from the File menu, choose Open.
Result: The Open window appears.
2. Navigate and select the .cal ﬁle you wish to open and restore.
3. Click Open.
Result: The saved calibration data will be restored in Motive.

Motive 1.10 or lower
To conﬁgure BTSensors for calibration
1. Change the Motive layout to Calibration (found under Layout > Calibration).
2. Go to the Cameras window.
Note: To quickly conﬁgure a BTSensor for calibration, change the preset setting of the
BTSensor to Tracking, then proceed to Step 6 in this section.

3. In the Cameras window, select the sensor group by clicking on the group name.

4. While the sensor group is still selected, look below to the Property section for the sensor group.
Under the Camera Settings heading, set the Video Type ﬁeld to Precision Mode/Object Mode.
5. Set the Filter Type Switch ﬁeld to Infrared Spectrum.
6. Go to the Application Settings window.
7. In the Application Settings window, in the Options tab, under the Application Options heading, set
the Active Marker Labeling ﬁeld to False.

8. Close the Application Settings window.
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Masking Infrared Interference for
Calibration
Masking is a function in Motive where an area of the BTSensor’s vision is masked (blocked from view).
This tells the system to ignore the masked section when looking for infrared sources. This is used
primarily to mask outside infrared interference that can confuse the system during BTSensor calibration.
Excessive masking may limit a BTSensor ﬁeld of view, as a masked area makes a BTSensor blind to
tracking in that area. You can reposition BTSensors to improve ﬁelds of view, rather than masking in
extreme cases of infrared interference.
Attention: Calibration will be successful if you mask infrared interference before calibration. Masking
diﬀers if Motive is conﬁgured for active or passive markers.

Motive 2
To automatically mask all visible infrared sources from all BTSensors
Attention: Automatic masking will remove all previous masks from the BTSensor.
1. In Motive, go to the Camera Preview window.
2. On the Camera Preview toolbar, click the Mask Visible Markers button.
The Mask Visible Markers button.
Result: All currently visible infrared sources are masked. Any previously created masks are
removed. If additional sections need to be masked, use manual masking techniques.
To clear all masks from all BTSensors
1. In Motive, go to the Camera Preview window.
2. On the Camera Preview toolbar, click the Clear Masking button.
The Clear Masking button.
Result: All masking are cleared from all BTSensors.
To manually mask a BTSensor view
1. In Motive, go to the Camera Preview window.
Result: What each connected BTSensor sees is displayed as a 2D image in the Camera View
window. If BTSensors are conﬁgured to see infrared sources, they appear as white objects.

Camera View window with infrared interference.

2. On the Camera Preview toolbar, select the shape of the mask, either Draw Rectangular Mask or
Draw Circular Mask from the toolbar.
The Draw Rectangular Mask button.
Result: You will create masks in the selected shape.
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Camera View window with rectangular mask.

3. To mask the infrared interference areas inside the Camera View window of a BTSensor, click on one
corner of the interference while holding the left mouse button down and drag the mask to cover
the infrared interference.
Result: The infrared object (white object) is covered by a mask (red object). The infrared
source will not interfere with tracking when masked.

Camera View window with partial IR masking.

4. Repeat the above steps for each instance of infrared interference.

Camera View window with full IR masking.

To toggle additive or subtractive masking
The Toggle Additive/Subtractive Masking button makes all the draw masking buttons remove the
masking instead. For example, if you click the Toggle Additive/Subtractive Masking button to subtractive
and then draw a rectangle, the individual masking where the rectangle was drawn will be removed.
1. In Motive, go to the Camera Preview window.
2. On the Camera Preview toolbar, click the Toggle Additive/Subtractive Masking button.
The Toggle Additive/Subtractive Masking button.
Result: Toggle subtractive makes all draw masking buttons remove the masking when
applied. Toggle additive makes all draw masking buttons add the masking when applied.
3. Draw the mask.
Result: The mask is removed if toggle subtractive is selected. The mask is added if toggle
additive is selected.

Motive 1.10 or lower
To automatically mask all visible infrared sources from all BTSensors
Attention: Automatic masking will remove all previous masks from the BTSensor.
1. In Motive, go to the Camera Preview window.
2. On the Camera Preview toolbar, click the Block Visible Markers button.
Result: All currently visible infrared sources are masked. Any previously created masks are
removed. If additional sections need to be masked, use manual masking techniques.
To clear all masks from all BTSensors
1. In Motive, go to the Camera Preview window.
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2. On the Camera Preview toolbar, click the Clear Blocking button.
Result: All masking are cleared from all BTSensors.
To manually mask a BTSensor view
1. In Motive, go to the Camera Preview window.
Result: What each connected BTSensor sees is displayed as a 2D image in the Camera View
window. If BTSensors are conﬁgured to see infrared sources, they appear as white objects.

2. On the Camera View toolbar, select the shape of the mask, either Rectangular Blocking or Circular
Blocking from the toolbar.
Result: You will create masks in the selected shape.

3. To mask the infrared interference areas inside the Camera View window of a BTSensor, click on one
corner of the interference while holding the left mouse button down and drag the mask to cover
the infrared interference.
Result: The infrared interference (white object) is covered in by a mask (red object). While

masked, the infrared source will not interfere with tracking.

4. Repeat for each instance of infrared interference.
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Calibrating a BTSensor
BTSensor Calibration Introduction
If BTSensors that were initially placed in the Space were moved after setup or bumped accidentally, the
BTSensors must be calibrated. BTSensor calibration enables the system to determine where the
BTSensors are in relation to each other using the calibration wand, and where they are in relation to the
origin using the ground plane.
Proper calibration is very important because incorrect calibrations will send incorrect position data and
erroneously aﬀect the BTSystem's accuracy.
Attention: Anytime a BTSensor is moved or bumped, BTSensor calibration must be performed and
saved to the Motive project ﬁle. See Working with Recordings for details saving and playing back Motive
recordings.

Diﬀerences Between Full Calibration and
Reﬁne Calibration
There are three ways to calibrate BTSensors: a Full calibration, a Reﬁne calibration, and a Partial Reﬁne
calibration.
Full: This method calibrate BTSensors using no previous information. This calibration is always
used when using BlackTrax in a new Space.
Reﬁne: This calibration method uses existing information from a previously saved calibration as a
starting point of the calibration. This calibration method is primarily used when BTSensors are
moved slightly after an initial calibration and needs calibration again.
Partial: This calibration method uses existing information from a previously saved calibration as a
foundation. The user selects either a Full or a Reﬁne calibration type as above, and is able to
select a number of BTSensors to perform the partial calibration upon. BTSensor calibration builds
upon the previous calibration and corrects any errors. This calibration method is primarily used
when some BTSensors are moved slightly after an initial calibration and need correction, but not
the entire BTSensor rig.

Wand Calibration
Wand calibration enables BlackTrax to determine the relative position of BTSensors to each other in
the Space. This is followed by ground plane calibration, which enables BlackTrax to determine the
BTSensor’s relative position to the ground. See Ground Plane calibration below for more information.
Note: When wanding starts, Motive records the wanding and autosaves it to the session folder.
To calibrate BTSensors with the calibration wand
1. In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.
1. Go to the Camera Calibration pane.
2. Choose either a Full or Reﬁne calibration based on the guidelines above.
3. In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading to
Custom.
4. Set the Wand Length (mm) ﬁeld to 1000.
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5. Set the Center Distance (mm) ﬁeld to 350.
2. Click Start Wanding.
Result: BTSensors record calibration wand data within the Space. The Calibration Engine
section records the samples of each BTSensor and the spread of the samples.
1. In the Physical Space, plug the power source into the calibration wand, and connect the
HPSU.
Result: The calibration wand’s LEDs should be visible in Motive as an infrared
source.
2. Wand the Physical Space by moving the powered calibration wand across the Space.
Move the wand up and down, back and forth, and rotate the head while you move, to
create diﬀerent data points (think of a ﬁgure eight motion). Ensure the calibration wand
LEDs are not covered or being blocked from BTSensor view.
Tip:
When in use, the front facing LED on the Slim 13E BTSensor turns blue to
indicate that the wand is visible.
You must ﬁll as much of a BTSensor's view with as much wanding data as
possible to improve calibration accuracy.
3. In Motive, look at the Camera Preview and Perspective View window. Perspective View shows all
BTSensors on the ground when they do the very ﬁrst wanding. Examine each BTSensor’s recording
of the calibration wand. Wand samples are represented as colored lines. Each BTSensor is
represented by a unique color. Each BTSensor should have the same number of samples recorded.
Attention:
If a BTSensor will not record samples while wanding, consult the Camera Preview
window. See if other BTSensors are detecting the wand. If the wand does not appear on
any other BTSensors, the area will not calibrate due to lack of coverage. If the wand
shows up on at least two other BTSensors, continue wanding, but adjust the path and
angle of the wand to give the BTSensors diﬀerent views. If a section of the intended
Space will not record samples after all of the steps above, cancel the calibration.
Reposition the BTSensors to obtain better overlapping ﬁeld of views of the tracking
area.
If a BTSensor will not record samples while wanding, you may deselect the problem
BTSensor in the Camera window and recalibrate with the remaining BTSensors. The
area of the Space the problem BTSensor was covering may have less accurate tracking
or even no tracking available, but the rest of the Space should be accurate.
Note: The Calibration Engine section gives feedback about the BTSensor calibration,
including the number of times the calibration wand is viewed by each BTSensor. An estimate
on the quality of the calibration is displayed based on the number of samples which were
recorded. Calibration quality can be: Low, Medium, High, or Very High.
4. Click Calculate.
Result: Motive starts to calibrate BTSensors based on the collected data. The current state of
calibration is displayed at the top of the Calibration Engine followed by the calibration result
rating and the overall quality.
Note:
The calibration data captured in Perspective View is colored to indicate data accuracy.
Blue: Less than 6mm accurate in that area.
Red: Greater than 88mm accurate in that area.
The calibration engine displays a quality rating for all BTSensors as well as the global
average and the wand average based on the Desired Quality. The quality ratings are (in
order from worst to best): Poor < Fair < Good < Great < Excellent < Exceptional.
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A full bar in the quality column is the best ranking.
A relatively high Error for a BTSensor indicates that the given BTSensor received poor
samples during calibration. Restart the wand calibration process. At least two
BTSensors must have vision of the calibration wand for data to be captured for
calibration. There is a progress bar in the Results column to highlight the quality of
each BTSensor.
While calibrating, BTSensors initially attempt to calibrate for the lowest level of quality.
Once BTSensors have met the criteria of that quality level, the system will advance to
the next level quality and attempt to calibrate. This process repeats until the highest
quality calibration based oﬀ the data has been achieved. Once exceptional quality had
been achieved, the system will apply the calibration automatically.
In the Perspective View window you can see a visualization of the wand sample
collected for calibration. The position of BTSensors will move to match their position in
the physical Space as the system determines their location.
5. Once the rating for each BTSensor reaches “Excellent” or greater, and the Overall Results quality
rating reaches “Excellent” or greater, the calibration results will automatically be applied to the
system.
To apply the calibration manually
1. In the Calibration Engine section click Apply Results.
Result: The Calibration Results Reports window will open. Calibration results are
available
2. In the Calibration Results Reports window click Apply.
Result: The calibration data will be applied to the BTSensors and they will know their
position in the Space in relation to each other. BTSensors positions can be viewed in
the Perspective View window in Motive. Ground plane calibration is required next to
determine the BTSensor’s position relative to the origin (if using a Reﬁne calibration,
you may skip ground plane calibration).
6. In Motive 2, click the File menu and select Save Current Take or click File menu and select Save
Proﬁle. In Motive 1.10 or lower , to save the changes to the project ﬁle, click the File menu and
select Save Project.

Partial BTSensor Calibrations
As mentioned above, it is possible for the user to calibrate sections of their BTSensor setup after the
initial calibration, as opposed to having to recalibrate the entire BTSensor setup (as of Motive 1.10).
The partial BTSensor calibrations are based oﬀ either a Full or Reﬁne calibration as you would do above.
To be able to complete a partial calibration, Motive needs the calibrated BTSensors as reference. These
are known as Anchor Cameras. You need at least 2 of these anchor BTSensors, in addition to the
BTSensors you wish to calibrate in order to complete the calibration successfully.
To complete a partial BTSensor calibration
1. In Motive, change the layout to Calibration preset. From the Layout menu, choose Calibration.
1. Go to the Camera Calibration pane.
2. Choose either a Full or Reﬁne calibration based on the guidelines above.
3. In the Calibration tab, under the Wand Option heading, set the OptiWand sub-heading
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to Custom.
4. Set the Wand Length (mm) ﬁeld to 1000.
5. Set the Center Distance (mm) ﬁeld to 350.
2. Select the BTSensors you would like to calibrate from the list in the Camera Pane.
3. Calibrate the system as you would above, conﬁrming you would like to only calibrate the selected
BTSensors.
4. Once complete, you do not need to set the ground plane.
Note: You will see all BTSensors collecting data. Only the selected BTSensors will use this data to
calibrate, and all other BTSensors will ignore this data. When calculating, Motive may return a poor result
overall, but this is not indicative of the actual result of just the updated BTSensors, it is reporting as if
you wanded the entire Space. It is important to verify the tracking data with a Beacon after a partial
calibration has been completed to verify the calibration results.

Known Wand Calibration Issues
Issue: When Calibration Engine is calculating, calibration might return a very high error (100+), a
very poor rating for the BTSensors, and you may see the distortion map in the Camera View warp
outside the camera square.
Solution: Either the wand data you provided Motive does not match the real world wand (check
the wand length and center distance from above) or Motive displays unsuccessful results. Reboot
Motive and run the calibration recording again through the solver and if the wanding data itself is
good, this normally ﬁxes the issue.
Issue: After calibrating multiple times the Calibration Engine will not give a Global “Excellent”
rating.
Solution: The data samples taken from wanding may be of poor quality and could be an issue.
Ensure the Space is properly masked from infrared interference, and BTSensors are aimed
correctly. Start calibration again and rewand the Space.
Note: Not all the BTSensors will always receive an 'Excellent' or greater rating. Acceptable tracking can
still be achieved with what appears to be poor results. The calibration report will let you know how
accurate each BTSensor is relative to each other. If one BTSensor is poor, it might be okay if there are
several other BTSensors seeing that same area.
Tip: The best way to verify calibration is to lay out the ground plane and ensure that each point is only
shown as 1 marker (not two or more points or the points are moving when the ground plane is sitting on
the ground and not moving).

Ground Plane Calibration
After the BTSensors are calibrated with the calibration wand, you must set the ground plane. This step
will inform the BTSystem where they are in relation to the origin. It will also inform the BTSystem the
direction of the axis.
Attention: The origin of the Space must be visible to a minimum of 2 correctly calibrated BTSensors for
ground plane calibration to be accurate.
Note: As of Motive 1.10, when performing Reﬁne, Full Reﬁne, or Partial Reﬁne calibration types, the
user does not have to reset the ground plane.
To calibrate BTSensors with the ground plane
1. In the
Physical
plane into an L shape, ensuring the5/14/2019
arms are at a
BlackTrax
Wiki Space, unfold and lock the ground
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90° angle.
2. Plug in the power source to an outlet and connect the ground plane to a power source or battery
pack.
3. Move the center marker or the ground plane over the Origin of the Space. Adjust the feet of the
ground plane to align it with the origin as deﬁned in BTWYSIWYG. You can see if the ground plane is
level with the built-in level on the ground plane arms.
Attention: The origin of the coordinate plane of the tracking area must be the same as the
origin of the virtual representation of the tracking Space as made in BTWYSIWYG. If the
virtual representation and actual tracking area do not share the same origin and axes
orientation, positional data and ﬁxture tracking will be incorrect. The origin also needs to
match any Third Parties origin connected to BlackTrax.
Tip: Mark the origin of the Space and the orientation of the axes be marked for future
reference.
4. Aim the long arm of the ground plane to the venue +Y axis.
5. Aim the short arm of the ground plane to the venue +X axis.
6. In Motive, in the Camera Calibration window, in the Ground Plane tab, set the Vertical Oﬀset (mm)
ﬁeld to 90mm.
Attention:
If the ground plane is not placed at the height of the Origin, such as on a tripod or
stage, measure the distance between the X-Y plane and the center of the ground plane
markers. Enter in this value in the Vertical Oﬀset (mm) plus 90mm.
You can oﬀset the ground plane position if the ground plane cannot be placed on the
origin due to space restrictions, such as obstructions blocking the Origin from BTSensor
view.
To oﬀset the ground plane
1. Measure the distance (mm) on each axis from the Origin to the ground plane's
position.
2. Record the diﬀerence in the Capture Volume Translation table.
3. Click Apply Translation.
Note: Each time you Apply Translation, the origin will oﬀset by 1 by each
unit you speciﬁed. You should clear the oﬀsets back to 0 after making them
in case the button is hit accidentally after you ﬁnish setting it.
Attention: It is possible to rotate the ground plane’s position in Motive
without physically moving the ground plane
To rotate the ground plane
Click Apply Rotation.
Enter in the desired rotation values in the Capture Volume Rotation table.
7. To apply the ground plane calibration, click Set Ground Plane.
Result: The BTSensors will know their position in relation to the ground and adjust
accordingly in Camera View window in Motive.
8. In Motive 2, from the File menu, choose Save Current Take or from the File menu, choose Save
Proﬁle. In Motive 1.10 or lower, to save the changes to the project ﬁle, from the File menu, choose
Save Project.
Note: The axis in Motive is diﬀerent than the axis in BlackTrax. Please keep that in mind
when oﬀsetting the ground plane in Motive. For reference:
BlackTrax +X = Motive -X
BlackTrax +Y = Motive +Z
BlackTrax +Z = Motive +Y
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Tracking Mode
Table of contents:
Tracking Mode Settings
Customizing Tracking Bounds
Optional View Settings
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Tracking Mode Settings
After BTSensors are calibrated, minor adjustments need to be entered in Motive for the system to switch
from BTSensor calibration to tracking mode. These settings enable ﬁxture tracking to occur. Once
tracking mode is conﬁgured, no changes to the Motive project are needed unless BTSensors were moved
or bumped since BTSensor calibration.

Motive 2
To conﬁgure BTSensors for normal tracking
1. In Motive, change the layout to Conﬁguration preset. From the Layout menu, choose
Conﬁguration.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Conﬁguration from the drop-down menu of layout presets.
2. In Devices window, click Filters under the Properties section.
3. On the Filters section, click the Filters Type drop-down menu and click None.
4. In the Application Settings window, click the Live Reconstruction tab.
5. On the Live Reconstruction tab, select the Enable Point Cloud Reconstruction checkbox.
6. On the Reconstruction Settings section, click Marker Labeling Mode and then click Active and
Passive Markers or Active Markers Only to set Motive for tracking.
Result: Active and passive markers or only active markers are displayed on the Perspective
View window.
7. In the Streaming window, under the OptiTrack Streaming Engine heading, select the Broadcast
Frame Data checkbox.
Under the Network Interface Selection heading, set the Local Interface ﬁeld to Local loopback.
Close the Data Streaming window.
8. In the Synchronization window, click the Synchronization drop-down box and then click Custom
Synchronization.
9. Under the Sync Input heading in the Details section, click the Source drop-down menu and then
click Reserved.
10. Under the Sync Input heading in the Details section, type 5000 on the Sync Oﬀset (us) ﬁeld.
11. On the Synchronization section, click Apply.
Note: The Input Monitor section can be used to immediately check if the TimeKeeper is connected
correctly to the eSync and Motive. In the Reserved ﬁeld of the Input Monitor section, there should be a
value of around 100 Hz (or close to this number). This means Motive is receiving the TimeKeeper sync
signal. If this number is not in the range of 99.998 - 100.004 Hz (or close) there may be a conﬁguration
issue with the TimeKeeper, and you should report the issue to a BTE to be resolved.

Note: If you experience Tracking issues after conﬁguring these settings, reset Motive Settings from the
BlackTrax GUI. If your issue is not resolved, please contact BlackTrax support for further assistance.

Motive 1.10 or lower
To conﬁgure BTSensors for normal tracking
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1. In Motive, change the layout to Conﬁguration preset. From the Layout menu, choose
Conﬁguration.
2. In the Synchronization window, under Synchronization, click Custom Synchronization from the dropdown menu.
1. Under the Sync Input heading, set the Source ﬁeld to Reserved.
2. Set the Synchronization oﬀset to 5000.
3. Click Apply
Note: The Input Monitor section can be used to immediately check if the TimeKeeper is
connected correctly to the eSync and Motive. In the Reserved ﬁeld of the Input Monitor
section, there should be a value of around 100 Hz (or close to this number). This mean
Motive is receiving the TimeKeeper sync signal. If this number is not in the range of
99.998 - 100.004 Hz (or close) there may be a conﬁguration issue with the TimeKeeper,
and you should report the issue to a BTE to be resolved.

Note: If you experience Tracking issues after conﬁguring these settings, reset Motive Settings from the
BlackTrax GUI. If your issue is not resolved, please contact BlackTrax support for further assistance.
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Customizing Tracking Bounds
Motive can have restrictions placed to customize tracking. Infrared sources, such as a LED Stringer of a
BTBeacon, that are outside these restrictions will not be acknowledged by the system.

Motive 2
Limiting Tracking Within Boundaries
In Motive, as an optional step, you can create a boundary around the Space. The boundary commands
the system to ignore infrared sources outside this boundary. BTBeacon positional data found outside the
boundary will not be sent downstream to other applications.
To deﬁne boundaries, you need to measure how far the origin of the Space is from the intended
boundary in the Space. This is required for each axes (XYZ). The origin of the Space should be the same
origin as the duplicate Space made in WYSIWYG.
Attention: In Motive, the Z axis represents length and the Y axis represents height. For the rest of
BlackTrax the Z axis represents height and the Y axis represents length. +X also becomes -X in Motive.
Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking occurs
below the origin, ensure the value can cover the intended tracking area.
To set the tracking boundary of the space
1. In Motive, change the layout to Running preset. From the Layout menu, choose Running.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Running from the drop-down menu of layout presets.
2. In the Application Settings window, click the Live Reconstruction tab.
3. On the Live Reconstruction tab, click the Advanced Options heading to open the Advanced Options
section.
4. On the Advanced Options section, click the Reconstruction Bounds heading to open
the Reconstruction Bounds section.
5. On the Reconstruction Bounds section, click the Visible Bounds drop-down menu and select True.
Result: The set tracking boundary of Space is displayed in the Perspective View window. The
set tracking boundary of the Space will not be displayed in the Perspective View window if
False is selected.
6. Set the Minimum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) X axis (width).
7. Set the Maximum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) X axis (width).
8. Set the Minimum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Y axis (height).
9. Set the Maximum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Y axis (height).
10. Set the Minimum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Z axis (length).
11. Set the Maximum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Z axis (length).
12. Close the Reconstruction Properties window.
Result: The boundary in your Space is deﬁned. Tracking is only possible inside this
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boundary.
13. To save as a proﬁle, select Save Proﬁle or Save Proﬁle As from the File menu.
Tip: You can also export the BTSensor calibration data. See To export a calibration CAL ﬁle.
To set BlackTrax BTSensor beam length
Attention: The Maximum distance should be the largest distance between a BTSensor and the furthest
tracking boundary. The minimum distance should be the shortest distance between a BTSensor and the
closest tracking boundary.
Note: After BTSensor calibration, Motive automatically determines these values with estimates of
acceptable tracking distances. You may override these values at any time, but if you re-calibrate these
ﬁelds will be re-populated.
1. In Motive, change the layout to Running preset. From the Layout menu, choose Running.
Tip: You may click the drop-down box at the right hand side of the main toolbar and click
Running from the drop-down menu of layout presets.
2. In the Application Settings window, click the Live Reconstruction tab.
3. On the Reconstruction Settings section of the Live Reconstruction tab, set the Maximum Ray
Length ﬁeld to the desired maximum length.
4. On the Reconstruction Settings section of the Live Reconstruction tab, set the Minimum Ray Length
ﬁeld to the desired minimum length.
5. To save as a proﬁle, choose Save Proﬁle or Save Proﬁle As from the File menu.
Result: The beam length of BTSensors will be set. BTSensors will only acknowledge
BTBeacons within this range.
Tip: You can also export the BTSensor calibration data. See To export a calibration CAL ﬁle.

Motive 1.10 or lower
To set BlackTrax BTSensor beam length
Attention: The Maximum distance should be the largest distance between a BTSensor and the furthest
tracking boundary. The minimum distance should be the shortest distance between a BTSensor and the
closest tracking boundary.
1. Open the Reconstruction Properties window. To open the window, from the View menu, choose
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Options heading set
the Minimum Ray Length ﬁeld to the desired minimum length.
3. Set the Maximum Ray Length ﬁeld to the desired maximum length.
4. Save the changes to the project ﬁle. To save, from the File menu, choose Save Project.
Result: The beam length of BTSensors will be set. BTSensors will only acknowledge
BTBeacons within this range.
Note: After BTSensor calibration, Motive will automatically determine these values with
estimates of acceptable tracking distances. You may override these values at any time, but if
you re-calibrate these ﬁelds will be re-populated.

Limiting Tracking Within Boundaries
In Motive, as an optional step, you can create a boundary around the Space. The boundary will tell the
system to ignore infrared sources outside this boundary. BTBeacon positional data found outside the
boundary will not be sent downstream to other applications.
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To deﬁne boundaries you will have to measure how far the origin of the Space is from the intended
boundary in the Space. This will need to be done for each axes (XYZ). The origin of the Space should be
the same origin as the duplicate Space made in WYSIWYG.
Attention: In Motive, the Z axis represents length and the Y axis represents height. In the rest of
BlackTrax the Z axis represents height and the Y axis represents length. +X also becomes -X in Motive.
Note: Be aware of the -Y setting for your Space. If the origin of the Space is elevated and tracking occurs
below the origin, ensure the value can cover the intended tracking area.
To set the tracking boundary of the space
1. Open the Reconstruction Properties window. To open the window, from the View menu, choose
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction
Bounds heading set the Bound Reconstruction ﬁeld to True.
3. Set the Minimum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) X axis (width).
4. Set the Maximum X (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) X axis (width).
5. Set the Minimum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Y axis (height).
6. Set the Maximum Y (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Y axis (height).
7. Set the Minimum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the negative (-) Z axis (length).
8. Set the Maximum Z (meters) ﬁeld to the distance from the origin of the Space to the intended
boundary on the positive (+) Z axis (length).
9. Close the Reconstruction Properties window.
Result: The boundary in your Space will be deﬁned. Tracking is only possible inside this
boundary.
10. Save the changes to the project ﬁle. To save, from the File menu, choose Save Project.
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Optional View Settings
Because every Space is diﬀerent, there are certain BTSensor settings that will be unique. This section
provides guidelines on certain Motive settings which will create an accurate tracking environment.

Motive 2
To enable visualization of the tracking boundary
If the tracking boundaries of the Physical Space were enabled and deﬁned, the limits can be visualized
after BTSensors have been calibrated.
1. In Motive, change the layout to Conﬁguration preset. From the Layout menu, choose
Conﬁguration.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Conﬁguration from the drop-down menu of layout presets.
2. In the Application Settings window, click the Live Reconstruction tab.
3. On the Live Reconstruction tab, click the Advanced Options heading to open the Reconstruction
Bounds section.
4. On the Reconstruction Bounds section, click the Visible Bounds drop-down menu and click True.
Result: The set tracking boundary of the Space will be displayed in the Perspective View
window.
5. To save the take, choose Save Current Take or Save Current Take As from the File menu.
6. To save as a proﬁle, choose Save Proﬁle or Save Proﬁle As from the File menu.
To disable visualization of the tracking boundary
1. In Motive, change the layout to Conﬁguration preset. From the Layout menu, choose
Conﬁguration.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Conﬁguration from the drop-down menu of layout presets.
2. In the Application Settings window, click the Live Reconstruction tab.
3. On the Live Reconstruction tab, click the Advanced Options heading to open the Reconstruction
Bounds section.
4. On the Reconstruction Bounds section, click the Visible Bounds drop-down menu and click False.
Result: The set tracking boundary of the Space will not be displayed in the Perspective View
window.
5. To save the take, choose Save Current Take or Save Current Take As from the File menu.
6. To save as a proﬁle, choose Save Proﬁle or Save Proﬁle As from the File menu.

Motive 1.10 or lower
To enable visualization of the tracking boundary
If the tracking boundaries of the Space have been deﬁned, and enabled the limits can be visualized after
BTSensors have been calibrated.
1. Open the Reconstruction Properties window. To open the window, from the View menu, choose
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Advanced Options section, under the
Reconstruction Bounds heading set the Visible Bounds ﬁeld to True.
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Result: In the Perspective View window, the boundary of the Space appears as a transparent
volume.
3. Save the changes to the project ﬁle. To save, from the File menu, choose Save Project.
To disable visualization of the tracking boundary
1. Open the Reconstruction Properties window. To open the window, from the View menu, choose
Reconstruction Properties.
2. In the Reconstruction Properties window, in the Point Cloud section, under the Reconstruction
Bounds heading set the Visible Bounds ﬁeld to False.
Result: The visualization of the tracking boundary is disabled.
3. Save the changes to the project ﬁle. To save, from the File menu, choose Save Project.

Adding a Reticle to BTSensor Views
A reticle (cross-hair) can be added to all BTSensor views to aid in aiming and position.
Note: When the aim-assist feature is used on a BTSensor, a reticle is automatically toggled on for that
BTSensor.

Motive 2
To add a reticle to all BTSensor views
1. In Motive, change the layout to Aiming preset. From the Layout menu, choose Aiming.
Tip: You may click the drop-down box on the right-hand side of the toolbar and click Aiming
from the drop-down menu of layout presets.
2. On the Application Settings window, click the Views tab.
3. On the Views tab, click the 2D Display Options heading to open the 2D Display Options section.
4. On the 2D Display Options section, click the Reticles drop-down menu and click True.
Result: Reticles are displayed on all connected BTSensor views in Motive.
Tip: When you are on the Multi-Camera 2D View, you may click the Visual Aids icon and
select the Reticles menu to enable.

Motive 1.10 or lower
To add a reticle to all BTSensor views
1. Open the Application Settings window. To open the window, from the Edit menu, choose
Application Settings....
2. In the Application Settings window, in the Display tab, under the 2D Display Options heading, set
the Camera Reticle ﬁeld to True.
Result: Reticles appear on all connected BTSensor views in Motive.
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Recording in Motive
Table of contents:
Introduction
Modes in Motive
Working with Recordings
Calibrating BTSensors from a Recording
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Recording Introduction
In Motive, you can save recordings of tracked objects and you can play back these recordings at another
time. You can record the wanding of the Space while calibrating BTSensors. The recorded wanding can
be played back anytime instead of physically repeating the wanding of the Space.
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Modes in Motive
In Motive, there are three modes of operation: LIVE, REC (Record) and EDIT. Modes act as a reminder of
where information shown in the Perspective View and Camera View window is originating from.

Motive 2
The Status Bar is always docked at the bottom of Motive, and it provides both recording and navigation
controls over Motive's primary operating modes.
LIVE/REC mode
EDIT mode
LIVE: Information shown in LIVE mode is happening in real-time. Everything shown is what
BTSensors see at the present time. When in LIVE mode, a green image is displayed in Perspective
View.
Note: LIVE mode is the default mode of Motive.

REC: Information shown in REC mode is happening in real-time and being recorded to ﬁle for later
use. Everything shown is what BTSensors see at the present time. When in REC mode, a red image
is displayed in Perspective View and a red border appears around the Perspective View and Camera
View windows.

EDIT: Information previously recorded is being played back. Everything shown is what BTSensors
saw during a recording in REC mode. When in EDIT mode, a blue image is displayed in Perspective
View.

Attention: When Motive is in EDIT mode, no live data is sent through the BTSystem. Be sure that no
application downstream of BlackTrax is relying on tracking information while switching between LIVE and
EDIT modes.

Motive 1.10 or lower
LIVE: Information shown in LIVE mode is happening in real-time. Everything shown is what
BTSensors see at the present time. When in LIVE mode, a green image is displayed in Perspective
View.
Note: LIVE mode is the default mode of Motive.
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REC: Information shown in REC mode is happening in real-time and being recorded to ﬁle for later
use. Everything shown is what BTSensors see at the present time. When in REC mode, a red image
is displayed in Perspective View and a red border appears around the Perspective View and Camera
View windows.

EDIT: Information previously recorded is being played back. Everything shown is what BTSensors
saw during a recording in REC mode. When in EDIT mode, a blue image is displayed in Perspective
View.

Attention: When Motive is in EDIT mode, no live data is sent through the BTSystem. Be sure that no
application downstream of BlackTrax is relying on tracking information while switching between LIVE and
EDIT modes.
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Working with Recordings
Motive 2
To record in Motive
1. In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.
2. On the Status Bar, type a name for the recording in the Take ﬁeld.
3. To start recording, click the Red Circle on the right-hand side of the window.
Result: Motive enters REC mode. A red outline appears around the Perspective View and
Camera View windows. Any trackable object in the Space will be recorded to ﬁle.
4. To stop recording, click the Red Circle again.
Result: Motive exits REC mode. The recording will be saved as a ".tak" ﬁle.

To play back a recording in Motive
1. In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.
2. To open the previous recording that you want to use, double-click the ".tak" ﬁle from the list in the
Project pane.
Result: Motive enters EDIT mode and the Status Bar changes to the EDIT mode functions. A
timeline of the recording is displayed.
Note: Click any point in the timeline and the recording jumps to the selected point.
3. On the Status Bar, Click the Play button (arrow icon) to play the recording in the Timeline window.
Result: The recording of what BTSensors saw is replayed on the system. The BTSystem acts
as if the recording is actually happening in real-time.

Motive 1.10 or lower
To record in Motive
1. In Motive, from the View menu, choose Timeline (or go to Layouts > Recording).
Result: The Timeline window will open.
2. In the Timeline window, enter a name for the recording in the Take ﬁeld.
3. To start recording, click the Red Circle on the right-hand side of the window.
Result: Motive will enter REC mode. A red outline will appear around the Perspective View
and Camera View windows. Any trackable object in the Space will be recorded to ﬁle.
4. When you want to stop recording, click the Red Circle again.
Result: Motive will exit REC mode. The recording will be saved as a .tak ﬁle.
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To play back a recording in Motive
1. In Motive, from the View menu, choose Timeline and Project (or click Layout > Recording).
Result: The Timeline and Project windows will open.
2. Open the previous recording you want to use by double-clicking the .tak ﬁle from the list in the
Project pane.
Result: Motive will enter EDIT mode and the Timeline window will change to EDIT mode
functions. A timeline of the recording will be displayed.
Note: By clicking at any point in the timeline, the recording will jump to that point.
3. Click the Play button (arrow icon) to play the recording in the Timeline pane.
Result: The recording of what BTSensors saw will be replayed for the system. The BTSystem
will act as if the recording were actually happening in real-time.
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Calibrating BTSensors from a Recording
Each time you calibrate the BTSensors in Motive, the software automatically starts the recording of the
wanding. You can use this recording at a later date to re-calibrate your system, without the need of
physically wanding again.

Motive 2
To calibrate from a recording
1. In Motive, change the layout to Recording preset. From the Layout menu, choose Recording.
Tip: You may click the drop-down box at the right-hand side of the main toolbar and click
Recording from the drop-down menu of layout presets.
2. To open the previous recording that you want to use, double-click the ".tak" ﬁle from the list in the
Data pane.
Result: Motive enters EDIT mode, and the Status Bar changes to EDIT mode functions and
the timeline of the recording is displayed.
3. From the View menu, choose Camera Calibration Pane.
4. In the Camera Calibration window, ensure your wand settings match the previous wanding that was
applied. Choose to do a Full or Reﬁne calibration type.
Note: If the source recording was a Full calibration type, you must select Full calibration type
again.
5. In the Camera Calibration window, click Start Wanding to begin the calibration process.
Result: Motive scans the recording for the selected samples. After a few seconds, Motive
returns the same samples, and you can calculate the result as with a normal calibration.
6. On the Status Bar, click LIVE to return the system to LIVE mode.
7. Set your ground plane as per normal.
Note: This step is only required if Full calibration type was selected.

Motive 1.10 or lower
To calibrate from a recording
1. In Motive, from the View menu, choose Timeline and Project (or select Layout>Recording)
2. To open the desired recording, double-click the .tak ﬁle from the list in the Project pane.
Result: Motive will enter Edit mode, and the timeline window will change to Edit mode
functions. A timeline of the recording will be displayed.
3. From the View menu, choose Camera Calibration.
4. In the Camera Calibration window, ensure your wand settings match what they were when the
wanding took place. Choose if you wish to do a Full or Reﬁne calibration type.
5. Press Start Wanding to begin the calibration process.
Result: Motive will now scan the recording for the samples which were selected. After a few
seconds, it will return the same samples, and you can calculate the result as with a normal
calibration.
6. On the Timeline, click the Live button, to return the system to Live mode.
7. Set your ground plane as per normal.
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BlackTrax GUI
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Before Using BlackTrax
Attention: Before running the BlackTrax GUI, you must complete the following mandatory steps to
ensure a successful BlackTrax experience:
Set up the BTSystem in the Space: The BTSystem needs to be physically installed in the Space.
See BTSystem Hardware Conﬁguration for more information.
Create a ﬁle in BTWYSIWYG: A .wyg ﬁle provides BlackTrax with information on Trackables,
Fixtures and Space dimensions. From a .wyg ﬁle, you can either generate a .btx ﬁle or send the
necessary information directly between programs. See Creating a .btx ﬁle in BTWYSIWYG for more
information.
Conﬁgure and Calibrate BTSensors using Motive: Use Motive to conﬁgure BTSensors to
inform the BTSystem on how to track and share positional information with other components.
See Calibrating a BTSensor for more information.
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BlackTrax User Interface
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UI Introduction
When BlackTrax launches for the ﬁrst time, the BlackTrax Splash Screen appears while BlackTrax is
preparing to load, and then the Portfolio Manager window opens. In the Portfolio Manager window, you
can add a new portfolio which stores the BlackTrax, BTWYSIWYG and Project History backup ﬁles.
A project is launched from the Portfolio Manager and opens into Edit view. How the Portfolio Manager is
subsequently displayed at startup depends on the Open most recent Portfolio when BlackTrax starts
setting in the System section of System Conﬁguration (enabled by default).
Before the Edit view and the other views of BlackTrax are explained, we will ﬁrst deﬁne the options in
Portfolio Manager and describe the various parts of the user interface.
The Splash Screen upon launch of BlackTrax

The Portfolio Manager upon opening

The Default state of the BTGUI upon opening
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Portfolio Manager
Portfolio Manager at ﬁrst launch

All project ﬁles are saved via the Portfolio Manager.
Upon installation of BlackTrax, the BlackTrax Portfolios folder is created to your default drive where
saved project ﬁles for BlackTrax and BTWYSIWYG are automatically saved.
The Portfolio Manager displays the list of saved Portfolios.
The Portfolio Manager displays the name of the currently opened Portfolio.
Project History (.btbak) backup ﬁles are automatically generated when a project is saved manually
or in Auto Save. The backup ﬁles are saved in the Project History folder that is automatically
created in the BlackTrax Portfolios folder.
In the Portfolio Manager, you can:
Add a new Portfolio.
Duplicate a Portfolio.
Delete a Portfolio.
Sort the displayed list of Portfolios.
Import a ﬁle(s) into new Portfolios.
Open a Portfolio folder.
Launch a Portfolio.
Close a Portfolio.
To add a portfolio
1. In Portfolio Manager, click the Add (+) button.
Result: The New Portfolio dialog box appears.
2. Type the name of the new Portfolio in the Portfolio Name box.
Result:
The new Portfolio folder is added to the BlackTrax Portfolios folder and the name is
added to the list of Portfolios in Portfolio Manager.
The new BlackTrax and BTWYSIWYG ﬁles are generated and saved in the new Portfolio.
To duplicate a portfolio
1. In Portfolio Manager, select the Portfolio that you want to duplicate.
2. Click the Duplicate button.
Result: The Duplicate Portfolio dialog box appears.
3. Type the name of the duplicate Portfolio in the Portfolio Name box.
Result:
The duplicate Portfolio folder is added to the BlackTrax Portfolios folder and the name is
added to the list of Portfolios in Portfolio Manager.
The BlackTrax and BTWYSIWYG ﬁles are renamed and saved into the new Portfolio.
Note: Project History is not duplicated.
To delete a portfolio
Note: A Portfolio that is currently in use cannot be deleted.
1. Close BTWYSIWYG. Portfolio Manager will not delete the ﬁles if BTWYSIWYG is open.
2. From the list of Portfolios displayed in Portfolio Manager, click on the Portfolio that you want to
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delete.
Result: The selected Portfolio is highlighted.
3. Click the Delete button.
Result: The selected Portfolio folder and all the BlackTrax and BTWYSIWYG ﬁles in the folder
are deleted from the BlackTrax Portfolios folder.
To sort the displayed portfolios by name
1. In Portfolio Manager, click on the drop-down arrow and choose the Sort: Name drop-down menu.
Result: The list of Portfolios will be displayed in alphabetical order.
To sort the displayed portfolios by date
1. In Portfolio Manager, click on the drop-down arrow and choose the Sort: Date drop-down menu.
Result: The list of Portfolios will be displayed with the most recent Portfolio on top and the
oldest Portfolio at the bottom.
To import a ﬁle(s) from a portfolio
BlackTrax and BTWYSIWYG ﬁles can be imported into new Portfolios. When importing ﬁles, the user does
not need to import all ﬁle types. If no ﬁle is imported for a given section, the template ﬁle will be used for
that portion of the Portfolio.
1. In Portfolio Manager, click the Import File(s) button.
Result: The Import File(s) dialog box appears.

2. Type the new name of the Portfolio in the Portfolio Name box.
3. Select the BlackTrax Project checkbox to include BlackTrax ﬁles that will be imported and added to
the new Portfolio.
4. Click on the ellipsis button to browse and select the BlackTrax ﬁle.
Result: The link appears in the BlackTrax Project box.
5. Select the BTWYG Project checkbox to include BTWYSIWYG ﬁles that will be imported and added to
the new Portfolio.
6. Click on the ellipsis button to browse and select the BTWYSIWYG ﬁle.
Result: The link appears in the BTWYG Project box.
Note: The unchecked portions of the Portfolio will default to a new, empty ﬁle.
7. Click Create Portfolio.
Result:
BlackTrax and BTWYSIWYG projects that were imported into the new Portfolio open.
BlackTrax and BTWYSIWYG ﬁles are renamed and copied to the BlackTrax Portfolios
folder.
To open a portfolio folder
1. In Portfolio Manager, select a Portfolio.
2. Click the Open Folder button.
Result:
The folder of the selected Portfolio opens in the browse dialog.
The name of the open Portfolio is highlighted in blue in the Portfolio Manager window.
Note: By default, all BlackTrax Portfolios folders are saved in C: > BlackTrax Portfolios >
Portfolio Name > BlackTrax folder and BTWYG folder.
BlackTrax Wiki

156 of 298

5/14/2019

To launch a portfolio
1. In Portfolio Manager, select a Portfolio.
2. Click the Launch Portfolio button.
Tip: You may double-click the selected Portfolio.
Note: If you have Outputs that are assigned to NICs that do not exist on the current machine,
a dialog box will appear asking you to select a new NIC.
1. On the NIC dialog box, click on the drop-down menu of the displayed outputs to
change the NIC for each output.
2. On the NIC dialog box, click OK.
Result:
The new NIC is assigned to the desired output.
All the BlackTrax and BTWYSIWYG ﬁles in the selected Portfolio open.
The Messages window of BlackTrax appears showing the most recent change in the
state of the system.
New Portfolios open with 12 Trackables by default for BlackTrax and BTWYG.
Notes:
How the Portfolio Manager is displayed at startup depends on the Open most recent Portfolio
when BlackTrax starts setting in the System section of System Conﬁguration (on by default).
The Open most recent Portfolio when BlackTrax starts feature is disabled if a license check
fails when opening the Main GUI.
BlackTrax always opens to the Edit View.
How BTWYSIWYG ﬁles open from the Portfolio Manager depends on the Launch BTWYG ﬁle
with Portfolio setting in the System section of System Conﬁguration (enabled by default).
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Layout of the BlackTrax GUI
The functions of BlackTrax are divided into three simple core views. You may customize how the GUI lays
out the various toolbars and widgets to your liking, and as such, this documentation refers to the default
layout of the GUI. Along the left of the window are the View toolbar and Sub-View toolbar where you may
click and navigate to the diﬀerent views. The views of BlackTrax are:
Live view: The Live view is where you monitor a BlackTrax project. From this view, you have the ability
to manually switch between Chapters and Books or enable Chapter Control from a console. You can
connect or disconnect BlackTrax modules to the system as well as view the current BTBeacon patch,
data and their Trackables. You may choose which Trackables are displayed based on group, active
chapter, or all available. Only the information that was saved and applied to the project is displayed in
Live view.
Live View
Edit view: The Edit view is where you assign ﬁxtures to follow Trackables and program your Chapters.
An instance of ﬁxtures and Trackable relationships is called a chapter. Chapters can be edited, saved and
managed on this page. You can also create and manage Books. Books are collections of Chapters. You
may control how a ﬁxture follows a Trackable using Fixture Settings. Various ﬁxture settings and how
they connect to BlackTrax are managed from this view.
Edit View
Calibration view: The Calibration view is the parent of Calibration sub-views. Each sub-view oﬀers
settings and operations speciﬁc to the type of calibration. The sub-views available are Fixture Calibration
view and Frame Calibration view.
Note: Calibration view in itself is not a view, but automatically defaults to the last active sub-view once
clicked.
Fixture Calibration sub-view: Fixture Calibration sub-view allows you to correct and adjust approved
movable ﬁxtures connected to BlackTrax, ensuring precision when following Trackables. Features of
ﬁxtures that can be calibrated are the pan and tilt settings and pan and tilt motor mapping (DMX to
angle). The calibration proﬁles can be created, exported and imported for use as needed.
Fixture Calibration sub-view
Frame Calibration sub-view: Frame Calibration allows you to create and edit Rigid Body and Soft Body
Frames. A Frame is a collection of beacons and LEDs that form an object. From this view, you
can construct, oﬀset, and move the centroid and orientation of a Frame as well as rename them.
Frame Calibration sub-view
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Full Screen Mode
BlackTrax can display the GUI in a full screen mode. You can hide the Windows interface and focus
directly on your programming/tracking work.
To switch between full screen or windowed mode
1. From the View menu, choose Full Screen Mode or Windowed Mode.
Tip: You may click the Enter(Exit) Full Screen Mode icon on the Main Toolbar or click F11.
Result: BlackTrax GUI switches to full screen from the default windowed mode, or BlackTrax GUI
switches back to the default windowed mode from full screen.

Note: If you are in full screen mode, and launch one of the BT Modules via the Modules menu,
BlackTrax will switch to windowed mode upon launching the module.
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Menu Bar
BTGUI Menu Bar
The Menu Bar across the top of the GUI is where you will ﬁnd access to all functions of the software. The
diﬀerent menu bars are:
File: Saving of projects, as well as updating BTWYG information. You can also export various
functions such as ﬁxture calibration data and a programming report.
Edit: Undo, Redo and Discard Changes can be found here.
Discard Changes will rollback changes made in the BlackTrax project to the last savepoint
created. If no savepoint was created, the project will revert to as it was when originally
opened.
View: All docking widgets for the current view can be found here as well as options to
manipulate saved views.
Settings: Modify system and project settings.
Modules: Access to the various modules of the BlackTrax System, including BTEngine and BTWYG
Help: About information for your current release of BlackTrax and quick access to the License
Folder.
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File Menu
BlackTrax File Menu

Introduction
The File menu is where you can save, update, revert BlackTrax Projects and create Motive Projects. You
can update a .btprj ﬁle with a .btx ﬁle from BTWYG, or via the Apply BTWYG Updates when new
BTWYG information is sent to BlackTrax.
Other features that are available are being able to import and export calibration data, as well as
exporting chapter programming data for reference as an .html ﬁle.
You can also exit BlackTrax from this menu.

Reverting to a Project History File
From the File menu, you can choose Revert Project to select and open a Project History ﬁle of the
BlackTrax Portfolio that is currently in use.
To revert to a BlackTrax history ﬁle
1. From the File menu, choose Revert Project.
Result: The Revert Project dialog box appears showing the menu list of the dates and times
of the saved Project History ﬁles.
Tip:
You may click on the Revert Project icon on the main toolbar.
You may click on the Backup Date and Time arrow in the Revert Project dialog box to
sort the list in ascending or descending order.
2. In the Revert Project dialog box, click on a Backup Date and Time.
3. Click Revert.
Result: The Project History backup ﬁle associated with the date and time displayed opens
and the currently opened project is saved and archived in Project History.

Updating BTX Projects
If a BTWYSIWYG ﬁle (.btx) has been edited since it was used to make a BlackTrax project ﬁle (.btprj),
Update BTX Projects can be used to update the BlackTrax project ﬁle. Any new .btx information will be
carried over to the existing .btprj while maintaining any work you have already done to the project.
To update a BlackTrax project with new information from BTWYSIWYG via a .btx ﬁle
1. From the File menu, choose Update Project.
Result: The Browse window appears.
2. In the Browse window, navigate to the edited .btx ﬁle location, and select the ﬁle.
3. Click Open.
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Result: Information from the .btx ﬁle (e.g. ﬁxtures, trackables, Space dimensions) will be
loaded into BlackTrax project ﬁle (.btprj).
To update a BlackTrax project with new information from BTWYSIWYG directly
1. In BTWYG, go to Live Mode
2. From the Live menu, choose BlackTrax Panel (If BlackTrax panel is closed).
Result: The BlackTrax panel appears.
3. Ensure BTWYG is connected to BlackTrax (if it is not, click connect).
4. In the BlackTrax window, click BTX Apply.
5. In BlackTrax, from File menu, choose Apply BTWYG Updates.

Saving BlackTrax Projects
BlackTrax projects are saved as a .btprj ﬁle. Save Project will save the open BlackTrax project to the
same ﬁle name and location under which it was previously saved.
To save a BlackTrax project using Save Project
1. To save the current project, from the File menu, click Save.
Result: The currently open project is saved in the portfolio and a Project History backup
(.btbak) ﬁle is created.

Importing and Exporting Fixture Calibration Data
You can import and export ﬁxture calibration data to be used at a later date. This is useful to backup just
calibration data, as well as exporting calibration data to be used in lighting consoles. In both cases for
import and export, if no ﬁxtures are selected in Calibration Views > Fixture View window, then all
ﬁxtures with calibration data will be exported/imported. If ﬁxtures are selected, then only the selected
ﬁxtures will export/import.
To import ﬁxture calibration data
1. From the File menu, choose Import and then choose Fixture Calibration.
Result: The Browse window appears.
2. Browse to the .btcal ﬁle and open it.
Result: The calibration data stored in the .btcal is applied.
To export ﬁxture calibration data
1. From the File menu, choose Export then choose Fixture Calibration.
Result: The Export Calibration browse window appears.
2. Under ﬁle type, select if you want to export .btcal (for importing back into a .btprj ﬁle) or .xml (for
importing into lighting consoles or other devices).
3. Browse to the folder you wish to save the ﬁle.
4. Click Save.
Result: All calibrated ﬁxture data is exported.

Importing and Exporting Output
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Conﬁguration Data
You can import and export output conﬁguration data to conﬁgure the current tracking output or store
tracking output data for later use.
To import output conﬁguration data
1. From the File menu, choose Import and then choose Outputs.
Result: The Browse window appears.
2. Browse to the .btoc ﬁle and open it.
Result: The Output Import Details window appears. The table in the Output Import Details
window displays the output conﬁguration settings that will be imported into your project.

3. In the Output Import Details window, select the checkbox of the following options:
Create New: This option will create the new outputs as deﬁned in the New Outputs section.
Delete Existing: This option will delete any outputs in the Deleting Outputs section. These
existing outputs are already present in the BlacTrax project.
Overwrite Existing: The current output conﬁguration deﬁned in the Existing Outputs section
will be replaced with the settings of the output conﬁguration being imported.
Note: The checkbox will only appear if an output being imported has that option (i.e. Check
New will only appear if there are new outputs).
4. If an output data with the same name is already present in your ﬁle, the changes will be
highlighted, and you are given the option to overwrite the current output with these new settings.
5. The Output Conﬁguration data stored in the .btoc is applied to the current project in BlackTrax.
To export output conﬁguration data
1. From the File menu, choose Export and then choose Outputs.
Result: The Export Calibration window appears.
2. Under ﬁle type, select if you want to export .btoc.
3. Browse to the folder you wish to save the ﬁle.
4. Click Save.
Result: All Output Conﬁguration data is exported to the selected folder.
Note: The project ﬁle must ﬁrst be saved before you can export output conﬁgurations.

Exporting a Show Report
You can export a show report from the Export menu, which contains all the information regarding the
programming of the show, including chapters, trackables, and Frames.
To export a show report
1. From the File menu, choose Export and then choose Show Report.
The Export Show Report window appears.
2. Browse to where you would like to save the ﬁle and click on Save.
Result: The ﬁle is saved and contains all project information as of the export in an .html
format.
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Closing BlackTrax
You can close BlackTrax from the ﬁle menu, at which point it will ask you to save the project, if changes
were detected.
To close BlackTrax
1. From the File menu, choose Exit BlackTrax.
2. If prompted, save or discard project changes.
Result: The GUI is now closed.
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Edit Menu
Introduction
The Edit menu is where you can undo or redo your changes, or discard your changes and revert back to
the last time you hit the Apply Changes button.

Undo
If you want to reverse the last action you applied, you can easily reverse the action by using the Undo
tool available on the Edit menu.

Redo
If you did not want to reverse the previous undo action you applied, you can easily reverse the previous
undo action by using the Redo tool available on the Edit menu.

Discard Changes
Each time you click Apply Changes, a snapshot is created of the current editing and live space. As you
make changes, Changes: Blind will highlight in the status bar, alerting you that new changes have not
been made live. Normally, you would click on Apply Changes to apply your new edits live to the stage,
but in the event you wish to discard your changes and revert back to the last time you click Apply
Changes:
To discard your changes
1. From the Edit menu, choose Discard Changes.
2. Click Yes to conﬁrm you wish to discard all changes.
Result: All changes are discarded back to the last time you clicked Apply Changes.
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View Menu
View Menu

Introduction
The View menu contains all docking widgets, both global and per view, view shortcuts, and common
widget operations. If you are ever curious about what can be done/opened, the View menu should prove
helpful.

Top Section
The top section of the View menu contains you're three core views (Live View, Edit View, Calibration
Views), and Calibration Views' two sub-views (Fixture View and Frame Calibration View). Click on
each one will take you to the selected view and hovering over Calibration Views will give you access to
the two sub-views.

Upper Middle Section
This section contains commonly used widget functions.

Switching to Full Screen Mode
The BlackTrax GUI can be displayed in full screen mode. You can hide the Windows interface and work
directly on programming and tracking.
1. From the View menu, choose Full Screen Mode or Windowed.
Tip: You may click the Enter(Exit) Full Screen Mode icon on the main toolbar or click F11.
Result: BlackTrax GUI switches to full screen mode from the default windowed mode, or BlackTrax
GUI switches back to the default windowed mode from full screen.

Resetting All Views to Factory Defaults
If at any point you are not happy with the layout you have created, you may click Reset View to restore
the GUI's views back to factory default.
1. From the View menu, choose Reset View.
Result: Any custom views you have created (moved docking widgets, ﬂoated widgets to other
screens, or changes the sizing of widgets) will be reverted to factory defaults.
Note: This will aﬀect all views and cannot be undone.

Closing All Widgets
If you want to close all open widgets and just focus on the center pane in the GUI, you may use the Close
BlackTrax Wiki

166 of 298

5/14/2019

All Widgets option.
1. From the View menu, choose Close All Widgets.
Result: Any widgets currently open, including docked and ﬂoating on other monitors, will be
closed.
Note: This will only aﬀect the current view and cannot be undone.

Lower Middle Section
This section contains all global widgets, meaning anything you can open and access across all views. In
this section you will ﬁnd:
Beacon Patch
BTWYG Patch
Beacons
Messages
System Log
Note: Each widget remembers its location per view only. Meaning if you take Beacon Patch and move it
to a second monitor in Edit view, then switch to Live view, Beacon Patch will reset to its last saved
position in Live view (if no last saved position is available, it will revert to the factory default position).

Bottom Section
This section contains all per-view widgets, meaning each widget is only found in one view and can not be
shared between other views. In this section, per view, you will ﬁnd:
Live View
Running Books (In Multi Book Projects)
Running Chapters
Modules
Trackable Details
Edit View
Edit Books (In Multi Book Projects)
Edit Chapters
Libraries
Fixture Settings
Trackable Settings
Undo Stack
Terminal
Fixture Calibration Sub-View
Fixture Calibration Control
Fixture Calibration Properties
Fixture Calibration Points
Frame Calibration Sub-View
Frame LEDs
Rigid Frame Construction
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Settings Menu
Settings Menu

Introduction
The Settings menu contains links to all the widgets that contain settings for the software, the current
project or the option to change between Chapter or Book mode.

Menu
Output Conﬁguration: The Output Conﬁguration widget displays the active tracking output data
from the Output Modules and Trackable Settings as a result of the tracking operation in BlackTrax.
Project Properties: In Project Properties, you will ﬁnd settings and information of the current
project such as the show name, author, and description (all editable), and the settings that will
change the DMX input for Chapter Control Channel, Book Control Channel, and the Merging
Channel.
Chapter
Universe: Speciﬁes the universe used for Book and Chapter Control Channels
Book Control Channel: The Book Control Channel speciﬁes the DMX channel which will
be used to trigger Book changes from a lighting console in a Multi Book Project.
Chapter Control Channel: The Chapter Control Channel speciﬁes the DMX channel
which will be used to trigger Chapter changes from a lighting console.
Merging Channel
Enable Monitoring: When this checkbox is enabled the current DMX value of the
Merging Channel will be displayed in the Status Bar.
Universe: Speciﬁes the universe used for the Merging Channel.
Merging Channel: The Merging Channel is just a monitoring channel and does not
control the merging channel. The Merging Channel must be set in the merge node and
monitored from the GUI.
System Conﬁguration: In System Conﬁguration, you will ﬁnd settings that will change the
software behaviors (such as Fixture Calibration behavior, warning prompts, and autofocus behavior
going to BTWYG).
Reset Settings: The ability to reset Blacktrax, Motive or BT Engine settings to their original
manufacturer settings. During the reset, all tracking operations will pause momentarily.
Change Book Mode: Click on the Change Book Mode to switch BlackTrax between Standard
Chapters (no Books) mode or Extended Chapters (with Books) mode.
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Modules Menu
BlackTrax Modules Menu

Introduction
The Modules menu launches these modules that are used with BlackTrax. If you are in full screen mode,
selecting a module will exit full screen mode.

Modules
Module Status: Displays the list of currently active modules. See Module Status page.
BTEngine: Launches the Tracker, Follower, and Monitor modules as background tracking modules
with settings that are integrated within the Output Conﬁguration window of the Settings menu.
Tracking Adapter module is launched when an output is present in the project.
Tracker module is a background process that takes the positional data of a BTBeacon from
the Motive module, the corresponding BTBeacon idetiﬁcation data from the BTRouter, and
combines this data together.
Follower module is a background process that takes positional data from the Tracker,
generates angle and DMX values for moving light ﬁxtures, and forwards the data to other
modules for their own use. BTWYSIWYG uses the data from Follower to virtualize real-time
lighting tracking. Follower also listens to ArtNet/sACN from a console or from other sources.
Monitor module is a background process that maintains communication and command
settings of multiple Tracking Adapters that were set in the Output Conﬁguration window.
Tracking Adapter module is a background process that is an extension of Tracker's RTTrPM
output. It is used by the BTSystem to customize RTTrPM data for Third Party use. The
Tracking Adapter receives data provided by the Tracker module and customizes this data
based on preferences conﬁgured in the Tracking Adapter. This customized data is then sent
oﬀ to designated Third Party programs for their use.
BTWYG: Launches the BTWYG ﬁle associated with the currently open Portfolio.
Simulator: Identiﬁcation and positional data of BTBeacons can be created, conﬁgured and
managed in simulation. See Simulator Module page.
Cue: Realtime or simulated tracking data in BlackTrax can be recorded and saved as Chapters for
playback. See Cue Module page.
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Module Status
The Module Status widget displays the list of modules that are currently active with the corresponding
link connections. In the widget, you may click the Discover button to display the currently active module
connections.
In the Module Status widget, you may right-click on a module to restart or exit the module (excluding
BTWYG). In the Module Status widget, you may click Shutdown BTEngine to close all BTEngine modules
at once.

Modules Status widget
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Help Menu
The Help menu is where you will ﬁnd the shortcut to the License Folder location, and the About
BlackTrax dialog box with information about BlackTrax, product version, and build number.
The default License Folder location is C:\bt_run_time\license. For information on how to download the
license, please refer to the link .
The About BlackTrax dialog box:
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Toolbars
Main Toolbar in Live View

MainToolbar in Edit View

Main Toolbar in Calibration View > Fixture View

Main Toolbar in Calibration View > Frame View

View Toolbar

View and Sub-View Toolbar

There are three toolbars in the BlackTrax GUI: Main, Views, and Sub-Views.
Main: On top of the left side, contains basic operations such as saving , as well as common
functions found throughout the software such as Reset View, Beacon Patch, and a fullscreen option.
On the right side, you have access to the most used docking widgets found in your current view.
The right side of the toolbar will change depending on which view you are currently in.
Views: The ability to change between the three core views: Live, Edit, and Calibration.
Sub-Views: Sub-views are available for the Calibration View. Each sub-view oﬀers functions
related to a speciﬁc type of calibration.
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Docking Widgets
Frame Construction Docking Widget

The GUI is comprised of several docking widgets, each covering features and functionally to control,
calibrate, and operate the system. You can ﬁnd all available docking widgets under the View menu, and
the most common widgets available in the toolbar.
All docking widgets comprise of a 'ﬂoat' and 'close' function. Floating a widget will detach it from the GUI,
and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the View menu or toolbar.
Diﬀerent widgets function in diﬀerent ways, and their speciﬁc function will be covered in other sections of
this documentation.
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Status Bar
Status Bar with a running show
Along the bottom of the screen, the status bar displays important system information at a glance. The
following information is available for view:
Attention: The following status icons act as buttons and can be clicked on to toggle following.
Mode Status: Displays if calibration mode is active or normal mode is active.
Normal Mode: Fixtures follow according to chapter programming and current chapter.
BlackTrax controls pan and tilt, and optionally zoom, iris, and dimming of intensity.
Fixture Calibration Mode: Fixtures follow according to the Fixture Calibration View, and
BlackTrax controls intensity, pan, tilt, zoom, iris, colour, and gobo. Chapters are ignored.
Attention: The calibration status icons act as buttons and can be clicked on to toggle calibration.
Current Chapter: Displays the chapter currently active.
MCV: Stands for Merging Channel Value and displays the current DMX value from the console of
the merging channel.
Note: The numbers beside "MCV" will ﬂash colors when a new DMX packet is received by
BlackTrax.
DMX Input: Indicates if the system is receiving DMX information either from ArtNet or sACN. An
animated icon indicates the system is receiving information.
Motion Control: Indicates if the system is receiving motion information. An animated icon
indicates the system is receiving information.
BTWYG Updates: Indicates if the system is receiving an update from BTWYG via the BTX Apply
function.
Messages: A button to access the messages widget.
Changes: Indicates if changes are Live (everything is actively sending to the lighting ﬁxtures and
all constructed Frames are reporting position) or Blind (changes that have been made, but are not
actively sending to the real world system or live space). The Apply Changes button will apply the
changes to the live space.
Any change made to the BlackTrax project will be saved to a temporary savepoint. The
savepoint that was created will last until the BlackTrax project is closed.
The blue LED next to the Changes: Live indicator will turn to a ﬂashing red LED next to the
Changes: Blind indicator whenever changes are made to the project but are not yet applied
to the live space.
Apply Changes: Click Apply Changes to apply any blind changes to the live space.
Result: The changes made from the selected option/s will be applied to the live space and
blue LED next to Changes: Live will be displayed.

Mode Status
To enable ﬁxture calibration
1. When in Normal Mode, in the status bar, click the Normal Mode button to switch to Fixture
Calibration Mode.
Result: BlackTrax is set to Fixture Calibration Mode and the features of the Fixture Calibration view
is unlocked.
To disable
ﬁxture calibration
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1. When in Fixture Calibration Mode, in the status bar, click the Fixture Calibration button to switch to
Normal Mode.
Result: BlackTrax is set to Normal Mode and the Fixture Calibration view features is locked.
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Live View
Table of Contents:
Running Chapters Widget
Running Books Widget
Trackable Details Widget

Live View showing all Trackables in the BlackTrax Project

Live Trackables
In the main window at the center area of the Live View is where you will ﬁnd live trackable information,
showing the current BTBeacon patch data and their Trackables. There are a few diﬀerent options for
viewing this data.

Icon View
This view displays Trackable Data in the same way it is represented in the Beacon Patch Docking Widget.
Displayed are:
Trackable container with Trackable Name
Any assigned beacons with their relevant information
An indicator beside the beacon number to indicate if the beacon is currently visible (Blue) or not
(Grey)

Live Trackables with Icon View

Table View
This view displays live trackable information with live LED status monitoring in the following columns:
Trackable with name
Assigned Beacon
Battery Status
Radio Status: Fresh data (Blue), Stale data (Red)
Visibility of the trackable: Visible (Blue), Not-visible (Grey)
Status of the individual LED associated with the trackable: Active (Blue), Inactive (Grey)

Live Trackables with Table View

Small View
This view displays Trackable Data that is represented as small icons with the Trackable Name, beacon
number with the relevant information and the indicator. Click on the box beside Small View to select this
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display option. Displayed are:
Small Trackable container icon with Trackable Name
Any assigned beacons with their relevant information
An indicator beside the beacon number to indicate if the beacon is currently visible (Blue) or not
(Grey)

In addition to the views mentioned above, there are further sorting options available to show the relevant
data as the user prefers. They are:

Show per Chapter
This option will show only trackables currently assigned to the currently running chapter.

Per Chapter Live Trackables using the Icon View

Show by Group
This option will show any trackables that have been assigned to a group through the Trackables docking
widget. When showing by group, an additional drop-down menu appears to allow the selection of groups.
For information on Trackable group creation, refer to Grouping Trackables in the Libraries widget section
of this manual.

Displaying Trackables in a selected group

Tab Views
There are also two options for displaying trackable information while using the Icon View.
Centroid Tab will display battery information, as well as the XYZ Calculated centroid of a trackable,
as well as Roll, Pitch, Yaw and BTBeacon information.
LED Tab will display battery information, as well as the XYZ information of individual LED Stringers
connected to the beacon.
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Running Chapters Widget
Overview
The Running Chapters widget contains the list of recalled Chapters, which can be selected to become
active. The Running Chapters widget displays:
Names and descriptions assigned to the recalled Chapters.
Tracking status of the recalled Chapters.
Fixture calibration preset that was applied to the recalled Chapter.
When Tracking is active, assigned ﬁxtures will follow the Trackables assigned to the selected active
Chapter. Selecting which Chapter to activate can be controlled by using manual control in BlackTrax, or
using DMX via Art-Net or sACN from a connected lighting console.

Running Chapters Widget

Manual Chapter Control
Manual control enables control of chapters from within the BlackTrax GUI.
To enable manual control of chapters
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. On the drop-down menu, click Manual.
To select a chapter to be active using manual control
1. In the Running Chapters widget, from the list of saved Chapters, click on the Chapter.
Result: The selected Chapter will have an Active icon in the Active ﬁeld to show it is
currently active. Fixtures assigned to the selected Chapter will follow the assigned Trackables
in the Space.

DMX Chapter Control
With DMX control enabled, the selection of which chapter is active can be controlled from a lighting
console.
To enable DMX control of chapters
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. On the drop-down menu, click DMX Input.
Result: The connected lighting console has control over the selected Chapter. The Universe
and Address used to control the Chapters from the lighting console are displayed in the
bottom left-hand corner of the center widget and in the Status Bar. The Chapter Control DMX
value is also displayed at the bottom 178
left-hand
corner of the Running Chapters5/14/2019
widget.
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To toggle auto scrolling to an active chapter
With DMX Input enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the
chapter list always display the active chapter when enabled.
1. In the Running Chapters widget, click Auto Scroll.
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Running Books Widget
Overview
The Running Books widget contains the list of created Books that can be recalled to become active.
When a Book is recalled, the list of Chapters in the Book is displayed in the Running Chapters widget.
Selecting which Book to recall can be controlled by using manual control in BlackTrax, or using DMX via
Art-Net or sACN from a connected lighting console.

Running Books Widget

Manual Book Control
Manual control enables the control of Books from within the BlackTrax GUI.
To enable manual control of books
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. On the drop-down menu, click Manual.
To select a book to be active using manual control
1. In the Running Books widget, from the list of created Books, click the Book.
Result: The selected Book will have an Active icon in the Active ﬁeld to show it is currently
active. The list of Chapters in the selected Book will be displayed in the Running
Chapters widget.

DMX Chapter Control
With DMX control enabled, selecting which Book to recall can be controlled from a lighting console.
To enable DMX control of books
1. In the center widget of Live View where the Icons are displayed, click on the drop-down menu at
the bottom left-hand corner.
2. On the drop-down menu, click DMX Input.
Result: The connected lighting console has control over the selected Book and all the
Chapters in the Book. The Universe and Address used to control the recalled Book and
Chapters from the lighting console are displayed in the bottom left-hand corner of the center
widget and in the Status Bar. The Book Control DMX value is also displayed at the bottom
left-hand corner of the Running Books widget.
To toggle auto scrolling in the active chapter
With DMX Input enabled, the Auto Scroll feature becomes available for use. Auto Scroll will make the
Books list always display the active Book when enabled.
1. To toggle auto scrolling, in the Running Books widget, click Auto Scroll.
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Trackable Details Widget
Trackable Details Widget

Overview
This widget is used to monitor the details of beacons assigned to any Trackables in the currently selected
Chapter that have a Rigid or Soft frame assigned to them. Selecting a Trackable with a Rigid or Soft
frame assigned to it in the central widget of the Live View will display all the beacons which the Rigid or
Soft frame is assigned. The widget lists the name of all the beacons assigned to the frame, as well as the
battery status, and a visibility icon (Blue for visible, red for not visible, grey for inactive).
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Editing View
Table of Contents:
Chapter Conﬁguration
Edit Chapters Widget
Edit Books Widget
Libraries Widget
Fixture Settings Widget
Basic Tab
Oﬀset Tab
Auto Spot Tab
Zones Tab
Trackable Settings Widget
Programming Chapters
Undo Stack
Terminal Widget
Error Codes for Unsupported Fixtures

Overview
The Editing View is where moving ﬁxtures are assigned to follow the position of Trackables in chapters. A
chapter is saved information on which Trackables are to be tracked, and which ﬁxtures are to follow them
at a speciﬁc instance. Speciﬁc customization can also be enabled in a chapter such as conﬁguring how a
BTBeacon’s LEDs should be used for Tracking; if a zone is to be used in the chapter; and if a terminal
command is used to alter tracking behavior.
Edit View Overview
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Chapter Conﬁguration
Single Chapter Conﬁguration
The central widget in the Editing View is where you modify Chapters and assign Trackables and Fixtures
to the chapters. The Single Chapter tab is where you modify settings for the currently selected chapter in
the Edit Chapters widget. With a chapter selected in the Edit Chapters widget, you can drag trackables
from the Trackables Library into the top pane of the central widget to assign the trackable to the selected
Chapter. You can also copy/paste Trackables using the "Copy/Paste" buttons, and delete selected
trackables from the selected chapter using the "Delete" button.
When you assign a trackable to a chapter then select the chapter and corresponding trackable you wish
to assign ﬁxtures to, you can drag the desired ﬁxtures from the Fixtures library in the Libraries widget to
the bottom pane of the central widget. You can also possible to copy/paste Fixtures using the
"Copy/Paste" buttons, and delete selected ﬁxtures from the selected trackable/chapter using the "Delete"
button.
Select a ﬁxture in the bottom pane of the central widget and open the Fixture Settings widget to apply
ﬁxture settings.
In the Single Chapter tab, ﬁxtures are displayed in List View or Table View. You can add ﬁlters in each
view to display ﬁxtures with speciﬁc settings.
Uses Iris: Will show if a ﬁxture uses iris to change the beam size.
Uses Prediction: Will show if a ﬁxture has prediction settings.
Has Oﬀset: Will show if a ﬁxture has any oﬀset settings applied.
Has Following Setting: Will display if a ﬁxture is assigned to follow speciﬁc LEDs of assigned
BTBeacons.
Uses LED 1: Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 1.
Uses LED 2: Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 2.
Uses LED 3: Will display if a ﬁxture is assigned to follow the LED in BTBeacon port 3.
Uses Zones: Will show if a ﬁxture uses zoom to change the beam size.
Uses Auto-Spot Mode: Will show if a ﬁxture has Auto-Spot mode settings.
Uses Zoom: Will show if a ﬁxture has any zone settings applied.
Table View displays all ﬁxtures assigned to the currently selected trackable in a table format. You may
conﬁgure the columns to display an icon according to the applied ﬁxture settings. The columns are Spot
ID, and Type, followed by any of the settings enabled in the following list:
LED Following
Zoom
Iris
Smooth Pickups
Auto Douse
Sensitivity
Oﬀset
Auto Spot Mode
Zone
Click the Clear Trackable Selection button at the bottom of the top pane of the central widget to clear the
selected individual trackable or all the selected trackables.
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Click the Clear Fixture Selection button at the bottom of the bottom pane of the central widget to clear
the selected individual ﬁxture or all the selected ﬁxtures.

Several Chapter Conﬁguration

In the Several Chapters tab in the central widget, settings can be applied to several ﬁxtures at once and
across multiple chapters.
To select multiple chapters and have them appear in the widget
1. In the Edit Chapters widget, select the chapters.
2. At the bottom of the central widget, click the Scan Chapters button.
Result: All ﬁxtures in the selected chapters displayed.
3. in the Fixture Settings widget, change and apply the desired settings.
If you select the Auto-Select checkbox, then there is no need to click Make Selection, you can simply
select the ﬁxtures you want to apply settings to and change the settings of each ﬁxture in the Fixture
Settings widget. You may clear the Auto-Select checkbox if you are selecting several ﬁxtures at once
(more than 1000 across all chapters).
Use the Search box to search for ﬁxtures by spot number or ﬁxture type across the selected chapters.
Click the Clear Selection button at the bottom to clear the selected individual ﬁxture or all the selected
ﬁxtures.
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Edit Chapters Widget
Overview
The Edit Chapters widget is where Chapters are created, removed, and re-ordered. The selected chapter
or chapters in this widget deﬁne what is displayed in the central pane of the Edit View, in Single Chapter,
or Several Chapters mode.
The Edit Chapters widget is where Preset Calibrations are displayed, recalled and selected for each
Chapter.

Edit Chapters Widget

Functionality
The following actions can be performed in the Edit Chapters widget:
To create a new chapter
1. In the Edit Chapters widget, click the Plus button.
Result: A blank chapter is created in the chapter list below the currently selected chapter.
2. For the changes to take eﬀect, click Apply Changes.
To create a copy of an existing chapter
Copying a chapter will copy all aspects of the selected chapter, including ﬁxture and Trackable
relationships.
1. In the Edit Chapters widget, select the chapter you want to copy.
2. Click the Copy selected chapter button.
Result: A copy of the chapter is created in the chapter list below the currently selected
chapter.
3. For the changes to take eﬀect, click Apply Changes.
To delete a chapter
1. In the Edit Chapters widget, select the chapter you want to delete.
2. Click the Delete button.
Result: A dialog box appears asking if you really want to delete the chapter.
3. To conﬁrm deletion, click Yes.
4. For the changes to take eﬀect, click Apply Changes.
To move chapters in the chapter list
1. In the Edit Chapters widget, select the chapter you want to move.
2. Click the Up Arrow or Down Arrow button to move the selected chapters up or down.
3. For the changes to take eﬀect, click Apply Changes.
To name a chapter
1. In the Edit Chapters widget, in the Name ﬁeld of the chapter, double-click to enable editing.
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2. Enter the name of the chapter in the Name ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To write a description of a chapter
1. In the Edit Chapters widget, in the Description ﬁeld of the chapter, double-click to enable editing.
2. Enter the chapter description in the Description ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To select a preset calibration for a chapter
1. In the Edit Chapters widget, highlight the row to select a Chapter.
2. In the highlighted Chapter row, double-click on the Preset Calibration ﬁeld.
3. Select the preset from the Preset Calibration drop-down.
Result: The ﬁxture calibration data collected under the selected preset is applied to the
selected Chapter.

Edit Chapters Widget in Multi Book Mode
Edit Chapters Widget

In Extended Chapters (with Books) mode, the Edit Chapters Widget displays the name of the selected
Book where the current selected Chapter is accessed. See Edit Books Widget.
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Edit Books Widget
Overview
When BlackTrax is in Multi Book mode, Chapters can be created, edited, saved and managed as part of
a Book or Books. In the Edit Books widget, a Book with Chapters can be created, removed, re-ordered or
selected for editing. The Chapters in the selected Book will be displayed in the Edit Chapters widget for
editing.

Edit Books Widget

Functionality
The following actions can be performed from the Edit Books widget:
To select a chapter from a book
1. In the Edit Books widget, from the table list of Books, click on the Book that contains the Chapter
you want to select.
Result: The list of Chapters available in the selected Book are displayed in the Edit Chapters
widget. You can proceed to select the Chapter from the Edit Chapters widget.
To create a new book
1. In the Edit Books widget, click the Plus button.
Result: A blank Book is created in the Book list below the currently selected Book.
2. For the changes to take eﬀect, click Apply Changes.
To create a copy of an existing book
Copying a Book will copy all the Chapters in the selected Book, including ﬁxture and Trackable
relationships in all the Chapters in the selected Book.
1. In the Edit Books widget, select the Book you want to copy.
2. Click the Copy selected book button.
Result: A copy of the Book is created in the Books list below the currently selected Book.
3. For the changes to take eﬀect, click Apply Changes.
To delete a book
1. In the Edit Books widget, select the Book you want to delete.
2. Click the Delete button.
Result: A dialog box appears asking if you really want to delete the Book.
3. Click Yes to conﬁrm deletion.
4. For the changes to take eﬀect, click Apply Changes.
To move books in the books List
1. In the Edit Books widget, select the Book you want to move.
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2. Click the Up Arrow or Down Arrow button.
3. For the changes to take eﬀect, click Apply Changes.
To name a book
1. In the Edit Books widget, double-click the Name ﬁeld of the selected Book.
2. Write the name of the Book in the Name ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
To write a description of a book
1. In the Edit Books widget, double-click the Description ﬁeld of the selected Book.
2. Write the description in the Description ﬁeld.
3. For the changes to take eﬀect, click Apply Changes.
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Libraries Widget
Overview
The Libraries widget contains all Trackables, Fixtures, and Zones that can be applied to Chapters in the
Editing View. The widget is separated into three tabs, one each for Trackables, Fixtures, and Zones. Each
type of assignable item can be dragged from the Libraries widget into its respective pane in the Edit
view. The top pane for trackables, bottom pane for ﬁxtures being assigned to trackables, and into the
Fixture Settings widget for Zones.

Trackables Tab
The Trackables tab is organized in a table format with three columns: Name, WYG Trackable, and
Patch status.
Name: The name of the trackable in BlackTrax, which can be changed by double-clicking the name
ﬁeld on the widget.
WYG Trackable: The name of the trackable when it was exported from BTWYSIWYG.
Patched: The patch status indicates whether or not the trackable has been assigned to a chapter
or chapters. A blue checkmark is displayed to indicate that the Trackable has been assigned to a
chapter or chapters.
Depending on your BlackTrax project, you may have a large amount of Trackables to keep track of. The
Search Trackables function helps you to sort and locate the exact Trackables you need.

Libraries Widget viewing the Trackables Tab

To search for a trackable
The only way to search for a Trackable is by searching for the Trackable Name assigned in BlackTrax.
1. In the Search ﬁeld of the Trackables tab , enter the name of the Trackable(s) you are looking for.
Result: The Trackables List in the Trackables tab will display only Trackables that meet your
search criteria.

Grouping Trackables
The Group feature in this widget can be used to group selected trackables and display together in Live
mode.
To group trackables
1. From the list in the table, select the Trackables you would like to group together.
2. Click the Group drop-down menu and select New Group From Selected.
Result: The New Trackable Group dialog box appears.
3. Enter the group name in the Group Name ﬁeld on the New Trackable Group dialog box.
Result: The group of Trackables is created and appears in the Group drop-down menu.
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Note: The Delete Group button deletes the currently selected group (but not the Trackables
themselves).
Note: The current group selection does change the ﬁltering of the Trackable tab.

Fixtures Tab
The Fixtures tab is organized in a table structure with columns for Spot ID, Fixture Name, whether or
not it is assigned, and which Trackables it is assigned to in the currently selected chapter.
Like Trackables, there is built-in search functionality to search by patch info, ﬁxture name, or by WYG
Trackable assignment.

Libraries Widget viewing the Fixtures Tab

To search for a ﬁxture
1. In the Fixtures section, select from the Search By... drop-down menu how you want to search for
Fixtures.
Note:
By Spot ID will search for Fixtures based on the ID assigned in BTWYSIWYG.
By Fixture Name will search for Fixtures based on how a Fixture is named in BlackTrax.
By Trackable will search for Fixtures currently assigned to a Trackable (in the selected
chapter) based on the BT Trackable name. (For example, if you search for Trackable
name Iron Man, all ﬁxtures assigned to Iron Man will be displayed.)
2. In the Search Fixtures ﬁeld, enter the name of the Fixture(s) you are looking for.
Result: The Fixture List will display only Fixtures that meet your search criteria.

Grouping Fixtures
The Group feature in this widget can be used to group selected ﬁxtures together for programming.
Creating a ﬁxture group will automatically select all ﬁxtures in that group at the time of creation.
Selecting a ﬁxture group will automatically select all ﬁxtures in that group.
To group ﬁxtures
1. From the list in the table, select the ﬁxtures you would like to group together.
2. Click the Group drop-down menu and select New Group From Selected.
Result: The New Fixture Group dialog box appears.
3. Enter the group name in the Group Name ﬁeld on the New Fixture Group dialog box.
Result: The group of Fixtures is created and appears in the Group drop-down menu.
Note: The Delete button deletes the currently selected group (but not the Fixtures
themselves).

Zones Tab
The Zones tab has three columns, the Zone Name, the Shape Type and Dynamic. The Dynamic
column for
Zones indicates if the Zone is dynamic/assigned
to a Trackable. You can search5/14/2019
by the Zone
BlackTrax Wiki
190 of 298

Names.

Libraries Widget viewing the Zones Tab
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Fixture Settings Widget
Table of contents:
Basic Tab
Oﬀset Tab
Auto Spot Tab
Zones Tab

Overview
The Fixture Settings widget is where you conﬁgure how ﬁxtures interact with Trackables in a speciﬁc
chapter. Fixture Settings is separated into four tab sections: Basic, Oﬀset, Auto Spot and Zones. The
tabs will be explained in detail in the following pages.

Fixture Settings - Basic tab

You can select a single ﬁxture, or multiple ﬁxtures in the center pane of Edit View to have Fixture
Settings display the collective settings. In multi-ﬁxture selection, there is always an 'active' ﬁxture, which
displays its current settings in the Fixture Settings widget. The active ﬁxture is indicated by the name
and spot ID of the ﬁxture at the top of the Fixture Settings widget.
When you select multiple ﬁxtures, any diﬀerences between ﬁxtures will be highlighted in blue. For
example: Spot 1 has a zoom setting of 1m and Spot 2 has a zoom setting of 2m. When you select both
ﬁxtures, the text box will highlight blue to indicate a diﬀerence between the two selected ﬁxtures.

Fixture settings - Basic tab (With multiple ﬁxtures selected, diﬀerences highlighted and

Intensity Control features marked.)
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Basic Tab
Basic tab is where you conﬁgure general settings of a ﬁxture. The size of the beam using the zoom or iris
of the ﬁxture. Controlling how the ﬁxture deals with pan-ﬂips. What sensitivity is used when the ﬁxture
follows the trackable.

Fixture Settings - Basic tab

Beam Size Control
BlackTrax allows you to control the size of a ﬁxture’s beam while it is following a Trackable. This is done
using the iris or zoom features of a ﬁxture. The beam setting of a ﬁxture is linked to the chapter it was
created. Fixtures can be in multiple chapters and have diﬀerent beam sizes in each chapter.
If both zoom and iris control are enabled, the BTSystem will tell the ﬁxture to ﬁrst use zoom control to
shape the beam size. Using both the iris and zoom can increase the range.
To control the beam size of a ﬁxture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the method of controlling the beam size by selecting the
checkbox next to the desired method.
Result: The Beam Diameter and Distance Range settings appear.
5. In the Beam Diameter ﬁeld, enter the desired beam diameter (in meters).
Result: The Distance Range displays at what distance from the ﬁxture the beam diameter
can be maintained.
6. For the changes to take eﬀect, click Apply Changes.

Intensity Control
Additional Pan-Flip Dimming Time: This feature manages how a ﬁxture should behave if it
encounters a pan-ﬂip during tracking in the chapter. When a ﬁxture encounters a pan-ﬂip in
BlackTrax, the ﬁxture will douse, perform the ﬂip then turn back on. The time it takes for the
ﬁxture to turn back on is determined by the speed of the ﬁxture's pan/tilt motors as deﬁned in
WYSIWYG. The Pan-Flip Dimming feature is always enabled and the slider is available to add
additional time after WYSIWYG's time before the ﬁxture turns back on (for example, in cases where
the ﬁxture is slower than what WYSIWYG has on ﬁle).
To add pan-ﬂip dimming time
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Basic tab in the Fixture Settings widget.
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4. In the Additional Pan-Flip Dimming Time ﬁeld, specify the number of seconds or use the slider
to add extra pan-ﬂip dimming time.
Note: The range of time is limited to 0-3 seconds.
5. For the changes to take eﬀect, click Apply Changes.
Smooth Pickups: This feature turns the ﬁxture On once as a single event per chapter, only when
the Beacon is visible.
BlackTrax checks for motion at the beginning of the chapter.
BlackTrax automatically douses the ﬁxture to 0 if motion is not detected. When motion is
seen, the ﬁxture fades in to console control over the fade time speciﬁed once the Trackable
Visible For: time has elapsed (motion must be seen continuously during this time for the fade
to start).
When completed, the Smooth Pickups feature is disabled for the remainder of the chapter.
Smooth Pickups is disabled by default.
To enable and set smooth pickups
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the checkbox Smooth Pickups.
5. Click on the Trackable Visible For: scroll box to set the length of time required for a Trackable to be
visible and the light to fade in.
6. Click on the Fade-in time: scroll box to set how long the light fades in.
Auto Douse: This feature turns the ﬁxture On only when the Beacon is visible and as an ongoing
event all throughout the course of the chapter.
If all LEDs of the patched Beacon becomes hidden, BlackTrax automatically douses the ﬁxture
to 0 (from console control) after the reaction time is complete.
BlackTrax automatically fades in the ﬁxture when at least one LED is visible and after the
reaction time is complete.
Reaction time is the length of time required for motion to be visible, or to be hidden before
the fade time starts.
To enable and set auto douse
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the checkbox Auto Douse.
5. Click on the Reaction Time: scroll box to set the length of hidden or visible time for fade time to
start.
6. Click on the Fade-In Time: scroll box to set how long the light fades in.
7. Click on the Fade-Out Time: scroll box to set how long the light fades out.

Following Sensitivity
Sensitivity determines exactly how a ﬁxture is supposed to follow a Trackable. The prediction algorithms
takes the current BTBeacon and ﬁxture information and makes an informed prediction on where the
Trackable will be next. The BTSystem will then be able to anticipate where the ﬁxture needs to aim to
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keep tracking tight on the Trackable.
The prediction algorithm available are:
None: No prediction is used.
Note: When the Following Sensitivity is set to None or Multiple, the Ahead Time and Delay
Time settings and options are not displayed.
Standard Prediction: Taking the pan and tilt settings of ﬁxtures following the Trackable, a Kalman
ﬁlter is used to estimate the velocity and poisition of the ﬁxture. A prediction of the ﬁxture's future
pan/tilt values is then created.
Delay: Fixtures will follow a Trackable’s position after a set amount of time. This causes ﬁxtures to
follow behind moving Trackables. Useful for eﬀects.
Linear Prediction: Taking the current BTBeacon position as input, a Kalman ﬁlter is used to estimate
the velocity, and position of the Trackable. A prediction of the Trackable’s future movement is then
created.
Second Order Prediction: Taking the current BTBeacon position as input, a Kalman ﬁlter is used to
estimate the acceleration, velocity, and position of the Trackable. A prediction of the Trackable’s
future movement is then created.
Second Order+Prediction: Taking the pan and tilt settings of ﬁxtures following the Trackable, a
Kalman ﬁlter is used to estimate the acceleration, velocity, and position of the ﬁxture. A prediction
of the ﬁxture’s future pan/tilt values is then created.
Fixture responsiveness can also be conﬁgured with prediction. Fixture responsiveness is measured on a
scale of -4 (Smooth) to 2 (Responsive).
Smooth: A ﬁxture set to smooth will follow Trackables in a ﬂuid manner. This may appear as a
delay in extreme cases.
Responsive: A ﬁxture set to responsive will jump to and track every slight movement of a
Trackable. This may appear very jumpy in extreme cases.
Note: It is recommended that you test a ﬁxture’s prediction prior to use, to determine if the chosen
prediction movement is right for your tracking needs.
To assign an algorithm to a ﬁxture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Basic Settings section, select the desired sensitivity from the Sensitivity drop-down
menu.
If you want the ﬁxture to be tracking ahead of where the Trackable will be, enter how far
ahead in time (milliseconds) in the Ahead Time ﬁeld.
5. Assign how reactive you want the ﬁxture to follow by adjusting the Turner value slider to between
Smooth or Responsive.
6. For the changes to take eﬀect, click Apply Changes.
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Oﬀset Tab
Oﬀset tab is where you conﬁgure LED Following Settings for selecting which individual LEDs of a
BTBeacon assigned to follow a Trackable should follow.

Fixture Settings - Oﬀset tab

LED Following Settings
Each Trackable can have the LEDs of assigned BTBeacons tracked individually by the BTSystem. This can
be used instead of the default setting which is the average position of all visible LEDs. Tracking can also
be altered, to follow a Trackable but on an oﬀset.
To assign a ﬁxture to an individual LED of a trackable
1. In the Edit Chapters widget, select the chapter the ﬁxture is in.
2. On the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. On the LED Following Settings section, click on the drop-down menu and choose the LED you
want to follow.
5. For the changes to take eﬀect, click Apply Changes.
To oﬀset the tracking of a trackable by a ﬁxture
1. In the Edit Chapters widget, select the chapter the ﬁxture is in.
2. On the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. In the LED Following Settings section, select the Enable Oﬀset checkbox to set the tracking oﬀset
from the X, Y, or Z axis.
5. Under the Oﬀset subsection, enter how far oﬀ from the centroid you want to oﬀset tracking in the
X, Y or Z axis by entering the values in the X, Y or Z ﬁelds.
6. For the changes to take eﬀect, click Apply Changes.
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Auto Spot Tab
Auto Spot tab is where you conﬁgure the following properties of a ﬁxture to better mimic a human follow
spot operator.

Fixture Settings - Auto Spot tab

Auto Spot Mode Settings
Auto Spot Mode is where a ﬁxture simulates the behavior of a manual follow spot. In normal operation,
moving ﬁxtures will lock on to a Trackable and follow all movement, even if the movement is very slight.
This has the possibility of making the ﬁxture’s light look shaky or jittery. In Auto Spot Mode, when a
Trackable is relatively still, the following ﬁxture will freeze in place. When the Trackable starts to make
larger movements, and/or attempt to exit the frozen light beam, the ﬁxture will unfreeze and continue
following tightly.
There are two diﬀerent follow spot modes to choose from. They can be used independently or together.
The diﬀerent auto spot modes are:
Local Damping: The system will ignore small movements on all axis. Select the Enable Local
Damping Mode checkbox to display Radius and Enter Time.
Radius: Click on the Radius scroll box to adjust the size of the movement. Refer to the
diagram below.
When a given Trackable is only moving within this value, in relation to the Enter Time,
the ﬁxture will freeze in place. A secondary radius will be built around this radius, which
extends past the bounds of the ﬁrst radius by half the size of the speciﬁed radius
setting.
If the Trackable moves outside of the original ﬁrst radius but still within the secondary
radius, the ﬁxture slowly readjusts to the new position, and the ﬁrst radius moves to
the new position.
If the Trackable moves outside of the secondary radius, the ﬁxture resumes tracking as
normal, responding to small movements again.
Diagram:
Enter Time: Click on the Enter Time scroll box to adjust the length of time that a Trackable
must be within the Radius for the setting to become engaged. The longer the time that the
Trackable is within the radius, the slower the ﬁxture responds to movements until eventually
all movement is ignored.
Z-Damping: The system will ignore small vertical movements on the Z axis. Select the Enable ZDamping Mode checkbox to display Damping Time.
If the Trackable stays within a constant range, over the speciﬁed time, Z movements slow
down until eventually Z movements are ignored within the distance traveled.
If the Trackable moves outside of the distance measured over the course of the speciﬁed
Dampening Time, a new distance range is set.
Note: Auto Spot Mode is determined per ﬁxture, per Chapter.
To enable
auto spot mode for a ﬁxture
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1. In the Chapter widget, select the chapter the ﬁxture is in.
2. In the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget.
4. Under the Auto Spot Mode Settings section, select the checkbox next to the desired Auto Spot
Mode(s).
5. For the changes to take eﬀect, click Apply Changes.
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Zones Tab
Zones tab is where you conﬁgure the interaction of ﬁxtures with any zones in the chapter.

Fixture Settings - Zones tab

Zone Settings
Zones in the project can be enabled to interact with ﬁxtures following Trackables. When a Trackable or
the beam of a ﬁxture following the Trackable enters a zone, the ﬁxture can be turned on or doused. How
ﬁxtures interact with zones is user deﬁnable.
Zones can have their interaction with Trackables and ﬁxtures customized in the following ways:
Douse Out: A ﬁxture will douse when the Trackable it is following interacts with a zone.
Inside Zone: The ﬁxture will be doused while the Trackable is inside the zone.
Outside Zone: The ﬁxture will be doused while the Trackable is outside the zone.
Collision Type: How the Trackable and ﬁxture relationship interacts with the zone.
Beam collision: When the beam of the ﬁxture following the Trackable is in the zone, the
relationship is considered in the zone.
Note: A reﬂection of the beam will not count. The size of the beam must be set for
Beam collision to work.
Point collision: When the Trackable is physically in the zone, the relationship is considered in
the zone.
To enable a zone for a ﬁxture
1. In the Chapter widget, select the chapter the ﬁxture is in.
2. On the Center pane, click on the Trackable the ﬁxture is assigned to and click on the Fixture Icon of
the ﬁxture to select it.
3. With the Fixture Icon selected, go to the Fixture Settings widget and click the Zones tab.
4. Under the Zone Settings section, select the Zone Enabled checkbox.
5. Select which zone you want the ﬁxture to interact with by selecting the zone from the Zones tab in
the Libraries widget, and dragging and dropping it in the Zone ﬁeld in the Fixture Settings tab.
6. Choose how you want the ﬁxture to douse when entering a zone, click on an option from the Douse
Out drop-down menu.
To have the ﬁxture fade-in rather then instantly turn on, enter the amount of time for the
fade-in in the Fade-in Time ﬁeld.
To have the ﬁxture fade-out rather then instantly turn oﬀ, enter the amount of time for the
fade-out in the Fade-out Time ﬁeld.
7. Choose how you want to interact with the zone, click on an option from the Collision Type dropdown menu.
8. For the changes to take eﬀect, click Apply Changes.
Note: See “BlackTrax Zones” for more information on creating zones for a BlackTrax project.
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Trackable Settings Widget
Trackable Settings Widget

Overview
The Trackable Settings widget displays information on the selected Trackable, and where you can assign
a Dynamic Zone to the given Trackable. Any BTBeacon or rigid frame assigned to the Trackable will
inherit the Trackable’s settings, and function as directed.

Trackable Settings Widget with a Dynamic Zone assigned

Dynamic Zone Properties
From the Zone Assignment drop-down menu, you can choose any of the zones present in their ﬁle to
become a Dynamic Zone for the selected Trackable. An icon will also be displayed beside the selected
Zone name, displaying the shape of the currently selected zone (Rectangular Zone, Cylindrical Zone, or
Spherical Zone).
Once a Zone is assigned as Dynamic, the Zone will no longer use the drawn (or Static) position for any
Chapter. This can be conﬁrmed in the Libraries Widget, under the Zones tab; the Dynamic checkbox will
appear. A Dynamic Zone will follow the attached Trackable, and any interactions that are programmed
for that Zone (ﬁxtures dousing in or out for example) will be triggered depending on the Trackable's
motion instead of the drawn WYSIWYG position.
By default, the Zone is centered around the centroid of the Trackable, but you can also oﬀset the position
of the Dynamic Zone on the X, Y and Z Axis relative to the centroid.
When Motion is Lost: The user can choose from 3 options for what the Dynamic Zone should do if the
Trackable loses motion:
Keep Position: When the Trackable loses motion, the Dynamic Zone will remain in the last known
position, and ﬁxtures will interact with it in that position until motion is regained.
Assume Inside: When the Trackable loses motion, the ﬁxtures assigned to the Trackable will
assume they are inside the Dynamic Zone, and react based oﬀ the current Chapter programming.
Assume Outside: When the Trackable loses motion, the ﬁxtures assigned to the Trackable will
assume they are outside of the Dynamic Zone, and react based oﬀ the current Chapter
programming.
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Programming Chapters
The Relationship section displays which Fixtures are assigned to which Trackables in the chapter. The
Libraries widget displays Trackable and ﬁxtures that are available.
To add a trackable to a chapter
1.
2.
3.
4.

In the Chapter widget, select a chapter you want to add a Trackable to.
In the Libraries widget, click the Trackables tab to view available Trackables.
On the Trackables tab, select the Trackable you want to add.
Click Add.
Result: A Trackable Container of the Trackable appears in the Relationship section for the
chapter.
Note: Trackables can also be added to a chapter by dragging and dropping a Trackable from
the Trackables tab into the top section of the center pane.
5. For the changes to take eﬀect, click Apply Changes.
To delete a trackable from a chapter
1.
2.
3.
4.

In the Chapter widget, select a chapter you want to delete a Trackable from.
In the Libraries widget, click the Trackables tab to view available Trackables.
On the Trackables tab, select the Trackable you want to delete.
Click Delete.
Result: The Trackable is removed from the Chapter.
Note: You can also drag and drop the Trackable back into the Library or click the delete
button in the Trackable section.
5. For the changes to take eﬀect, click Apply Changes.
To remove all trackables from a chapter
1.
2.
3.
4.

In the Chapter widget, select a chapter where all Trackables will be removed from.
In the center pane, select all Trackables in the Chapter.
In the center pane, click Delete.
For the changes to take eﬀect, click Apply Changes.

To assign a ﬁxture to a trackable
When a Fixture is assigned to a Trackable, the BTSystem will instruct the ﬁxture to follow the Trackable.
Fixtures will only follow an assigned Trackable in the chapter they are assigned, and only when that
chapter is active.
1.
2.
3.
4.
5.

In the Chapter widget, select a chapter that has a Trackable you want to assign a ﬁxture to.
In the center pane, select the Trackable bubble of the Trackable.
View available ﬁxtures by going to the Libraries widget and clicking the Fixtures tab.
On the Fixtures tab, select a ﬁxture you want to assign to the Trackable.
Click Assign.
Result: A Fixture Box of the ﬁxture appears in the bottom section of the center pane
indicating it is assigned to that Trackable.
Note: Fixtures can also be assigned a Trackable by dragging ﬁxtures from the Fixtures tab
and dropping them onto a Trackable Container.
6. For the changes to take eﬀect, click Apply Changes.
To unassign a ﬁxture from a trackable
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1.
2.
3.
4.

In the Chapter widget, select a chapter that has a Trackable you want to unassign a ﬁxture from.
In the Libraries widget, click the Fixtures tab.
On the Fixtures tab, select the ﬁxture you want to unassign from the Trackable.
Click Unassign.
Result: The Fixture is removed from the Trackable.
Note: Fixtures can also be removed from Trackables by dragging ﬁxtures from the Trackable
Box to the Libraries widget.
5. For the changes to take eﬀect, click Apply Changes.

To copy and paste a trackable from a chapter to another chapter
1.
2.
3.
4.
5.

In the Edit Chapters widget, select a Chapter with the Trackable you want to copy.
In the Chapter widget, click on the Trackable you want to copy.
Click the Copy button.
In the Edit Chapters widget, select another Chapter you want to paste the copied Trackable.
In the Chapter widget, click the Paste button.
Result: The Overwrite dialog box appears.
6. Click Overwrite to cut and paste the selected Trackable or click Keep to cancel the operation and
keep the previous Trackable.
Result: The icon of the copied Trackable appears in the Chapter widget when Overwrite is
selected.
7. For the changes to take eﬀect, click Apply Changes.
To copy and paste the ﬁxtures from a trackable to another trackable
1.
2.
3.
4.
5.

In the Chapter widget, click on the Trackable with the Fixture/s you want to copy.
In the bottom section of the Chapter widget, click on the Fixture/s you want to copy.
Click the Copy button.
In the same Chapter widget, click on another Trackable you want to paste the copied Fixture/s.
Click the Paste button.
Result: The Overwrite dialog box appears.
6. Click Overwrite to cut and paste the selected Fixture/s or click Keep to cancel the operation and
keep the previous Fixture/s.
7. For the changes to take eﬀect, click Apply Changes.
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Undo Stack
The Undo Stack widget is where you can undo and redo changes applied in Edit View of the BlackTrax,
such as chapter, editing, ﬁxture settings and Trackable renaming. The Undo Stack widget displays all the
editing operations that have been completed in Edit View. Each of the editing operation listed can be
selected to set the Edit View according to the previous state of the selected editing operation history,
however you may only undo a maximum of 10 steps during one undo operation.

Undo Stack widget

To go to a point in the editing operations that have been applied
1. From the View menu, choose Undo Stack.
2. In the Undo Stack widget, from the list on display, click on an editing history that you wish to go to.
Result: The Edit View goes to the applied state of BlackTrax in Edit View that is associated
with the selected history in the Undo Stack widget.
Tip: You can also use the keyboard shortcuts Ctrl+Z to undo, or Ctrl+Y to redo.
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Terminal Widget
Terminal Widget with Syntax for a "Fixture Train"

Overview
The Terminal widget is where you alter ﬁxture following behavior to achieve unique eﬀects.
Attention: Terminal commands aﬀect speciﬁed ﬁxtures across all Trackables in the chapter.
To enter a terminal command
1.
2.
3.
4.

In the Edit View, select the chapter you want to aﬀect.
Open the Terminal docking widget.
Click in the Terminal and enter the command.
All commands must end with a semicolon.

Fixture Train Command
Multiple ﬁxtures can follow a Trackable one after the other creating a train or snaking eﬀect. The parts of
the command are as follows:
ﬁxtures= - The ﬁxtures following the Trackable.
Note:
The ﬁxture is identiﬁed by the ﬁxture ID used in BlackTrax.
Fixtures will follow in the order stated. Fixtures can be expressed as a range (e.g.
ﬁxtures=1-10), or listed individually (e.g. ﬁxtures=1,7,20).
Fixtures must start and end with a square bracket [ and ] - see the example below
start= - The delay in seconds before the ﬁrst ﬁxture will start following the Trackable.
step= - The delay in seconds before a ﬁxture will start following the ﬁxture before it.
Example: If step=1s, Fixture 1 will follow the Trackable after 1s, Fixture 2 will follow Fixture
1 1s after that.
span= - The total time in s you want to delay all ﬁxtures by. The delay between each ﬁxture is
determined by the number of ﬁxtures divided by span time.
Example: If you have ten ﬁxtures and the span is 10s, the delay between each ﬁxture will be
1s.
Attention: You can only have a span= for the eﬀect, or start= and step=. You cannot use both at once.
The following is an example of a complete ﬁxture train command to demonstrate how it all comes
together.
Example: delay ﬁxtures=[1-10] start=1 step=1;
In this example ﬁxtures 1 through 10 will follow the Trackable. Fixture 1 will start following 1s after the
Trackable has started moving. Each subsequent ﬁxture will follow the one ahead of it 1s after it moves.
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Error Codes for Unsupported Fixtures
When you add new ﬁxtures in BTWYSIWYG, ﬁxture conﬁguration updates are applied to BlackTrax when
you Apply BTWYG Updates and Apply Changes.
The Messages dialog box will conﬁrm the project update with the new BTWYG data that has been added
to BlackTrax.
The Messages dialog box will conﬁrm that it has received unsupported ﬁxture conﬁguration displaying
the ﬁxture model proﬁle and the error codes. The descriptions of the error codes are listed below. If you
receive an unsupported ﬁxture error code, please report it to BlackTrax support, with the model, and any
error codes received.
To apply ﬁxture conﬁguration updates from BTWYSIWYG to BlackTrax
1. In BTWYSIWYG CAD mode, from the BLACKTRAX menu, choose BTX Apply.
Results:
1. The conﬁguration of the ﬁxture(s) that was added in BTWYSIWYG is applied to
BlackTrax.
2. In BlackTrax, the Incoming BTX Update icon in the Status Bar turns to blue.
2. In the Status Bar of BlackTrax, click on the Incoming BTX Update icon and Apply Changes.
Note: You can also apply this via the keyboard shortcut CTRL+W or from the File menu.
Result: The conﬁguration of the new ﬁxture(s) is applied to BlackTrax and the Messages
dialog box appears conﬁrming the update. If applicable, the Messages dialog box will display
the ﬁxture model and error codes for unsupported ﬁxtures.

Error Codes for Unsupported Fixtures:
NPS

No Pan Stepping

NTS

No Tilt Stepping

PTOI

Pan Tilt Oﬀset Incorrect

ZOI

Zoom Oﬀset Incorrect

NZS

No Zoom Stepping

IROI

Iris Oﬀset Incorrect

NIRS

No Iris Stepping

INOI

Intensity Oﬀset Incorrect

NINS

No Intensity Stepping

NRCS

No Red Channel Stepping

NGCS

No Green Channel Stepping

NBCS

No Blue Channel Stepping
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RGBOI

RGB Oﬀset Incorrect

CWOI

Color Wheel Oﬀset Incorrect

NCWOI

Non Color Wheel Oﬀset Incorrect

GWOI

Gobo Wheel Oﬀset Incorrect

AWOI

Animation Wheel Oﬀset Incorrect

PWOI

Prism Wheel Oﬀset Incorrect
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Fixture Calibration View
Fixture Calibration View
The Fixture Calibration View is where you calibrate the position of ﬁxtures to ensure ﬁxture tracking is
precise and accurate. In the Fixtures section:
BTBeacons are assigned to ﬁxtures.
Fixtures can be set into groups for convenient selection.
Calibration data collected are saved as presets which can be recalled in the Edit Chapters widget
and displayed in the Running Chapters widget.
A maximum of 24 presets are available for the calibration of ﬁxtures in multiple positions.
To have a ﬁxture follow an assigned Trackable, BlackTrax ﬁrst determines the position of the Trackable.
This is done using the BTSensors and the BTBeacon assigned to the Trackable. BlackTrax references
where a ﬁxture is based on information collected from the BTWYSIWYG .btx ﬁle. Based on the Trackable
and ﬁxture positions, the BTSystem calculates the pan and tilt angles a ﬁxture need to be at for it to be
aiming at a Trackable. This information is then sent to the ﬁxture where it changes its pan and tilt
settings accordingly to aim at the Trackable.
Note: If there are inconsistencies between the location of ﬁxtures in the Space, and the virtual Space in
BTWYSIWYG, tracking information BlackTrax creates for the ﬁxture will be inaccurate.
Fixture calibration allows you to correct these inconsistencies and ensures the location of ﬁxtures is
accurate. It is recommended that all ﬁxtures be calibrated when they are ﬁrst installed in the Space, and
individually anytime a ﬁxture is moved or bumped.
Attention:
1. Discard Changes and Apply Changes are disabled during Calibration Mode.
2. Settings made in the Fixture Calibration page will not be applied until BlackTrax is set to
Following and Calibration Mode.
Assigning beacons to ﬁxtures for calibration
1. From the View menu, choose Calibration Views and then choose Fixture View.
Result: BlackTrax GUI opens the calibration mode widgets.
2. From the Preset: drop-down list, select the preset number.
Note: The preset numbers displayed will not change.
Tip: You may click Rename to type a new name for the selected preset.
3. Highlight a ﬁxture (or ﬁxtures) in the center pane of the BTGUI.
4. Right-click Not Assigned under the Assigned Beacon heading. Alternately, select the Assign
Beacon Button beside Group.
5. Select a beacon.
6. Repeat steps 1-4 for all beacons you want to use for ﬁxture calibration.
7. Fixtures will cycle through following the assigned beacon(s) as points are collected.
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Fixture Calibration Control Widget
Fixture Calibration Controls Widget

To calibrate a ﬁxture, measurement points must be collected. Measurement points are samples of ﬁxture
and BTBeacon data collected by the BTSystem. Typically this involves a ﬁxture attempting to lock onto a
BTBeacon in the Space. Then with the ﬁxture’s beam frozen in place, moving the Stringer LED so that it is
in the center of the beam.
There are two ways to control how ﬁxtures move for ﬁxture calibration: Follow Beacon, and Pan/Tilt
Sliders.
Follow Beacon: Using this control method, a ﬁxture that has been assigned a beacon, and is currently
active, will attempt to follow a BTBeacon. If there are diﬀerences between the original project ﬁle and the
actual physical space, ﬁxture following will be inaccurate and be oﬀ center from the BTBeacon. This is
normal behavior for uncalibrated ﬁxtures, and will be corrected after successful ﬁxture calibration.
Pan/Tilt Sliders: Using this control method, the pan and tilt sliders in the Measurement section are used
to move selected ﬁxtures.

Selecting a Control Mode for Fixture Calibration
To select a control mode for ﬁxture calibration
1. In the Fixture Calibration Control widget, select the control method from the Control Mode dropdown menu.
Result: Fixtures will move according to the selected control method.
To move a ﬁxture using the pan/tilt sliders
1. In the Fixture Calibration view, in the central widget, select the ﬁxture you want to move.
2. Select the control method to Pan/Tilt Sliders.
3. The tilt of the ﬁxture can be moved by adjusting the Tilt slider, or entering the exact angle in the
Tilt ﬁeld.
4. The pan of the ﬁxture can be moved by adjusting the Pan slider, or entering the exact angle in the
Pan ﬁeld.
Tip:
You may click the Flip Pan button to reverse the pan/tilt movement without the collection of
measurement points.
Click on the Time scroll box to set a longer time to complete the Flip Pan movement during any of
these operations:
During Fixture Calibration when measurement points are being collected.
When Flip Pan button is clicked but measurement points are not being collected.
When the ﬁxture's pan/tilt reaches the end of its range and performs a Pan Flip movement.
Attention: During Fixture Calibration, when any of the 3 scenarios mentioned above occur, the ﬁxture
will perform a full 180 degree pan/tilt movement which could cause the hang structure to shake. Setting
a longer time to complete the Flip Pan will make the movement smoother and avoid any change in
position or alignment.
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Controlling Zoom and Iris
Zoom and Iris can be controlled from the Fixture Calibration Control widget using the Zoom and Iris
sliders similar to pan and tilt of the selected ﬁxture(s). If the checkboxes for Apply Globally are set, then
the control will apply to all currently active or queued ﬁxtures, otherwise, it will only apply to the
currently selected ﬁxture.
Note: A momentary loss of control of your ﬁxtures will happen occasionally while changing the
Zoom and Iris in Fixture Calibration mode. This normal behavior happens only when you use the
sliders to actively control the Zoom and Iris in Fixture Calibration mode.

Clearing Colour and Gobos, and
Controlling Intensity
BlackTrax will also attempt to auto clear any colour and gobos that the console is instructing the ﬁxture
to use. While in Fixture Calibration Mode, BlackTrax will also control the intensity of the ﬁxtures, turning
them on or oﬀ based on if they are queued or not.
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Fixture Calibration Properties Widget
The Fixture Calibration Properties widget displays the ﬁxture positions and attributes that aﬀect tracking.

Fixture Calibration Properties widget

The Fixture Calibration Properties widget displays:
Selected Fixture: Model Name and Spot ID number of the selected ﬁxture.
X: Horizontal measurement of the selected ﬁxture's position.
Y: Depth measurement of the selected ﬁxture's position.
Z: Vertical measurement of the selected ﬁxture's position.
RX: Rotation angle with reference to the X axis.
RY: Rotation angle with reference to the Y axis.
RZ: Rotation angle with reference to the Z axis.
Note: Slope and Oﬀset values are used in determining the intrinsic perimeters of the ﬁxture, to
accurately map and calculate the DMX->Angle conversion of a ﬁxture.
Pan Motor Slope: Deviation value of the ﬁxture's pan movement with reference to the oﬀset.
Pan Motor Oﬀset: Oﬀset value with reference to the ﬁxture's pan movement origin.
Tilt Motor Slope: Deviation value of the ﬁxture's tilt movement with reference to the oﬀset.
Tilt Motor Oﬀset: Oﬀset value with reference to the ﬁxture's tilt movement origin.
Pan Status: Sets the orientation of the pan movement. Click on the drop-down and select Normal
or Inverted. When a ﬁxture is calibrated, this setting will always revert back to what the ﬁxture is
set to in WYSIWYG.
Tilt Status: Sets the orientation of the tilt movement. Click on this drop-down and select Normal
or Inverted. When a ﬁxture is calibrated, this setting will always revert back to what the ﬁxture is
set to in WYSIWYG.
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Fixture Calibration Points Widget
The Fixture Calibration Points widget displays the measurement points collected that specify the location
and beam position of a selected ﬁxture when aimed at a Trackable.

Fixture Calibration Points widget

The Fixture Calibration Points widget displays:
Table (Columns):
Number column: Calibration point number.
Use: Checkbox to select or deselect the row of data points of the selected ﬁxture. By deselecting a
checkbox, that point will no longer be used as part of the calibration next time the solver is run
(manually or automatically).
X: Horizontal measurement of the LED's position at the time of point collection (Reference: Stage
Left)
Y: Depth measurement of the LED's position at the time of point collection. (Reference: Upstage)
Z: Vertical measurement of the LED's position at the time of point collection. (Reference: Towards
the ceiling).
Pan Angle: Collected pan angle of the selected ﬁxture's moving head or mirror.
Tilt Angle: Collected tilt angle of the selected ﬁxture's moving head or mirror.
Residual: Error tolerance value of the measurement points collected.
Buttons:
Delete All Points: Click this button to erase all points collected from all the ﬁxtures in this chapter.
Delete Point(s): Click this button to erase all selected points collected from the selected ﬁxture.
+Collect Data Point: Click this button to collect new measurement points from the selected
ﬁxture(s) using the current LED position as the position. Also the same as pressing B on the
Beacon. The beam must be frozen for a point to be collected (in Control Mode: Manual, a point may
be collected at any time).
Freeze Beam/Unfreeze Beam: Freezes the ﬁxture in place so that you may move the LED into the
center of the beam to collect a data point. The ﬁxture will no longer respond to the updated motion
until the beam is unfrozen or a point is collected. Also the same as pressing A on the Beacon. Not
available in Control Mode: Manual.
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Fixture Calibration
Table of Contents:
Single and Multi-Fixture Calibration
Multi-Person Calibration
To turn on ﬁxture calibration
1. On the status bar, click Normal Mode.
Result: The BTSystem toggles to Calibration Mode. The features of the Fixture Calibration
view are enabled.
To turn oﬀ ﬁxture calibration
1. On the status bar, click Fixture Calibration.
Result: The BTSystem exits Calibration Mode and enter Normal Mode. The features of the
Fixture Calibration page are disabled.
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Single and Multi-Fixture Calibration
To calibrate a ﬁxture, measurements points must be collected. Measurement points are samples of
ﬁxture and BTBeacon data collected by the BTSystem.
You can collect measurements points for a single ﬁxture or multiple ﬁxtures. Each ﬁxture requires its own
measurement points to calibrate correctly.
Attention: For accurate ﬁxture calibration to occur, ensure that BTSensors are correctly calibrated and
accurate ﬁrst.

Collecting Calibration Data for a Single Fixture
To collect measurement points for a single ﬁxture
1. In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from
the Preset: drop-down list. You may click Rename to type a new name for the selected preset.
Note: The preset numbers displayed will not change.
Result: The measurement points for the single ﬁxture will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.
2. In BlackTrax, in the Fixture Calibration view, in the Fixtures section, select the ﬁxture that needs to
be calibrated.
3. A BTBeacon will be used to calibrate the ﬁxture. Click Assign Beacon to view a drop-down list of all
available BTBeacons.
4. Select the desired BTBeacon from the drop-down list.
Result: The selected ﬁxture will follow the selected BTBeacon in the Space.
5. In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to
port 1 of the BTBeacon.
6. Move the BTBeacon to a point within the Space.
Result: The selected ﬁxture should be following the BTBeacon in the Space.
Attention: The LED of the Stringer must be visible to 2 or more BTSensors simultaneously
for tracking to occur.
7. At a point in the Space with the ﬁxture following the BTBeacon, in BlackTrax click Freeze Beam.
Tip: Pressing the A button on the BTBeacon being tracked activates Freeze Beam remotely.
Result: The ﬁxture will stop in place.
8. In the Physical Space, put the Stringer LED as close to the center of the ﬁxture beam as possible.
9. With the LED still in the center of the beam, in BlackTrax click Collect Data Point.
Tip: Pressing the B button on the BTBeacon being tracked activates Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and ﬁxture as a measurement point
when Collect Data Point is selected. It will add the data to the Fixture Calibration Points
section. The ﬁxture will unfreeze and continue following the BTBeacon. The ﬁxture will also
pan-ﬂip after collecting a point to ensure you are collecting points on both sides of the tilt
range.
10. At a diﬀerent location in the Space, repeat steps 5 to 8 until you create a total of 5 measurement
points.
Attention: The minimum number of measurement points needed for calibration is 5.
Note:
For best results the measurement points samples should be at diﬀerent points in the
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Space, creating diﬀerent pan and tilt angles. It is recommended to take measurement
points in diﬀerent areas of the Space and at diﬀerent heights, creating the most
variation.
Points should be collected until the ﬁxture is calibrated (typically 5-8 but sometimes
more). The ﬁxture will auto-calibrate after each point once 5 points have been
achieved. Auto-calibration feature can be turned oﬀ in settings.

Collecting Calibration Data for Multiple Fixtures
Multiple ﬁxtures can be calibrated at the same time to speed up the ﬁxture calibration process. It may be
easier to ﬁrst assign the desired ﬁxtures into a single ﬁxture group. The ﬁxtures are calibrated as normal
by capturing measurement points for each ﬁxture, but with the additional ability to cycle through the
ﬁxtures in the ﬁxture group.
To create a ﬁxture group
1. In the Fixtures section, select the ﬁxtures that need to be calibrated.
2. In the Group drop-down list, select New Group From Selected....
Result: The New Fixture Group window appears.
3. In the New Fixture Group window, enter a name for the ﬁxture group in the Group Name ﬁeld.
4. Click OK.
Result: The selected ﬁxtures are joined in a ﬁxture group.
To collect measurement points for multiple ﬁxtures
1. In BlackTrax, in the Fixture Calibration View, in the Fixtures section, select the Preset number from
the Preset: drop-down list. You may click Rename to type a new name for the selected preset.
Note: The preset numbers displayed will not change.
Result: The measurement points for the multiple ﬁxtures will be collected under this preset
number, which can be recalled in the Edit Chapters widget and displayed in the Running
Chapters widget.
2. In BlackTrax, in the Fixture Calibration view, in the Fixtures section, use CTRL to select all ﬁxtures
you want to calibrate.
3. A BTBeacon will need to be used to calibrate the ﬁxtures. Click Assign Beacon to view a drop-down
list of all available BTBeacons.
4. Select the desired BTBeacon from the drop-down list.
Result: The selected ﬁxture will follow the selected BTBeacon in the Space.
5. In the Physical Space, take the chosen BTBeacon. Make sure that a single Stringer is connected to
port 1 of the BTBeacon.
6. Move the BTBeacon to a point within the Space.
Result: The ﬁrst ﬁxture of the selected ﬁxture group should be following the BTBeacon in the
Space. All ﬁxtures will follow the BTBeacon in the Space. Only the active ﬁxture will turn on,
the rest are doused.
Attention: The LED of the Stringer must be visible to 2 or more BTSensors simultaneously
for tracking to occur.
7. At a point in the Space with the ﬁxture following the BTBeacon, in BlackTrax click Freeze Beam.
Tip: Pressing the A button on the BTBeacon being tracked will activate Freeze Beam
remotely.
Result: The ﬁxture will stop in place.
Attention: You will not be able to use Freeze Beam if the BTBeacon is not tracked within the
Space.
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8. In the Physical Space put the Stringer LED as close to the center of the ﬁxture beam as possible.
9. With the LED still in the center of the beam, in BlackTrax click Collect Data Point.
Tip: Pressing the B button on the BTBeacon being tracked activates Collect Data Point
remotely.
Result: BlackTrax will collect the data of the BTBeacon and ﬁxture as a measurement point
when Collect Data Point is clicked. It will add the data to the Fixture Calibration Points
section. The ﬁxture will douse, ﬂip, then the next ﬁxture in sequence will turn on.
10. Collect a measurement point for the currently selected ﬁxture.
11. Continue cycling through ﬁxtures and collecting measurement points at the current location until
every ﬁxture has one measurement point at that location.
12. At a diﬀerent location in the Space, repeat steps 5 to 10 until you create a total of 5 measurement
points for each ﬁxture.
Attention: The minimum number of measurement points needed for calibration is 5.
Note: For best results the measurement points samples should be at diﬀerent points in the
Space, creating diﬀerent pan and tilt angles. It is recommended to take measurement points
in diﬀerent areas of the Space and at diﬀerent heights, creating the most variation.
To calibrate a ﬁxture using collected measurement points
Once measurement points are created for a ﬁxture, they can be used to create calibration data for the
ﬁxture and determine the ﬁxtures calibrated position.
1. In the Fixtures section, select the ﬁxture that needs to be calibrated.
Note: In the Fixture Calibration Points section, have a minimum of 5 measurement points
created.
2. Click Calibrate Selection.
Result: Calibration data is created from the measurement points and displayed in the
Calibration Results section under the Calibration Status column. The Calibration Status is
automatically applied to ﬁxtures. In the Fixtures section, the Calibrated ﬁeld for the ﬁxture
will change to (green) to indicate that calibration data was created and that it is applied to
the ﬁxture. In the Fixture Calibration Points section, in the Calibration Error (Residual)
column, residual values are created for each measurement point.
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Multi-Person Calibration
Multi-Person Fixture Calibration is a feature of BlackTrax, which allows any number of people to
simultaneously calibrate a group of ﬁxtures.

Fixtures table

Assigning Beacons
When calibrating ﬁxtures, you can assign individual beacons either by group, or on an individual basis. In
the Fixture Table, you can right-click a ﬁxture's Assign Beacon column and select Assign Beacon, or
select multiple ﬁxtures and select the Assign Beacon button at the top of the table. In this window, you
can assign a beacon to your selection of ﬁxtures. Repeat this process as many times as you have
individual beacons you wish to use to calibrate all of your ﬁxtures.

Active Status
In the Fixture Table, each Fixture has one of the following options as an associated calibration status,
represented in the Active Status column.
Inactive: Fixtures display this status if not assigned a beacon, and not calibrating, or waiting to
calibrate.
Queued: Fixtures display this status if assigned a beacon for calibration, but currently not being
calibrated. These Fixtures follow the beacon without intensity.
Calibrating: Fixtures display this status if assigned a beacon for calibration, with intensity at full,
and currently being calibrated.
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Reﬁning Calibration Data
After calibrating a ﬁxture, Residuals for each measurement point will be calculated and displayed in the
Fixture Calibration Points widget.
Calibration errors are diﬀerences between the calculated pan/tilt values of a ﬁxture and the estimated
pan/tilt values of the ﬁxture, based on all measurement points used in the calibration. A calibration
residual range between 0-0.08 indicates that a given measurement point is accurate relative to the
overall ﬁxture calibration. A collection of high quality samples is necessary for accurate ﬁxture
calibration. In this case, the smaller the number, the better.
A measurement point with a large residual value indicates that it was collected poorly relative to the
other points. Poor quality measurement points should not be used in calibration; they should be removed
and the ﬁxture re-calibrated.

Fixture Calibration Points widget

To disregard measurement points for a ﬁxture
1. In the Fixtures widget, select the ﬁxture that has measurement points you want to stop using for
calibration.
2. In the Fixture Calibration Points widget, clear the Use checkbox for any measurement points you
will not use.
Result: The selected measurement points will not be used for the ﬁxture’s calibrated
position next time you hit calibrate selection.
Note: If after removing measurement points from a ﬁxture you have less than 5 remaining, you need to
collect more sample measurement points before you recalculate ﬁxture calibration.
To delete measurement points from a ﬁxture
1. In the Fixtures widget, select the ﬁxture you want to delete measurement points from.
2. In the Fixture Calibration Points widget, select any measurement points you want to delete.
3. Click Delete Point(s).
Result: The selected measurement points are deleted from the ﬁxture.
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Managing Calibration Data
Fixture calibration data can be saved as a calibration ﬁle separate from the BlackTrax project. Calibration
can be saved as a BlackTrax Calibration ﬁle (.btcal) which can be read by BlackTrax, or as an XML ﬁle for
third-party use. Calibration proﬁles saved as .btcal ﬁles can be loaded and edited as needed in a project.
Fixture calibration data from any preset can be exported or imported into any preset you are
currently in.
The calibration data that was imported becomes part of the preset you are currently in.
The calibration data that was imported remains part of any other presets where data has been
exported from or into already.
Attention: BlackTrax cannot use XML calibration ﬁles to further calibrate ﬁxtures. Fixture calibration
saved to this format is only for third party use.
To export calibration data
Created calibration data can be saved separately from the BlackTrax project as a BlackTrax calibration
ﬁle (.btcal).
1. In Fixture Calibration View, ensure that you are currently in the preset that you want to export
from.
2. From the File menu, choose Export and then choose Fixture Calibration.
Export Calibration Menu

3.

4.
5.
6.

Result: The Export Calibration browse window appears.
In the Export Calibration window, select which calibration ﬁle type will be used from the drop-down
menu.
Note: To export speciﬁc ﬁxtures from a preset, select the desired ﬁxtures before exporting
your calibration data.
Navigate to the location where you want to save the calibration ﬁle.
In the File Name ﬁeld, type the name of the calibration session.
Click Save.
Result: Information on all ﬁxtures (calibrated or not) are saved to the calibration ﬁle. The
information will be accurate so long as the calibrated ﬁxtures are not moved or bumped. This
is provided the Motive calibration is the same (relative to the origin).
Export Calibration Data

To import calibration data
1. In Fixture Calibration View, ensure that you are currently in the preset that you want to import to.
2. In the Fixtures widget, select the ﬁxtures which have calibration data you want to import.
3. From the File menu, choose Import and then choose Fixture Calibration.
Import Calibration Menu
Result: The Browse window appears.
4. In the Browse window, browse to the location where the calibration ﬁle (.btcal) is located.
5. Select the .btcal ﬁle.
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6. Click Open.
Result: The calibration ﬁle loads and a report is displayed showing which ﬁxtures have data
imported.
Note: If no ﬁxtures are selected, all ﬁxture data is imported.
Import Calibration Data

To uncalibrate a ﬁxture
1. In the Fixtures widget, select the ﬁxtures you want to remove all calibration data from.
2. Click the Clear Selected Data button.
Result: All calibration data and measurement points are deleted from the selected ﬁxtures.
To uncalibrate all ﬁxtures in the project
1. In the Fixtures widget, click Clear All Data.
Result: A dialog box appears asking if you really want to clear all calibration data from the
project.
2. Click Yes.
Result: All calibration data are removed from all ﬁxtures in the project.
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Frame Calibration View
Table of Contents:
Body Frames
Frame LEDs Widget
Rigid Frame Construction Widget
Creating Frames
Rigid Frames
Soft Frames

Frame Calibration View

Overview
The Frame Calibration View allows the user to construct Frames from existing beacons and their LEDs.
Frames can be either Rigid of Soft. Rigid Frames are objects that are solid, or objects that will not change
shape such as a table or box. Soft Frames are objects that can change shape, or ﬂexible objects that
move such as a person or inﬂatable object. Both Rigid and Soft Frames can be created from the Frame
Calibration view, however, each has diﬀerent requirements.

Rigid Frames
Rigid Frames require a minimum of 3 visible LEDs to be created and tracked. If less than 3 LEDs are
visible at any point, the Rigid Frame will stop being tracked. A Rigid Frame can be composed of several
beacons/LEDs. If a Rigid Frame is composed of more than 3 LEDs and one LED is hidden or removed, the
centroid will remain static relative to the visible LEDs. The centroid can be rotated and moved around
using oﬀsets. That information is saved in the project ﬁle.

Soft Frames
Soft Frames are similar to Rigid Frames and only require a single LED to be created and tracked. You can
also create Soft Frames with multiple LEDs. If a Soft Frame is composed of a single LED and the LED is
hidden or removed, then the Frame will no longer be tracked. If a Soft Frame has multiple LEDs and a
single LED becomes hidden or is removed, tracking will continue but shift to follow the centroid of the
remaining LEDs. You can not oﬀset the centroid of a Soft Frame, and no orientation data is calculated.
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Body Frames
Body Frames Widget

Overview
The Body Frames widget (or central widget) in the Frame Calibration View lists the Frames that have
been created. The widget presents a table view listing the Name, Frame ID, the type of Frame (Soft or
Rigid) and the Status of the Frame (LEDs not ready, Ready to Construct and Constructed). In the Body
Frames widget, you can create, clone and remove Rigid and Soft Frames as well as assign a numerical
name to a Frame, similar to a Beacon ID.

Usage
The Body Frames widget is a table of all Frames in the project. The Table is composed of four columns:
Name, Frame ID, Type, and Status; and at the bottom: the Frame ID box, Frame type drop-down, +/buttons, clone frame and reset buttons.
Name
The assigned name of the Frame, RF or SF (depending on the type of Frame), followed by the
ID assigned to the Frame when it was created
Frame ID
The ID assigned to the Frame when it was created
Type
The type of Frame (Rigid or Soft)
Status
Red: LEDs not ready.
Yellow: Ready to Construct.
Green: Constructed.
Note: Once the Frame has been constructed but the LEDs assigned to the Frame are not yet seen by the
system, the Frame's status will list out the LEDs that must be seen before it changes to the "Constructed"
status.
Frame ID:
At the bottom of the widget, a text entry ﬁeld exists to enter the Frame ID, which can be any
number so long as it is not already taken by an existing beacon or Frame in the system.
Type:
The Type drop-down list speciﬁes what type of Frame is being created (Rigid or Soft).
+ button:
The + button adds (create) a Frame to the list after the Frame ID and Type have been
speciﬁed.
Delete button:
The Delete button removes a Frame from the list.
Note: Click Yes or Cancel in the delete conﬁrmation dialog that appears.
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Clone the selected frame:
Click this button to copy and paste a selected frame, then type the new frame ID in the Clone
Frame dialog that will appear.
Reset All Frames:
Click this button to reset the frames listed in the table.
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Frame LEDs Widget
Frame LEDs widget

Overview
The Frame LEDs widget displays all the LEDs assigned to the currently selected Rigid or Soft Frame in the
Frame Calibration View . The widget lists the LEDs assigned in a table format. The columns listed are:
Beacon ID-LED ID, LED Index, Information on the LED placement order, and the Visibility status.

Usage
The Frame LEDs widget is used to assign Beacon LEDs to the currently selected frame in the Body
Frames widget. The widget lists all the LEDs currently assigned to the selected frame in a column format,
with the following columns:
Beacon ID-LED ID
Lists the Beacon ID and the LED ID (example 3-1 is Beacon 3, LED 1).
LED Index
The ID of the LED sorted in order of insertion (before re-ordering).
Info
Lists the information on the LED placement order: Origin, X-Axis, Cross-Product, Additional.
Please refer to Assigning LEDs to a Rigid Frame in Rigid Frames.
Visible
Shows the visibility status icon (Blue for visible, red for not visible, grey for inactive).
You can drag beacons from the global Beacons widget to add to the currently selected frame into this
widget to assign them to the frame.
There are also three buttons at the bottom of the widget:
Remove Selected LEDs
Removes the select LED from the frame.
Re-Order LED: Switch with Previous
Moves the currently selected LED and swaps it with the previous LED, if it is the ﬁrst in the
list, it will not move.
Re-Order LED: Switch with Next
Moves the currently selected LED and swaps it with the next LED in the list, if it is the last in
the list, it will not move.
You can replace each of the beacons in the Frame LEDs widget.
To replace a beacon
1. In the Frame LEDs widget, right-click on a selected beacon in the table.
Result: The Replace Beacon tooltip is displayed.
2. Click on the Replace Beacon tooltip.
Result: The Replace Beacon dialog box appears.
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3. From the drop-down list, select the Beacon ID which will replace the selected Beacon.
4. Click OK.
Result: The new Beacon ID number is displayed in the table with the corresponding LED ID.
Note: Re-construct the Rigid Frame in the Rigid Frame Construction widget, then click Apply Changes.
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Rigid Frame Construction Widget
Frame Construction Widget

Overview
The Rigid Frame Construction widget is where you conﬁgure and monitor the currently selected frame in
the Body Frames widget. In the Rigid Frame Construction widget, Centroid Oﬀset and the Orientation
Oﬀset can be set and applied separately. All the changes can be applied to the existing frames in the
project. Frames must ﬁrst be constructed in the Rigid Frame Construction widget before they are ready
for use.

Usage
The Rigid Frame Construction widget displays the currently selected frame, and has several buttons used
to perform various actions on the selected frame, or all frames in the project:
Construct Frame
Creates the solution for the currently selected Rigid Frame.
Set Home
Matches the orientation of the Rigid Frame to align with the world coordinate's orientation.
Reset Frame
Clears the solution for the selected Rigid Frame.
The Current Position and Current Orientation of the selected Rigid Frame list the current position of
the centroid of all LEDs and the current orientation of the selected Rigid Frame. Use the Centroid Oﬀset
and Orientation Oﬀset scroll boxes to change the calculated centroid and oﬀset of the constructed
Rigid Frame.
Soft Frames do not have the capability of oﬀsetting the centroid because the centroid of the frame is
calculated based on the current position of the LEDs in the frame at any given time, and the centroid
may change depending on how many LEDs are visible.
Centroid Oﬀset applies any oﬀsets to the Centroid of the currently selected Rigid Frame after the Rigid
Frame is constructed.
To set the centroid oﬀset values
1. On the X, Y, and Z, scroll boxes on the Centroid Oﬀset section, click on the Up or Down arrows to
adjust the measurement values.
Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 0.01m.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 0.10m.
Orientation Oﬀset applies any oﬀsets to the Orientation of the currently selected Rigid Frame after the
Rigid Frame is constructed.
To set the orientation oﬀset values
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1. On the Roll, Pitch and Yaw scroll boxes on the Orientation Oﬀset section, click on the Up or Down
arrows to adjust the values in the cells.
Tips:
Click on the cell then use the mouse wheel to scroll in increments of +/- 1 degree.
Click on the cell, press and hold CTRL and use the wheel to scroll in increments of +/- 10
degrees.
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Creating Frames
Table of Contents:
Rigid Frames
Soft Frames

Overview
Create Frames by creating and assigning a Frame ID in the Body Frames widget, and then assign LEDs to
a selected Frame. Once the LEDs are assigned, you may conﬁgure settings for Rigid Frames in the Rigid
Frame Construction widget. In the Rigid Frame Construction widget, you can also monitor the Centroid for
both Rigid and Soft frames, as well as the orientation for Rigid Frames. This section describes the process
of creating both Rigid and Soft frames.
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Rigid Frames
Overview
Rigid Frames are designed to be objects whose shape does not change, and as the name suggests
"rigid", such as a set piece like a table or box. Rigid Frames must have at least 3 LEDs assigned in order
for a solution to be created for the frame. There is no limit to the number of LEDs that can be assigned to
a rigid frame. If at any point less than 3 LEDs are visible for the speciﬁc rigid frame, tracking will stop.
This section outlines the creation of a rigid frame.

Creating a Rigid Frame
Create a rigid frame in the Body Frames widget. First, assign an ID to the frame.
To assign an ID to a frame.
1. Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body
Frames widget.
2. On the drop-down list, click Rigid Body.
3. Click the green + button.
Result: The Rigid Frame is created and added to the list in the widget.
Once the frame is created, you may double-click and type a new name on the default name cell, and
press ENTER. By default, a Rigid Frame is given a name of 'RF(ID)'.

Assigning LEDs to a Rigid Frame
Assign LEDs to a rigid frame by dragging individual beacons from the global Beacons widget to the Frame
LEDs widget with a rigid frame selected in the Body Frames widget.
You must place the LEDs in the correct order on the object as well as in the Frame LEDs widget because
the ﬁrst three LEDs assigned to a rigid frame deﬁnes the orientation of the frame.
The ﬁrst LED corresponds to the origin of the local coordinate system of the object.
The second LED corresponds to the positive x-axis.
The third LED is special because it can be placed anywhere, but it deﬁnes the location of the
positive y-axis in the following way:
Placing the third LED somewhere in the same plane as LED 1 and LED 2, and taking the
cross product of the vectors from the origin to LED 2, and the origin to LED 3 will deﬁne
the positive z-direction of the local coordinate system of the rigid body. Use the right-hand
rule to determine the cross-product.
To perform the right-hand rule:
1. Place the side of the right hand, and place it along the line from the origin (LED 1) to
the positive x-axis (LED 2).
2. Curl the ﬁngers of the right hand towards the line from the origin (LED 1) to LED 3.
3. The direction where the thumb points is the positive z-axis.
Once the ﬁrst three LEDs are placed, any further LEDs added to the rigid body can be placed anywhere
and will be used as additional tracking points for the object, but are not required.
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Constructing the Frame
Once the LEDs have been assigned, the frame can be initialized and the solution can be calculated. Click
Construct Frame in the Rigid Frame Construction widget to initialize and calculate the solution. If the
original solution of the rigid frame changes, BlackTrax will attempt to adjust the existing solution
accordingly. This will change the status of all current frames with LEDs assigned to them from "Done" to
a list of the LEDs that have not yet appeared (visible to the tracking system). Click the Apply
Changes button to send all ready frames to the global Beacons widget(s), and allow them to be assigned
to a trackable. Click the Reset All Frames button to remove the solution from all Frames, but not delete
them. You must click Apply Changes.

Set Home
In most situations, it is necessary to align the Rigid Frame's orientation to an acceptable 'home' position.
A home position is where the object will be 0,0,0 for the Roll, Pitch, and Yaw respectively. You can
manually perform this action, but it is much easier to let BlackTrax determine this for you.
To use the set home function
1. Align the real world object along the same plain as the world coordinate system (ensure your X, Y,
and Z directions match where you set the ground plane. An example is to set the front face of the
object facing -Y).
2. Select your desired Frame.
3. Click Set Home.
Result: Your object will now be orientated with Roll at 0, Pitch at 0, and Yaw at 0. The object will rotate
in the same way that the real world coordinate system would rotate.
Once the object is 'homed', it is easier to oﬀset the centroid and orientation of the Rigid Frame (although
you may do this before you home the object, if desired). Enter the required values into the X, Y, and Z
ﬁelds for the centroid (in meters), and Roll, Pitch, and Yaw ﬁelds for Orientation (in degrees). These
settings will be applied automatically, based oﬀ the time set under System Conﬁguration>Frame
Calibration>Updating oﬀsets interval (seconds). By default, this is set to update 0.5 seconds after the
values are updated.
Note: You do not need to click Apply Changes when doing centroid and orientation oﬀsets or setting the
home orientation.
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Soft Frames
Overview
Soft frames are designed to be objects whose shape can be ﬂexible, such as a person or inﬂatable object.
Soft frames need a single LED assigned in order for a solution to be created for the frame. There is no
limit to the number of LEDs that can be assigned to a soft frame. If at any point less than 1 LED is visible
for the speciﬁc frame, then tracking will stop. This section outlines the creation of a soft frame.

Creating a Soft Frame
Create a soft frame in the Body Frames widget. First, assign an ID to the frame.
To assign an ID to a frame
1. Enter a numerical ID for the frame in the Frame ID box (Beacon ID) at the bottom of the Body
Frames widget.
2. On the drop-down list, click Soft Body.
3. Click the green + button.
Result: The Soft Frame is created and added to the list in the Body Frames widget.
Once the frame is created, you may double-click and type a new name on the default name cell, and
click Enter. By default, a Soft Frame is given a name of 'SF(ID)'. You must click Apply Changes after a
name change.

Assigning LEDs to a Soft Frame
Assign LEDs to a soft frame by dragging individual beacons from the global Beacons widget to the Frame
LEDs widget with a soft frame selected in the Body Frames widget. The order of the LEDs for a soft frame
does not matter because all soft frames are tracked at the centroid of the frame.

Constructing the Frame
Once the LEDs have been assigned, the frame can be initialized and the solution can be calculated. Click
the Apply Changes button in the Rigid Frame Construction widget to initialize and calculate the solution.
This will change the status of all current frames with LEDs assigned to them from "Done" to a list of the
LEDs that have not yet appeared (visible to the tracking system). This will send all ready frames to the
global Beacons widget(s), and allow them to be assigned to a trackable. The Reset All Frames button will
not aﬀect soft frames. The centroid of a soft frame cannot be set as the centroid is constantly being recalculated based on the position of the LEDs that the frame is made up of.
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Beacon Patch
The Beacon Patch widget is where information on the BTBeacon, Mini Beacon, Rigid and Soft Frames are
displayed and the assignment of BTBeacons, Mini Beacons, Rigid and Soft Frames to Trackables is
controlled. To know the position of a Trackable in the BTSystem, a BTBeacon or Mini Beacon or Rigid
Frame or Soft Frame must ﬁrst be assigned to the Trackable. The assignment will link the location of the
BTBeacon/Mini Beacon/Rigid Frame/Soft Frame with the position of the Trackable.
The X, Y, Z position of a Trackable is based on the position of the assigned BTBeacon or Frame's centroid
in the Space. The orientation of a Trackable is based on the IMU within the BTBeacon or the calculated
orientation of a rigid frame. BlackTrax interprets the data based on the conﬁguration of the Trackable as
it was set in the Trackable Settings widget. BTBeacons broadcast data at all times when the BTBeacon is
on, even if it is not assigned.
The Mini Beacon has a single built-in LED, no radio and no internal inertial measurement unit (IMU). The
Mini beacon icon will display only the Mini Beacon number and the centroid positional coordinate.
Beacon Patch

Assigning BTBeacons To A Trackable
For the BTSystem to detect the location and orientation information of a Trackable, a BTBeacon or Mini
Beacon or Rigid Frame or Soft Frame must ﬁrst be assigned to a Trackable. The assignment will associate
the data of the BTBeacon with the Trackable.
To assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable
1. Drag and drop the Beacon Icon of the BTBeacon/Mini Beacon/Rigid Frame/Soft Frame from the
Available Beacons section to the Trackable Container of the Trackable in the Available
Trackables section.
2. Click Apply Changes.
Result: The BTBeacon or Mini Beacon or Rigid Frame or Soft Frame will be assigned to the
Trackable.
Note: Assigning a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame to a Trackable that
already has a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame assigned will cause the
BTBeacon or Mini Beacon or Rigid Frame or Soft Frame that was previously assigned to be
unassigned.
To un-assign a BTBeacon or Mini Beacon or Rigid Frame or Soft Frame from a Trackable
1. Drag and drop the Beacon Icon of the assigned BTBeacon/Mini Beacon/Rigid Frame/Soft Frame from
the Available Trackables section to the Available Beacons section.
2. For the changes to take eﬀect, click Apply Changes.

Diﬀerent types of Beacons
There are three diﬀerent types of beacons, which can be categorized by their heading colour:
Blue: Regular or 'Classic' Beacon - this is a physical BTBeacon connected to stringers
Burgundy: Mini Beacon - this is a physical Mini Beacon connected to stringers
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Orange: A rigid frame - a 'virtual' BTBeacon that is constructed using at least three LEDs from any
number of BTBeacons
Pink: A soft frame - a 'virtual' BTBeacon that is constructed using at least one LED from any
number of BTBeacons

Beacon Patch Filtering
The Available Beacons section can be set to show only the selected types of beacons. By default, the
section opens with all types of Beacons selected.
To select the Beacon type that will appear in this section
1. On the top right corner of the Available Beacons section, click on the Beacons drop-down menu.
2. Select the checkboxes of either the Classic Beacon, or the Rigid Frame, or the Soft Frame or Mini
Beacons that you want to show in the section.
Result: Only the selected Beacon types will appear in the Available Beacons section.

BTBeacon Data
When BTBeacons are in the Space, their location and orientation are known by the BTSystem. This
information is displayed in the Beacon Icon for easy reference. BTBeacon data can be separated into
three categories: General, Centroid and LED.
Note: If any BTBeacon information is unavailable, it will appear as “?”. This could be because the
BTBeacon LEDs are not visible by the BTSystem, or the LEDs are unplugged.
Beacon Number: This is the identifying number of BTBeacon. It is used to tell BTBeacons apart
and is assigned to the BTBeacon automatically.
Battery Icon: This icon represents the percentage of power remaining in the BTBeacon. The timer
next to the icon gives an estimate of how long the BTBeacon can operate using the current LED
conﬁguration.

Centroid BTBeacon Data
Centroid BTBeacon data is primarily information based on the average Cartesian coordinates position all
visible LEDs connecting to the BTBeacon. Additional information about the BTBeacon is also displayed.
X : This is the current X coordinate of the BTBeacon. This position is based on the average X
coordinate position of all visible LEDs connected to the BTBeacon.
Y : This is the current Y coordinate of the BTBeacon. This position is based on the average Y
coordinate position of all visible LEDs connected to the BTBeacon.
Z : This is the current Z coordinate of the BTBeacon. This position is based on the average Z
coordinate position of all visible LEDs connected to the BTBeacon.
R : This is the current roll (rotation of X axis) value of the BTBeacon. This is based on the IMU inside
the BTBeacon or the solution based on the rigid frame.
P : This is the current pitch (rotation of Y axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Y : This is the current yaw (rotation of Z axis) value of the BTBeacon. This is based on the IMU
inside the BTBeacon or the solution based on the rigid frame.
Button A : This indicates the current status of the A button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in ﬁxture calibration.
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Button B : This indicates the current status of the B button on the BTBeacon. The button can be
set to either ON or OFF. This button is used in ﬁxture calibration.

LED BTBeacon Data
LED BTBeacon data is information on the individual Cartesian coordinate position of every LED connected
to the BTBeacon.
LED 1 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 1.
LED 1 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 1.
LED 2 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 2.
LED 2 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 2.
LED 3 : The number next to the icon is the identifying numbered pulse of the LED in the
BTBeacon’s port 3.
LED 3 Data : This is the current Cartesian coordinates of the LED in the BTBeacon’s port 3.
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Beacons
The Beacons widget is where an overview of the Beacons in the BTSystem is displayed and where
Beacons in the BTSystem are controlled.
Beacons, Mini Beacons, Rigid Frames and Soft Frames seen by the BTSystem.
Battery percentage per Beacon (Mini Beacon does not show Battery Percentage).
Status if the Beacon, Mini Beacon, Rigid Frame or Soft Frame is visible or not.
LED indexes with the corresponding bit codes (binary values) for every Beacon.
You can lock or unlock the Beacon list from the Lock checkbox.
You can add and remove classic Beacons from the new add and remove buttons.

Beacons widget

Beacons Widget Filtering
In the Beacons widget, you can click on either the Beacons tab or the Mini tab or the Rigid tab or the Soft
tab to select the Beacon type that you want to show in this widget.
Detailed Beacon Patch: Click this button to open the Beacon Patch widget.
Beacons tab: Click on the Beacons tab to show Regular or Classic Beacons, which are the physical
BTBeacons connected to the stringer.
Mini tab: Click on the Mini tab to show Mini Beacons, which are the physical Mini Beacons with an
LED embedded on top of the device.
Rigid tab: Click on the Rigid tab to show only the Rigid Frame 'virtual' BTBeacons.
Soft tab: Click on the Soft tab to show only the Soft Frame 'virtual' BTBeacons.
Lock: Select this checkbox to lock the Beacons list and disable the Beacon ID box, adding and
deleting Beacons in the table.(Available only in the Beacons tab.)
Notes:
1. When the list is locked, Beacons will not update automatically from radio data.
2. By default, the list is locked when a new project is loaded and when Apply Changes is
pressed.
Beacon ID: Assign a unique name for the Beacon. (Available only in the Beacons and Mini tabs.)
Add button: Adds a Beacon to the list in the table. (Available only in the Beacons and Mini tabs.)
Notes:
1. All Beacons follow a preset rule. (Beacon 1 = LED 1, 2, 3; Beacon 2 = LED 4, 5, 6, etc.)
2. When adding Beacons, you can enter either a single Beacon ID or range. (e.g. 10-45)
Delete button: Deletes a Beacon to the list in the table. (Available only in the Beacons and Mini
tabs.)
Speciﬁc BTBeacons, Mini Beacons, Rigid Frames or Soft Frames can be assigned to Trackables for speciﬁc
chapters. These settings will override any assignment made on the Beacon Patch page.
To assign a BTBeacon, Mini Beacon, Rigid Frame or Soft Frame to a Trackable for a speciﬁc
chapter
1. In the Chapters tab, select the chapter the Trackable is in.
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2. Select a Trackable.
3. Go to the Beacons widget.
4. Drag and drop icons the desired BTBeacon, Mini Beacon, Rigid Frame or Soft Frame from the list
onto the currently assigned Beacon of the desired Trackable.
Result: The chosen BTBeacon, Mini Beacon, Rigid Frame or Soft Frame will be assigned to
the Trackable for the speciﬁc chapter. A book icon will appear next to the Assignment setting
in the Trackables section.
Note: To revert back to the globally assigned BTBeacon, click the Book icon.
5. For the changes to take eﬀect, click Apply Changes.
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Messages
The Messages widget is where the history of error warnings and status updates of the state of the system
are displayed.
By default, the Messages widget will auto hide from view after 5 seconds of display. You can toggle on or
oﬀ the auto hide in the Messages widget.
The Messages widget will appear whenever there is a change to the state of the system, or an error has
occurred. As an alternative, you can manually open the widget by selecting the speech bubble on the
Status Bar.
The Messages widget can be set to appear only when a warning or error message has been generated. In
this mode, the color of the Messages Icon on the Status Bar turns blue when information is added to the
Messages widget.

Messages widget

To disable auto hide
1. In the Messages widget, clear the Auto Hide checkbox.
2. Click OK.
Note: Clicking the OK button will hide the Messages widget manually.
To enable only appears for errors and warnings
1. In the Messages widget, select the Only Appears For Errors and Warnings checkbox.
2. Click OK.
To clear all information
1. In the Messages widget, click Clear.
Result: The Messages widget will be cleared of all the information listed.
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System Log
The System Log widget displays system information about the BlackTrax project. The various features of
the system log are:
Enable Logging: Select this checkbox to log all events in System Log widget.
Log Data: Select this checkbox to record all data transmitted. Used primarily for debugging
purposes.
To File: Select this checkbox to save the System Log to C:\bt_run_time.
Auto Scroll: Select this checkbox to automatically scroll to the latest event when it is created in the
System Log.
Note: If logging data To File is enabled, you may accumulate Gigabytes of data in a single day of use.
We recommend that the log ﬁle is removed periodically to conserve BTSystem memory.

To set the system log as a separate window
Double-click the System Log heading.
Result: The System Log window appears as a separate window.
To reattached the system log window to BlackTrax
In the System Log window, on the top right of the window, click Attach.
Result: The System Log window reattaches to the main widget.
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Project Properties
The Project Properties widget is where descriptive data and properties of the BlackTrax project are
created, displayed and managed. You can change the properties that were set in the Project Properties
widget.

Project Properties widget

The Project Properties widget displays the following:
Show Name: Type the name of the current project in this box.
Show Author: Type the name of the author of the current project in this box.
DMX Control: On the Source drop-down menu, select the source of the DMX input for the
Universe and the Chapter Control Channel. On the Source drop-down menu, select from either ArtNet or sACN.
Note: As Art-Net starts at 0 instead of 1, universe selection reﬂects that when changing
between sACN and Art-Net.
Chapter: Set the Chapter Control Channel number and the Universe for the assigned control
channel of the active Chapter.
Universe: Click on this scroll box to set the Universe for the assigned control channel of the
active Chapter.
Chapter Control Channel: Click on this scroll box to set the channel number for the control of
the active Chapter.
Note: Book Control Channel scroll box is displayed in this section when the project is in Multi
Book Mode.
Merging Channel: Select the Enable Monitoring checkbox to set the channel number that will
only monitor the Merging Channel that was set in the merge node.
Universe: Click on this scroll box to set the Universe for the assigned control channel of the
Merging Channel monitor.
Channel: Click on this scroll box to set the control channel for the Merging channel monitor.
Note: The Merging Channel is a single DMX channel that is patched into your lighting console
to enable the control of moving ﬁxtures from BlackTrax. This can be a dimmer channel that
controls intensity fading between BlackTrax and the lighting console, or a simple On/Oﬀ
control. This channel must be patched in your console and set as the trigger channel in your
merge node. See DMX/Ethernet Node for Tracking with Moving Lights.
Display Units: BlackTrax allows for either metric or imperial measurement to be used. This setting
can be changed in the Display Units section. The default unit settings of BlackTrax is metric.
Loading a project will revert BlackTrax to the default unit of measurement. Click on the Display
Units drop-down menu to select the measurement unit.
To open the project properties widget
From the Settings menu, choose Project Properties.
Result: The Project Properties widget appears.
To set the DMX control source
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In the Project Properties widget, in DMX Input section, select from the Source drop-down menu.
Result: The selected source will set the DMX input for the Chapter Control Channel of the BlackTrax
project.
To set the universe and chapter control channel
1. Open the Project Properties widget.
2. In the Chapter section, click on the Universe scroll box.
3. Click on Chapter Control Channel scroll box.
To enable the merging channel monitoring
1.
2.
3.
4.

Open the Project Properties widget.
In the Merging Channel section, select the Enable Monitoring checkbox to toggle.
Click on the Universe scroll box.
Click on the Channel scroll box.

To set the units of measurement
1. Open the Project Properties widget.
2. In the Display Units section, click on the drop-down menu to select Metric or Imperial.
3. Select the desired measurement type.
Result: The selected unit of measurement will apply to the BlackTrax project.
Attention: Inputs will always be in metric.
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System Conﬁguration
The System Conﬁguration widget is where BlackTrax software behavior can be conﬁgured.

System Conﬁguration Widget

The System Conﬁguration widget displays the following buttons to access the sections:
System: System prompts can be toggled On or Oﬀ. See Editing section page.
Fixture Calibration: Settings that aﬀect the collection of measurement points of the ﬁxtures can be
toggled On or Oﬀ. See Fixture Calibration Section page.
Frame Calibration: Click on the Updating oﬀsets interval (seconds) scroll box to set the time
interval for the Centroid and Orientation Oﬀset values to be applied to the selected Rigid Frame.
See Frame Calibration Section page.
BTWYG: Settings that enable incoming and outgoing links to BTWYSIWYG can be toggled On or Oﬀ.
See BTWYG Section page.
Noise Filter: Determines if the point is valid or not by using a probability algorithm to determine
how likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100
frames, but it then appears for one frame 10m away (typically caused by IR noise), then the ﬁlter
tosses that single frame away and continues to track the real LED. See Noise Filter section page.
Beacons: Settings that aﬀect the function and reporting of Beacons. See Beacons Section page.
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System Section
The System section in the System Conﬁguration widget is where system prompts can be toggled On or
Oﬀ.

System section

System: Toggle system prompts.
Enable conﬁrmation prompts for System Changes: Select this checkbox to display a dialog
box asking for conﬁrmation to apply the changes you have made in BlackTrax after
clicking Apply Changes in Normal Mode and Fixture Calibration Mode.
Open most recent Portfolio when BlackTrax starts: Select this checkbox to open BlackTrax
with the last Portfolio that was opened, or clear this checkbox to open the Portfolio Manager
when opening BlackTrax.
Note: The Open most recent Portfolio when BlackTrax starts feature is disabled when a
license check fails while opening the Main GUI of BlackTrax.
Auto Save Project every (minutes): Select this checkbox to enable, and set the duration of
Auto Saving of the .btprj associated with a Portfolio. Auto Save can happen anywhere from 5
minute to 30 minute intervals, and the timer is activated by editing changes in the BlackTrax
GUI.
Launch BTWYG ﬁle with Portfolio: Select this checkbox to open the BTWYG ﬁle associated
with the launched Portfolio at time of launch.
Auto Select for Fixture Groups: Select this checkbox to have ﬁxtures in a Fixture Group be
selected automatically in the Libraries Widget when selecting a group from the Group dropdown list.
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Fixture Calibration Section
The Fixture Calibration section of the System Conﬁguration widget is where the settings that aﬀect the
collection of measurement points of the ﬁxtures can be toggled On or Oﬀ.

Fixture Calibration section

Fixture Calibration:
Use calibrated ﬁxture position for beam Zone collisions: Select this checkbox to use the
calibrated beam zone settings of the ﬁxture that was calibrated in BlackTrax. Clear this
checkbox to use the beam zone settings applied to the ﬁxture as drawn in BTWYSIWYG.
Use calibrated ﬁxture position for zoom/iris control: Select this checkbox to use the calibrated
zoom and iris settings of the ﬁxture that was calibrated in BlackTrax. Clear this checkbox to
use the zoom and iris settings applied to the ﬁxture as drawn in BTWYSIWYG.
Check if motion from beacon is gone: Select this checkbox to disable the collection of
measurement points when the signal from a beacon is not seen and a warning is displayed.
Clear this checkbox to enable the collection of measurement points and the warning will not
be displayed.
Enable Automatic Calibration: Select this checkbox to enable the automatic collection of the
measurement points after the 5th measurement point and every point thereafter.
Clear Fixture Properties: Select the checkboxes for Clear Colour, Clear Gobo, and Clear
Prism to remove the colour, gobo, and prism attributes from the ﬁxtures selected in
BlackTrax.
The ﬁxture goes to white when Clear Colour is selected.
The gobo is removed from the ﬁxture when Clear Gobo is selected.
The prism is removed from the ﬁxture when Clear Prism is selected.
Uncheck All/Check All: Click on Uncheck All or Check All buttons to include or exclude the
colour, gobo, and prism from the selected ﬁxture in BlackTrax.
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Frame Calibration Section
The Frame Calibration section in the System Conﬁguration widget is where you can set the time interval
for the Centroid and Orientation Oﬀset values of the selected Rigid Frame.

Frame Calibration section

Frame Calibration: Click on the Updating oﬀsets interval (seconds): scroll box to set the time
interval for the Centroid and Orientation Oﬀset values to be applied to the selected Rigid Frame.

BlackTrax Wiki

246 of 298

5/14/2019

BTWYG Section
The BTWYG section in the System Conﬁguration widget is where the settings that enable the incoming
and outgoing links to BTWYSIWYG can be toggled On or Oﬀ.

BTWYG section

BTWYG: Toggle incoming and outgoing links to BTWYSIWYG.
Allow outgoing selection to WYSIWYG: Select this checkbox to enable the selection of ﬁxtures
in WYSIWYG from BlackTrax.
Allow incoming selection from WYSIWYG: Select this checkbox to enable the selection of
ﬁxtures and trackables in BlackTrax from WYSIWYG.
Send tracking information to WYSIWYG: Select this checkbox to send information from
BlackTrax to WYSIWYG.
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Cameras Section
The Cameras section in the System Conﬁguration widget is where noise ﬁlter settings are activated and
conﬁgured.

Cameras section

Noise Filter: Determines if the point is valid or not by using a probability algorithm to determine
how likely a point would be. For example, if Beacon 1, LED 2 is seen in the same spot for 100
frames, but it then appears for one frame 10m away (typically caused by IR noise), then the ﬁlter
tosses that single frame away and continues to track the real LED. As the system does not have a
concept of 'real' and 'fake', the system uses a history to determine the 'real' LED. This means that
in rare cases, noise may pass through the outlier ﬁlter if the noise is consistent, such as a
reﬂection. There are other tricks to mask out reﬂections and to trim out extra parts of the tracking
area. Please see Motive reconstruction bound settings for more information.
Enable: Select this checkbox to activate the noise ﬁlter.
Minimum Covariance: Click this scroll box to set how 'wide' or 'narrow' the range of noise
suppression. Minimum Covariance aﬀects a higher tolerance of points in a given spectrum.
Maximum Z-Sqr Score: Click this scroll box to set how 'wide' or 'narrow' the range of noise
suppression. Maximum Z-Sqr Score aﬀects a wider tolerance of points in a given spectrum.
Maximum Iterations: Click this scroll box to set the maximum number of repetitions per frame
the same data point is analyzed to determine the noise level. There is no range to this ﬁeld,
but the default is 150.
Tip: The easiest way to adjust the outlier ﬁlter is to increase or decrease the Min Covariance and
then click Apply Changes. There is a large range that you may use, so it is best to step the ﬁeld by
either +0.1 or -0.1 each time to see if the noise becomes better or worse.
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Beacons Section
The Beacons section in the System Conﬁguration widget is where settings that aﬀect Beacon reporting
and behavior within the system can be conﬁgured.

Beacons section

Beacons: Settings that aﬀect the display of Beacon battery life.
Radio becomes stale after (seconds): Click on this scroll box to set how long after a packet of
battery life data of the beacon is received (without receiving new packets) for the radio
indicator in Live View to turn red. The radio indicator is also visible in Table View via the
Radio column.
Live View:

Icon with Fresh data (Gray)

Icon with Stale data (Red)

Icon

with no orientation data
Table View:
Radio column with Fresh data (Green)
Radio column with Stale data (Red)
Number of battery packets to average: Click on this scroll box to set the number of times the
battery life information is collected to be averaged.
Display raw battery values in the Beacon Widget: Select this checkbox to display the raw battery
life percentage (non-averaged) as a separate column in the Beacons Widget.
Frame batteries updated every (minutes): Click on this scroll box to set (in minutes), how the
battery status of the beacons in rigid and soft body frames will update by displaying the lowest
beacon's battery when that timer runs out (and repeats).
Detect battery time based on: Select either 1 Stringer or 2 Stringers or 3 Stringers as the reference
for monitoring the battery life capacity.
Process Classic Beacon Orientation: By default, this checkbox is clear. This will prevent orientation
of Classic Beacons being reported once the Beacon has been patched to a Trackable. Therefore
Classic Beacon orientation will not aﬀect:
Dynamic Zones
Avatar Rotation in BTWYG Live View
RTTrPM Outputs
Smoothed Centroid Jumps: Select this checkbox to enable the option of setting the timing of the
centroid updating when shifting from one calculated centroid to a newly calculated centroid. For
example, when a Stringer contributing to a centroid becomes hidden from BTSensor view.
Smoothing time (milliseconds): Click on this scroll box to set the time (in milliseconds) it takes for
the calculated centroid updating to complete when a Stringer contributing to a centroid becomes
hidden, or is visible again in the BTSensor view. The shift will be smoother (but takes more time to
complete) when the timing is longer.
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Output Conﬁguration
The Output Conﬁguration widget displays the active tracking output data from the Output Modules and
Trackable Settings as a result of the tracking operation in BlackTrax.
The Output Conﬁguration widget is used by the BTSystem to create, customize and remove RealTime Tracking Protocol data for Third Party use (RTTrPL, RTTrPM, and Art-Net).
The Output Conﬁguration widget receives data based on preferences conﬁgured in Output
Conﬁguration. The customized data is then sent to designated Third Party programs.
Note: Output Conﬁguration data can be imported and exported for use of current tracking output and
saved for later use. You can activate Import or Export Outputs from the File menu.

Output Conﬁguration widget

The Output Conﬁguration widget displays the following sections:
Active Outputs: The list data and settings of created outputs for the current BlackTrax project.
See Active Outputs page.
Edit Output: The section for managing the network connections of the selected output. See Edit
Output page.
Sending Trackables: The list of every active Trackable detected by the BTSystem and their thirdparty output status (only applicable to RTTrPM outputs). See Sending Trackables page.
Output Options: The section enables you to select which RTTrPM modules to the output of the
selected active module (only applicable to RTTrPM and outputs). See Output Options page.
Note: As a general rule, click Apply Changes to apply all changes that you set in Output Conﬁguration.
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Active Outputs
The Active Outputs section displays the list of output connections that are detected by the BlackTrax
System. The connection settings and output statuses for every active module can be monitored via the
Active Output table.
Active Outputs section
Enable checkbox: Select the checkbox to enable the active output connection and determine if the
connection is sending data externally.
Note: When the number of active outputs exceed your system's license, the warning dialog
box appears prompting for you to click OK to disable a selected output or click Disable All and
turn oﬀ all other outputs. A selected output that is within the number of Licensed Outputs will
be enabled.
Label: The unique name of the active module that you speciﬁed for the BTSystem.
Type: The type of data protocol being sent to the selected module.
Output NIC: The IP address where the output is being sent through from the selected active
module.
Communication: The type of connection, such as multicast, unicast or broadcast.
Details: The target IP address where the output data will be sent to.
Status: Connection status of the detected module.
Enable All: Select this checkbox to enable all active output connections and display if all the
licensed outputs are sending output data externally from the server.
Note: The Enable All checkbox is not available if the number of output connections displayed
in the table exceed the number of Licensed Outputs authorized for the BlackTrax system.
Add: Click this button to add a new active output connection.
Delete: Click this button to delete an active output connection.
Note: Deleting an output marks it for deletion and it will be deleted when the user clicks
Apply Changes next. As a general rule, click Apply Changes to apply all changes that you set
in Output Conﬁguration.
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Edit Output
The Edit Output section is where you can set or change the network data of the output connection
module that is added to the Active Outputs section. You can conﬁgure RTTrPM outputs' parameters.

Network Tab
Network tab

Label: Type the unique name of the active connection module that is added to the Active Outputs
section.
Type: Click on this drop-down menu to select the type of data protocol being sent to the selected
active module.
NIC: Click on this drop-down menu to select the local IP address where the output data is being
sent through for the selected active module.
Notes:
When a project is opened in a server that is missing the saved NIC, BlackTrax will ask
what NIC you would like to use for each output.
When BlackTrax detects an IP change in Windows, the Messages dialog box will alert
you once to reboot BlackTrax to reload the settings.
Communication: Click on this drop-down menu to select the type of IP address in the connection,
such as multicast, unicast or broadcast. The default output address corresponding to multicast and
broadcast will be entered automatically according to the selected type.
Notes:
The default multicast output address for the selected output is entered automatically if
Multicast is selected.
The broadcast output address will be based oﬀ the selected NIC for the output and
entered automatically if Broadcast is selected.
The user must enter the unicast address if Unicast is selected.
Address and Port ﬁelds are editable per output, where applicable if user settings are
speciﬁed instead of the defaults.
Address: The target IP address where the output data will be sent to.
Port: The port number where the IP address for the output data is connected to.
Apply: Click to apply the settings.
Note: As a general rule, click Apply Changes to apply all changes that you set in Output Conﬁguration.

Advanced Tab
Advanced tab

Coordinate System: Choose which type of coordinate system to use with positional data. Click on
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this drop-down menu to choose between the Stage (WYSIWYG) or Screen coordinate systems.
Stage (WYSIWYG): In the Stage coordinate system, the Z axis refers to the upward direction,
and Y is on the same plane as the X axis. (Used in WYSIWYG)
Screen: In the Screen coordinate system, the Z (and -Z) axis is on the same plane as the X
axis, and the Y axis refers to the upward direction.
Integer: Choose how integer data is sent. Click on this drop-down menu to change the network
order of integer ﬁelds output in RTTrPM packets from Big Endian (Network Order) to Little Endian
(Intel Order).
Float Point: Choose how the ﬂoat variable value is deﬁned. Click this drop-down menu and select
Big Endian (Network Order) or Little Endian (Intel Order).
Orientation: Click on this drop-down menu to change the Beacon orientation to Euler or Quaternion
coordinates.
Decimal Precision: Click this scroll box and set the decimal point precision for the X, Y, Z values
coming out of the RTTrPM.
Apply: Click to apply the settings.
Note: As a general rule, click Apply Changes to apply all changes that you set in Output Conﬁguration.
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Sending Trackables
The Sending Trackables section is where Trackables are displayed and selected. The Trackable
Settings in the Output Options section are then applied to the selected Trackable.
Beacon IDs and Trackables are sent over RTTrPM.
When you patch a Beacon or Mini Beacon or Rigid Body Frame or Soft Body Frame to a Trackable, a
BlackTrax output sends the name of the Trackable (for example Luke instead of 1).
The position and orientation of the Trackable is generated from the Beacon or Frame that is
patched to it.
When you repatch a Trackable to a diﬀerent Beacon or Frame, the position of the new Beacon
or Frame is sent to the Trackable and out to the third party.
Beacons and Frames that are not patched to a Trackable will send as Beacon IDs. You can repatch
Trackables to diﬀerent Beacons and Frames in the BlackTrax software and all connected third
parties will receive the update automatically. You do not need to manually repatch Beacons in
every third party.
Sending Trackables section
In the Sending Trackables section:
Send Trackables checkbox: Select the checkbox to enable the Trackables tab.
Result: The Trackables tab is displayed.
Note: By default, the Trackables tab is oﬀ. Not all third parties are compatible with this
feature; consult with BlackTrax Technical Support or the third party support to conﬁrm
compatibility.
Trackables tab: Click the tab to display the list of Trackables and their output status: Enabled,
Trackable, Patched Beacon and Smoothing.
Enabled: Displays a check mark when enabled.
Trackable: Displays the name of the Trackable.
Patched Beacon: Displays the ID or name of the Beacon or Frame assigned.
Smoothing: Displays the Smoothing value that was set in the Trackable Settings tab.
Beacons/Mini/Rigid/Soft tab: Click the tab to display the table with the list of Trackables.
Enabled: Displays a check mark when enabled.
Beacon: Displays the Beacon ID or name.
Smoothing: Displays the Smoothing value that was set in the Trackable Settings tab.
To enable sending trackable data to third parties
1. On the Sending Trackables section, select the Send Trackables checkbox.
Result: The Trackables tab appears.
2. Click the Trackables tab or Beacons tab or Mini tab or Rigid tab or Soft tab.
Result: The list of detected Trackables/Beacons/Mini Beacons/Rigid Frames/Soft Frames are
displayed in their tabs.
3. On each of the tab list, select or highlight the Trackable or Beacon or Mini Beacon or Rigid Frame or
Soft Frame.
4. Click Enable Selected.
Result: The Enabled column displays a check mark.
Tip: You can select/highlight several Trackables or Beacons or Rigid/Soft Frames at once and
then click Enable Selected to send to third parties, or click Disable Selected to stop sending.
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(By default, no Beacons are sending to third parties.)
Notes:
If a Beacon or Frame is patched to a Trackable, the Beacon or Frame will not be available for
selection to enable in their respective tab.
Rigid and Soft bodies display their name instead of Beacon ID.
Click Apply Changes to apply all changes that you set in Output Conﬁguration.
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Output Options
The Output Options section is where Trackable data that is being sent can be altered.
Attention: The settings aﬀect Output Modules that are sending data from BlackTrax, and applies to
RTTrPM outputs.
Trackable Settings tab: Set tracking smoothing response for a single or multiple trackables. The
Smoothing option is enabled when Acceleration and Velocity in the Output Modules is selected.
Trackable Settings tab
Smoothing: Set how ﬂuid the XYZ values of the Trackable become.
Use the slider and the scroll box to adjust the range of ﬂuidity from Smooth to Responsive, to
set the range between -4 to +2. Both slider and the scroll box correspond to the same
perimeter.
A more smoothed Trackable will result in less jitter going to the third party, and can help
smooth out less than ideal calibrated volumes, but it will introduce a slight delay as well.
To set the smoothing response of a selected trackable
1. On the Output Modules tab, select the Acceleration and Velocity checkbox and clear the Output
Raw Position checkbox.
Result: Smoothing is enabled on the Trackable Settings tab.
2. On the Sending Trackables section, select a single or multiple Trackable(s).
3. On the Trackable Settings tab, use the Smooth to Responsive slider or click the scroll box to set the
range of ﬂuidity between -4 to +2.
Result: The smoothing range that was set is displayed in the Smoothing column of the
Sending Trackables section.
Output Modules tab: Select which data to send through the selected output module.

Output Modules tab

Send: Select the checkboxes to choose the output connection data that will be sent through.
LED: Select this checkbox to send BTBeacon LED data.
Centroid: Select this checkbox to send BTBeacon Centroid data.
Orientation: Select this checkbox to send BTBeacon orientation data.
Timestamps: When enabled, the Frame ID generated by the TimeKeeper is used as a time
stamp.
Acceleration and Velocity: Select this checkbox to send centroid and/or LED position
acceleration and velocity data.
Note: The Smoothing option on the Trackable Settings tab is enabled when
Acceleration and Velocity checkbox is selected.
Output Raw Position: Select this checkbox to turn oﬀ the ﬁlter that is used for the
acceleration and velocity data that was sent.
Notes:
Acceleration and velocity data is not 100% accurate due to inaccuracies that can
occur, such as BTSensor jitter, poor BTSensor calibration, reﬂections and IR
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interference. This creates imperfect data or noise. Filtering the data is a way to
correct any noise that enters the data.
Enabling Output Raw Position, or disabling Acceleration and Velocity will deactivate the smoothing slider from the Trackable Settings tab.
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Output Conﬁguration Settings for Third
Parties
Known Output Conﬁguration settings for third parties:

Media Servers:
Avolites Ai
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Big Endian (Network Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Checked

disguise
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamp: Checked
Acceleration and Velocity: Checked

Green Hippo
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
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Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Checked

Modulo Kinetic
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Big Endian (Network Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Checked

Touch Designer
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

Watchout
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Unchecked
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Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

Widget Designer
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

Camera Control:
CamBot Designer
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked

MRMC Flair
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
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LED: Checked
Centroid: Unchecked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked

Rushworks CTRL+R
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Unchecked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked
Please Note: Rushworks CTRL+R will only work with the default RTTrPM Multicast network settings.

Lighting Visualization:
Capture
Edit Output > Advanced tab
Coordinate System: Screen
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamp: Unchecked
Acceleration and Velocity: Checked

WYSIWYG
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Big Endian (Network Order)
Float Point: Little Endian (Intel Order)
Orientation: Quanternion
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Output Options > Output Modules tab
LED: Unchecked
Centroid: Checked
Orientation: Checked
Timestamp: Checked
Acceleration and Velocity: Unchecked

Motion Control:
Raynok Motion Control Software & System
Edit Output > Advanced tab
Coordinate System: Stage (WYSIWYG)
Integer: Little Endian (Intel Order)
Float Point: Little Endian (Intel Order)
Orientation: Euler
Output Options > Output Modules tab
LED: Checked
Centroid: Checked
Orientation: Checked
Timestamp: Unchecked
Acceleration and Velocity: Unchecked
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System Status Widget
System Status Widget

System Status displays the connection status, and data information for Tracker, Follower and Tracking
Adapter outputs. You can click Alt+S on the keyboard to launch the System Status widget. System Status
checks for any RTTrPM outputs when the widget opens, and if so, a pop-up dialog appears before opening
and displays the text Analyzing System...Please Wait.... You may click on the Cancel button to abort the
operation, otherwise the pop-up dialog appears for one minute. If you decide to skip the system being
analysed, the widget will still be displayed, however any output latency will display as "No Information" in
Red.
System Status pop-up dialog box
Each connection has the following information.
Connection:
Tracker
Motive
Internal input from Motive for motion data
Router
Input from physical Router for battery and button pushes from Beacons
Tracking Adapter Output
Internal output to Tracking Adapter(s)

Follower
Motion
Internal input from Tracker for motion data
DMX in
Input from a lighting console for sACN/Art-Net
BTWYG
Internal output to BTWYG for lighting visualization
RTTrPL
Output to a DMX Merge node for sending to a physical lighting system

Tracking Adapter
Traker Input
Internal input from Tracker for motion data
RTTrPM
Output to a third party using the RTTrPM protocol
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Status: Connected/Disconnected at time of System Status being launched.
Packets: Number of Packets sent at time of the System Status being launched.
Data Sending: Yes/No depending on if packets are increasing.
Note: (Follower only. Displays DMX in Source.)
The System Status widget will also analyze and display the output latency in milliseconds of any Tracking
Adapter outputs running at the time of launching the widget. To accurately determine system latency,
the system needs to be measured over a full minute. Latency does not account for any latency within
Motive, from Stringer to BTSensor, or the network to the Third Party.
Latency will increase slightly with more active Beacons, so when using this tool, ensure all Beacons you
wish to measure are actively tracking before starting the test.
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Keyboard shortcuts
Standardized BlackTrax keyboard shortcuts are deﬁned below:
Description

Keyboard shortcuts

New Project

Ctrl+N

Open Project

Ctrl+O

Save

Ctrl+S

Apply Changes

Ctrl+Enter

Apply BTWYG Updates

Ctrl+W

Copy

Ctrl+C

Paste

Ctrl+V

Select All

Ctrl+A

Undo

Ctrl+Z

Undo Stack

Ctrl+Shift+Z

Redo

Ctrl+Y

Live View

Ctrl+1

Edit View

Ctrl+2

Fixture Calibration View

Ctrl+3

Frame Calibration View

Ctrl+4

Close All Widgets

Ctrl+'

Beacon Patch

Ctrl+B

Beacons

Ctrl+Shift+B

Output Conﬁguration

Ctrl+T

Messages

Ctrl+M

Fullscreen Toggle

F11

About BlackTrax

F1

Close

Alt+F4

Record Tracking and Lighting Data

Ctrl+R

Launch System Status Widget

Alt+S
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Record Tracking and Lighting Data
This feature enables BlackTrax to automatically record tracking and lighting data in the form of packets
while receiving incoming tracking data from Motive. This data will save in the C:\bt_run_time folder as a
.rec ﬁle. The recording can be played back in the Cue application.
To start/stop record tracking and lighting data
1. On your keyboard, click the shortcut Ctrl+R once to start recording.
Result: Tracking and Lighting Data starts recording automatically and the status bar displays
the record icon.
Record icon
2. Click the shortcut Ctrl+R again to stop the recording.
Note: Three ﬁles are saved in C:\bt_run_time.
1. Motion data: Tracker-N
2. Radio data: Tracker-R
3. RTTrPL packets: Follower-L
Sample ﬁles saved in C:\bt_run_time
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Simulator & Cue Modules
Table of contents:
1 Simulator Module :
1.1 Layout of the Simulator Module :
2 Cue Module :
2.1 Layout of the Cue Module :
2.2 Record and Playback Tracking Data in the Cue Module :
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Simulator Module
The Simulator Module is where the identiﬁcation and positional data of BTBeacons can be created,
conﬁgured and managed in simulation. The Simulator can send and receive simulated data to and from
the other modules. The sections in the Simulator layout are:
Beacon Conﬁguration
Beacon Position
Network Conﬁguration
Message Log

Simulator Module
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Layout of the Simulator Module
Beacon Conﬁguration:
In the Beacon Conﬁguration section, Beacons are created, identiﬁed, conﬁgured, and removed.
Create: Click this button to create a single Beacon using the Beacon and LED 0, LED 1, and LED 2
ﬁelds and add to the list in the table.
LED Bit Code: Select the LED Bit Type from the drop-down list.
Attention: Beacon LEDs are identiﬁed by ﬂashing a speciﬁc bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system. A real system is based on 12-bits.
Delete: Click this button to remove the selected Beacon(s) from the list in the table.
Beacon: In the box, type the number assigned for the Beacon that you will create and assign the
corresponding index numbers.
LED 0, LED 1, LED 2: In the boxes, type the LED indexes for each LED ID corresponding to the
Beacon number that you have set in the Beacon box.
Update: Click this button to apply the LED Indexes to the Beacon, which will be displayed in the
table.
Table: Displays the list of Beacon(s) created and LED Indexes, Bit Codes and position for each
corresponding LED.
LED 1, LED 2, LED 3: Select the checkbox to enable position data for that LED, and then type the
measurement (in meters) for the oﬀseted X, Y and Z positions.
Apply: Click this button to apply the LED positions for the selected LEDs.
Note: LED positions are relative to the centroid position.
Batch Beacon Creation: Creates Beacons in a batch.
Count: In the box, type the number of Beacons you want to create in a batch.
Create: Click this button to create the batch of Beacons and add to the list in the table. When
created this way, Beacons follow the standard Preset Beacon numbering for ID and LED
indexes.

Beacon Position
In this section, the virtual positional oﬀset coordinates of the centroid are displayed, and can be reconﬁgured.
Path Type: Click this drop-down list to select Manual or Circle.
Manual: Use the slider to set the measurements (meters) for X, Y, Z positions and RX, RY and
RZ (rotation). You can also type the measurement values in the boxes beside the sliders.
Update: Click this button to apply the entered centroid position to the selected
Beacon(s).
Range: In the boxes, type the measurement values (meters) in this section to set the
maximum and minimum ranges of the movements.
Update: Click this button to apply the range values to all Beacons.
Circle: Automatically rotates the Beacon with reference to the set position and rotation of the
centroid. You can also type the measurement values in the boxes beside to specify the
rotation location and angle. R=Radius of the circle's movement, and A=Angle of the circle
around the world coordinate system.
Update: Click this button to apply the position and rotation values to the selected
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Beacon(s).
Start/Stop: Toggle this button to start or stop the movement.
Pulse: Click this button to trigger a single pulse of movement.

Network Conﬁguration
In this section, the network address and port information linked to the internal IP addresses of the
BTServer are displayed.
Motive Sender: Displays the network address and port information used for sending position data to
the other modules. Unmark the checkbox to disable the connection and stop sending position data.
Router Listener: Displays the network address and port information used for receiving data packets
(such as commands) from the Beacons. Unmark the checkbox to disable the connection and stop
receiving data.
Note: This feature is not currently used.
Router Sender: Displays the network address and port information used for simulating sent data
packets from the Beacons (such as battery status). Clear the checkbox to disable the connection
and stop sending data.

Message Log
In this section, information on data that passes through the Simulator and system events are displayed.
This information can also be saved to a separate ﬁle for review later. Message Log ﬁles can be found at
C:\bt_run_time.
Display Log Data: Select this checkbox to display detailed packet information in the Message Log.
Write to File: Select this checkbox to save the log as a text ﬁle in the C:\bt_run_time folder.
Clear Log: Click this button to clear all messages in the log.
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Cue Module
Cue Module is where real-time or simulated tracking data in BlackTrax can be recorded as Time Stamp
Frames that will be saved as Chapters and played back in sequence. The sections in the Cue layout are:
Motive Input
Record
Recording Mode/Show Mode
Chapter Content
Chapter List Table
Log
Chapter Command

Cue in Recording Mode

Cue in Show Mode
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Layout of the Cue Module
Motive Input
In the Motive Input section, network settings are displayed showing the port and the input/output
connections to Motive.

Record
In the Record section, you can specify the Time Stamp Frame ID sequence to record by setting the start
and end Frames.
Frame ID: Specify the Frame time stamp data you want to record.
Start: In this box, type the Frame number where you will start the recording.
End: In this box, type the Frame number where you will end the recording.
Current Frame: Displays the actual Frames that are currently running.
Recorded: Displays the actual number of Frames that were recorded.
Start/Stop: Click this button, to start or stop the recording.
Note: You will not be able to Start before your Start Frame. The recording will also
automatically stop when you reach the end Frame.
Save To File: Click this button to save the recorded Frames as a .rec ﬁle to any location that you
choose.
Note: The Save To File button appears when a recording is completed. Once pressed a
browse window appears.

Chapter Content
In the Chapter Content section, you can select the recorded ﬁle that will be used in the Chapter that
you want to create.
File: Type the ﬁle name and path or click the browse button to locate and select the recorded
Frame.
Name: Type a name for the Chapter that you want to create.
Chapter ID: Type the number for the Chapter that you want to create (this corresponds to the
Chapter ID in the Main GUI).
Note: When the Main GUI enters Chapter 1, it sends a command to Cue to start playing
Chapter 1 as well (if in Show Mode). If the Main GUI enters a Chapter that does not exist in
Cue, then Cue will stop playing the current recording.
Loop: Select this checkbox to set the recorded ﬁle to play in a loop.
Delay (ms): Type the playback delay (in milliseconds) for the Chapter to wait after being triggered
to start playing data.

Recording Mode/Show Mode
In this section, you can toggle between Recording Mode or Show Mode.
Recording Mode: Saved ﬁles are created as Chapters and added to the table for editing and
playback.
Note: Click the Recording Mode button to toggle into Show Mode, which will display the list
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of Chapters in the table, and editing and playback from the Cue Module are disabled. Click
Enable Auto-Scroll to enable automatic scrolling through the Chapter list.
Load List: Click this button to load the list of saved Chapter(s) that were created and stored as a
BlackTrax Cue File (.bcf) ﬁle.
Save List: Click this button to save the list of Chapter(s) that were created in this module and
added to the list in the table. This saves a .bcf ﬁle.
Note: A .bcf ﬁle only contains references to the Chapter's .rec ﬁles. It does not contain the
.rec themselves. Ensure .rec ﬁles are still at the same path when loading .bcf ﬁles back into
Cue.
Play: Click this button to playback a selected Chapter from the table. Click the Stop button that
appears to stop the playback.
Delete Chapter: Click this button to remove the selected Chapter(s) from the table.
Create Chapter: Click this button to create a Chapter that consists of the ﬁle that has been
accessed and displayed in the Chapter Content section.

Table of Chapters
The table section displays the list of Chapters that have been created, showing in columns the Chapter
number, Name, File, Loop, Delay, Information, and Status.

Log
In the Log section, information on data that passes through the Cue module and system events are
displayed. This information can also be saved to a separate ﬁle for review later. Log ﬁles can be found at
C:\bt_run_time.
Enable Logging: Select this checkbox to display playback information.
To File: Select this checkbox to enable saving the log of data information into a ﬁle in the
bt_run_time folder.
Clear: Click this button to clear all the displayed log data.

Chapter Command
Received: Displays the number of Chapter changes received from the Main GUI.
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Record and Playback Tracking Data in
the Cue Module
The Cue Module is where you can record simulated tracking data and real-time tracking data in live mode
from Motive.
In the Cue Module, the tracking data are recorded as Chapters that are stacked as a series of cues which
can be recalled from the Main GUI in BlackTrax. The Cue Module follows the Chapter in the Main GUI in
BlackTrax.
To record cues from tracking data recorded in Motive
Note: By default,the Enable In and Enable Out checkboxes in the Motive Input section of Cue Module
are enabled and the network settings are displayed showing the port and the input/output connections to
Motive.
1. In Motive, go to the Recording view mode which will display the Timeline of the recorded ﬁle in the
Timeline section.
2. Open a recorded tracking data ﬁle (.tak) from Motive.
3. In Motive, identify the frame ID number where you want to start the cue that you will record.
4. In the Record section of the Cue Module, type the start frame ID number in the Start box of the
Frame ID section.
5. In Motive, identify the frame ID number where you want to end the cue that you will record.
6. In the Record section of the Cue Module, type the end frame ID number in the End box of the
Frame ID section.
7. In the Record section of the Cue Module, click Start.
8. In Motive, click the Play button in the Timeline section.
Note: You can type the start and end frame ID numbers in the preset boxes at the bottom of
the Timeline section in Motive.
9. In the Record section of the Cue Module, click Stop.
Result: The Save to File dialog box appears.
10. Click Save to store the ﬁle in your speciﬁed location.
Result: The recorded frame is saved as a chapter content ﬁle (.rec) which will be used to
create the stack of cues.
To create the chapters cue stack in recording mode
1. In the Chapter Content section of the Cue Module, type the ﬁle name and path of the recorded
Frame in the File box or click the browse button to locate and select the recorded Frame that you
want to create as a chapter in the cue stack list.
2. In the Chapter Id box, enter the number for the chapter you want to create. The Chapter ID number
will correspond and sync with the Chapter that you wish to recall and playback in the BlackTrax
GUI.
3. In the Name box, type the name that you want to add to the chapter that you will create.
4. Select the Loop checkbox to set the created chapter to play in a loop.
5. In the Delay (ms) box, you can type the length of time (in milliseconds) for the chapter to delay the
playback after it was triggered to start playing.
Result: The recorded Frames that were created as Chapters will be displayed in the table as
a stack of Chapter cues in series and sorted according to the Chapter ID number.
6. On the cue stack list of created Chapters, you can apply the following options:
Click Save List to save the current cue stack series of created Chapters as a BlackTrax Cue
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File (.bcf).
Click Load List to load the list of saved Chapters that was created and stored as a BlackTrax
Cue File (.bcf).
Click Create Chapter to add a Chapter that consists of the ﬁle that has been accessed in the
Chapter Content section.
Click Delete Chapter to remove the selected Chapter from the cue stack list.
Click Play to playback a selected Chapter from the cue stack list.
7. Click Recording Mode to toggle into Show Mode.
Result: The table will display the cue stack of Chapters in the table which will be played back
from the BlackTrax GUI. For example, when the Main GUI enters Chapter 1, Cue will also start
playing back the recorded ﬁle in Chapter 1 as well. When the Main GUI enters the Standby
Chapter or a Chapter that is not present in Cue, Cue will stop all playback. Editing and
playback from the Cue Module are disabled.

BlackTrax Wiki

275 of 298

5/14/2019

BlackTrax Device Manager
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Device Manager User Interface
Table of contents:
Introduction
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Introduction
The BlackTrax Device Manager is a software application where external hardware used in the
BlackTrax system can be accessed and managed directly through a PC.
In the Device Manager, ﬁrmware can be uploaded to the Charging Stations, Beacons, TimeKeepers
and Routers.
The Device Manager works with charging stations that are connected to the network.
When Device Manager launches, it opens to the last used layout by default. When Device Manager opens
for the ﬁrst time, the Main Panel, Device Settings, Charging Stations and System Log widgets are
displayed. The following section describes the various parts of the user interface.
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Layout of the BlackTrax Device Manager
GUI
The Device Manager displays the table of connected devices for TimeKeepers, Routers, and Beacons on
the Main panel, the docking widgets for Device Settings, Charging Stations, System Log and the Charging
Station Settings tab.
Main Panel: The Main panel (center area) of the Device Manager displays the table of connected devices
for TimeKeepers, Routers, and Beacons that are connected to the Device Manager.

Device Settings: The Device Settings widget displays the properties and settings for the control of the
devices connected to the Charging Station. Each device type (Beacon, TimeKeeper, Router) has unique
settings and properties. The Device Settings widget for each device type displays the diﬀerent settings.

Charging Stations: The Charging Stations widget displays identiﬁcation, ﬁrmware information, and status
of all connected remote charging stations for the BTBeacons. In the Charging Stations widget, you can
select and display a charging station, and the settings of the selected Charging Station will be displayed
in the Charging Station Settings widget.

Charging Stations Settings: The Charging Stations Settings widget is where you can conﬁgure the
settings of a selected remote Charging Station. When you select a Charging Station in the Charging
Stations widget, the settings of the selected Charging Station will be displayed in the Charging Stations
Settings widget.

System Log: The System Log widget displays the messages and data information from events that occur
in the Device Manager.
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Device Manager Menu Bar
Device Manager Menu Bar
The Menu Bar across the top of the interface is where you will ﬁnd menu commands to all functions of
the software. The diﬀerent menus are:
File: Closing the Device Manager.
Widgets: Access to all the docking widgets, advanced mode and reset view toggle.
Settings: Access to the Device Manager Conﬁguration module and the System Log widget.
Help: About information for the current release of Device Manager.
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Device Manager File Menu
Device Manager File Menu
The File menu is where you can close the Device Manager when you click File > Exit Device Manager.
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Device Manager Widgets Menu
Device Manager Widgets Menu

The Widgets menu provides:
Access to the dockable widgets: Device Settings, Charging Stations and Charging Stations Settings.
Close and reset functions.
Access to advance mode controls.
The docking widgets comprise of a 'ﬂoat' and 'close' function. Floating a widget will detach it from the
GUI, and allow you to drag it around the screen, or to another monitor. The close function will close the
widget, at which point you must re-open it from the Widgets menu.
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Device Manager Settings Menu
Device Manager Settings Menu
The Settings menu provides access to the Device Manager Conﬁguration module and the System Log
widget.
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Device Manager Help Menu
Device Manager Help Menu
The Help menu provides access to the About Device Manager dialog box with information about the
Device Manager, product version, and build number.
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Device Manager Widgets
Table of contents:
Main Panel
Device Settings
Charging Stations
Charging Station Settings
System Log
Device Manager Conﬁguration
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Main Panel of Device Manager
When Device Manager launches, it displays the table of connected devices for TimeKeepers, Routers, and
Beacons on the Main panel, and the docking widgets for Device Settings, Charging Stations, System Log,
and the Charging Station Settings tab.
The Main panel (center area) of the Device Manager displays the table of connected devices for the
TimeKeepers, Routers, and Beacons that are connected to the BlackTrax. Click on the Device Type Filter
drop-down to choose which type of device to display: All or TimeKeeper or Router or Beacon.
Note: TimeKeepers and Routers may be connected to a Charging Station via the USB port on the back of
the unit.
The Beacon, TimeKeeper, Router devices listed in the Main panel can each be selected and the settings
of the selected device will be displayed in the Device Settings widget and available for modiﬁcation. You
can also select multiple devices to apply several settings at once.

The conﬁguration settings displayed in the Main panel are:
Refresh Selection: Click this button to update the selection in the list.
Device Type Filter: Click this button to choose which type of device to display, All or TimeKeeper or
Router or Beacon.
ID: Identiﬁcation number of the Beacon device.
Type: The type of devices such as TimeKeeper, Router or Beacon. Click the column heading Type
to change the order of the list.
Status: If the device is Connected or Disconnected.
Station: Identiﬁcation of the charging station where the device is currently plugged, or USB if
plugged via USB.
Battery: Percentage level of the battery life.
Radio: Shows if the radio signal from the connected device is On or Oﬀ.
Version: The ﬁrmware version of the connected device.
Preset: Displays the assigned Preset number if the settings of the connected device match a
Preset conﬁguration or Custom if the settings have been modiﬁed.
Calibration: Indicates if the device is a calibration Beacon.
Notes: Displays packets of feedback information that is sent to the device for ﬁrmware upload.
Note: When a device is added to the list, it stays in the table, even if disconnected (will display status as
Closed). When a device is added again, it will compare device IDs to determine if the same device or not,
and will update its previous location in the table.

BlackTrax Wiki

286 of 298

5/14/2019

Device Manager Device Settings
The Device Settings widget displays the properties and settings for the control of the devices connected
to the Charging Stations. Each device type (Beacon, TimeKeeper, Router) has unique settings and
properties. The Device Settings widget for each device type displays diﬀerent settings.
When a device is selected in the Main Panel, the Device Settings widget will display the preset settings
by default.

Device Settings for a Beacon
To open device settings widget for a Beacon
1. In the Main Panel, click on the Beacon that you want to select.
Result: The Device Settings widget displays the settings of the selected Beacon.

Selected Device: The type and ID number of the selected Beacon.
Serial Number: The serial number of the selected Beacon.
Product Info: The additional information or name that was set to identify the selected Beacon.
To change the settings in device setting for a Beacon
1. On the Preset Beacon scroll box, click on the arrow and select the Preset Beacon number (or type a
new number, from 1-85).
2. Click Apply.
Result:
The default Beacon settings based on the selected Preset Beacon are applied to the
selected Beacon. Preset Beacon settings contain Beacon ID, Wireless Channel, Subnet,
LED Brightness, and other system level settings.
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration), or Custom when the settings of the Beacon were changed and currently
do not match a Preset Beacon.
3. Select the Calibration Beacon checkbox if the selected Beacon should be programmed as a
calibration unit. A Calibration Beacon automatically transmits signal packets faster.
Note: To unassign a Beacon as a Calibration Beacon, clear the checkbox and re-apply the
Preset Beacon.
4. On the Beacon ID scroll box, click the arrows and select a Beacon ID number (or type a new
number, from 1-85) if you want to customize the ID of the Beacon.
5. Click Apply.
Result: The Beacon ID number is changed and the Current Preset displays Custom.
6. On the Wireless Channel scroll box, click the drop-down list and select the Wireless Channel
number if you want to change the previously assigned Wireless Channel.
7. Click Apply.
Result: The Wireless Channel is changed and the Current Preset displays Custom.
8. On the Subnet scroll box, click the arrows and select the wireless Subnet number (or type a new
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number) that devices on the same Wireless Channel will use to communicate.
9. Click Apply.
Result: The Subnet is changed and the Current Preset displays Custom.
10. On the LED Brightness (ms) scroll box, click the arrows and select the length of exposure (in
milliseconds) (or type in a number, from 1-8) to increase or decrease the brightness of the LED.
11. Click Apply.
Result: The LED Brightness is changed and the Current Preset displays Custom.
Note: The increase in the level of LED Brightness will decrease the battery life of the Beacon
but may result in the LED being seen at farther distances. (Default = 3ms)
12. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected Beacon(s).
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
6. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a TimeKeeper
To open device settings widget for a TimeKeeper
1. In the Main Panel, click on the TimeKeeper that you want to select.
Result: The Device Settings widget displays the settings of the selected TimeKeeper.
Selected Device: Displays TimeKeeper.
Serial Number: The serial number of the selected TimeKeeper.
Product Info: The additional information or name that was set to identify the selected
TimeKeeper.
To change the settings in device settings for a TimeKeeper
1. Click on the Wireless Channel drop-down arrow and select the Wireless Channel number from the
drop-down list if you want to change the previously assigned Wireless Channel.
2. Click Apply.
3. On the Subnet scroll box, click the arrows and select the Subnet number (or type a new number)
that devices on the same Wireless Channel will use to communicate.
4. Click Apply.
5. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected TimeKeeper(s).
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To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into the memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
6. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)

Device Settings for a Router
To open device settings widget for a Router
1. In the Main Panel, click on the Router that you want to select.
Result: The Device Settings widget displays the settings of the selected Router.
Selected Device: Displays Router.
Serial Number: The serial number of the selected Router.
Product Info: The additional information or name that was set to identify the selected Router.
To change the settings in device settings for a Router
1. Click on the Wireless Channel drop-down arrow and select the Wireless Channel number from the
drop-down list if you want to change the previously assigned Wireless Channel.
2. Click Apply.
3. On the Subnet scroll box, click the arrows and select the Subnet (or type a new number) that
devices on the same Wireless Channel will use to communicate.
4. Click Apply.
5. In the Loaded Firmware section, a device ﬁrmware can be located, selected and uploaded into
the selected Router(s).
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into the memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update is complete, a checksum is performed to verify the upload.
5. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
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Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)
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Device Manager Charging Stations
The Charging Stations widget displays identiﬁcation, ﬁrmware information, and status of all connected
remote charging stations for the BTBeacons. In the Charging Stations widget, you can select and display
a charging station, and the settings of the selected Charging Station will be displayed in the Charging
Station Settings widget.

The Charging Stations widget displays the following settings:
Connect: Click this button to connect the newly added Charging Station.
Get Beacon List: Click this button to poll the Charging Station for all connected Beacons and add
them to the main list.
ID: Identiﬁcation number of the Charging Station in the range between 101 to 254. The default ID
number is 201. The ID will always match the last octet of the IP Address (ID 201 = 10.133.5.201).
Serial Number: The serial number of the hardware.
IP Address: The network IP address where the Charging Station is connected.
Status: Connected or Disconnected.
Version: Firmware version.
Notes: Other information.
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Device Manager Charging Station
Settings
The Charging Stations Settings widget is where you conﬁgure the settings of a selected remote Charging
Station. When you select a Charging Station in the Charging Stations widget, the settings of the selected
Charging Station will be displayed in the Charging Station Settings widget.

Selected Device: Identiﬁcation number of the selected Charging Station.
CS ID/IP: Select the Charging Station ID from the drop-down, then click Apply.
Loaded Firmware: In this section, a device ﬁrmware can be located, selected and uploaded into
the selected Charging Station.
To upload a ﬁrmware
1. Click Browse and select the ﬁrmware ﬁle and load into the memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update is complete, a checksum is performed to verify the upload.
5. When checksum is complete, the device reboots.
Status: Displays the current state of the ﬁrmware in the selected device.
Not Ready (no ﬁle loaded)
Ready (ﬁle loaded/previous ﬂash complete)
Preparing...(jumping to boot loader)
Flashing...(Actually ﬂashing the device)
Verifying...(checksum)
Finishing up...(jumping to main)
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Device Manager System Log
Data collected from events which occur in the Device Manager, such as system messages, conﬁguration
changes, and other events can be displayed in the System Log widget. This information can be saved
into a separate ﬁle for review later.
The System Log widget displays the date and time of the event, type of data, and the information.

In the System Log widget, the checkboxes available to choose what and how messages are displayed or
logged.
Warnings/Errors Only: Select this checkbox to log and display only the notiﬁcations that
indicate errors that occurred or predictive warnings.
To File: Select this checkbox to record all Device Manager data and events into a remote ﬁle,
marked with the current date and time. This ﬁle is saved at "C:\bt_run_time\Device Manager".
Auto Scroll: Select this checkbox to automatically scroll to the most recent data or event that has
occurred.
Clear: Click this button to clear all messages.
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Device Manager Conﬁguration
The Device Manager Conﬁguration widget is where you can conﬁgure the settings for the Device
Manager application, such as Beacon LED Bit Pattern, Radio Status, and the Charging Station Network
Address.

To conﬁgure the settings of the device manager
1. From the Settings menu of the Device Manager, choose Device Manager Conﬁguration.
Result: The Device Manager Conﬁguration window appears.
2. On the LED Bit Pattern scroll box in the Device Manager Conﬁguration window, select the LED Bit
Type that will apply to the Beacons connected to the Device Manager.
Attention: Beacon LEDs are identiﬁed by ﬂashing a speciﬁc bit code unique to that LED.
Higher Beacon indexes can be created with the higher bit codes (thus more Beacons) which
will add more latency to the system. A real system is based on 12-bits.
3. Select the Radio On checkbox to indicate when a device is connected that its radio should stay on.
Radio On checkbox is clear by default.
4. The jump settings scroll box displays how the Device Manager behaves when a new device is
connected to the Charging Station. These jump settings are accessible in Advanced Mode.
No Jump: By default, the device will apply whatever it's ﬁrmware is set to.
Jump to Bootloader: Device Manager sets the device to jump to its bootloader.
Jump to Main Firmware: Device Manager sets the device to jump to the main ﬁrmware.
5. On the CS NIC Address scroll box, select the address for the Network Interface Card for the
Charging Station that is connected to the BlackTrax System. Charging Stations are locked to the
10.133.5.x network.
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Common Functions of the Device
Manager
To set preset Beacons
The use of Preset Beacon numbers acts as an easy and convenient way to conﬁgure all perimeters of
Beacons without manually entering all settings.
1. Connect the Charging Station to the BlackTrax System.
2. Open the Device Manager.
Note: All devices that are connected to the Charging Station are displayed in the Device
Manager automatically showing the connection status and preset settings.

3. From the table in the Main panel of the Device Manager, select a Beacon.
Result: The Device Settings widget displays the settings (default preset or previously set
custom settings) of the selected Beacon.

4. On the Preset Beacon scroll box of the Device Settings widget, scroll and select the Preset Beacon
number.
5. Click Apply.
Result: All the pre-programmed settings associated with Preset Beacon number is applied to
the selected Beacon.
Note:
Current Preset displays the current preset settings under a preset Beacon ID (i.e. 3,
Calibration).
You may select several Beacons which assigns all Beacons with a diﬀerent preset
number, incrementing by 1.
6. Select the Calibration Beacon checkbox if you want to set the Beacon as a calibration unit.
Result: The Calibration Beacon is set at Time Slot 1 and IMU is enabled. A Calibration Beacon
automatically transmits signal packets faster.
Note: To unassign a Beacon as a Calibration Beacon, you must uncheck the checkbox and
re-apply the Preset Beacon.
Example of the Preset Beacon settings:
Current Preset: 2
Wireless Channel: 26
Subnet: 35
LED Brightness: 3ms

To upload ﬁrmware from device settings
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1. In the Device Settings widget of a selected device, click Browse and select the ﬁrmware ﬁle and
load into memory.
2. Click Upload.
Result: The upload proceeds and the ﬁrmware upload process is displayed in the Status
section.
3. Device Manager checks if the selected device matches the ﬁrmware.
4. The ﬁrmware update begins.
5. When ﬁrmware update is complete, a checksum is performed to verify the upload.
6. When checksum is complete, the device reboots.
7. Status resets to display "Ready" if a ﬁle is loaded, or "Not Ready" if no ﬁle is loaded.

To program charging stations
When Device Manager opens, all devices that are connected to the Charging Station are automatically
displayed in the Device Manager widget showing the connection status and the latest applied settings.

1. Select a Charging Station from the list in the Charging Stations widget.
Result: The Charging Station Settings widget displays the identiﬁcation number of the
selected Charging Station. The ID number includes the network address information.

2. If you added or replugged a Charging Station to the system, click Connect to check the network for
any Charging Station on the system.
Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you may need to enable the connection again.
3. If you added or replugged a Charging Station with Beacons, click Get Beacon List to poll the
Charging Stations and update the main list with any connected Beacons.
Note: When you add a new Charging Station into the system or if the Charging Station was
unplugged from the system, you may need to refresh the list of devices connected to the
Charging Station.

To upload ﬁrmware from charging station settings
1. Select a Charging Station from the Charging Stations widget.
Result: The Charging Station Settings widget displays the settings of the selected Charging
Station.
2. In the Charging Station Settings widget of the selected Charging Station, click Browse and select
the ﬁrmware ﬁle and load into memory.
3. Click Upload.
4. Device Manager checks if the ﬁrmware matches the selected device and proceeds to update.
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Health and Safety Information
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BTBeacon Lithium-Ion Battery
Information
The BTBeacon contains a rechargeable lithium-ion battery that is used to power the device. Improper use
of a lithium-ion battery can result in ﬁre or serious injury. Please read and understand the following
general warnings on lithium-ion batteries.

General Warnings
Do not place the battery near ﬁre, heaters, other high temperature locations, or apply heat to the
device.
Do not pierce the battery with any sharp objects, strike with heavy objects, or otherwise damage
the casing.
Do not expose the battery to water or any other type of liquid, or allow the device to get wet.
Never short-circuit, damage or heat the battery to approximately 60°C (140°F) ±.
If the lithium-ion battery does catch ﬁre, it may burn even more violently if it comes into contact
with water or moisture in the air. DO NOT THROW WATER ON A BURNING BATTERY OR ITS LITHIUMION BATTERY! A ﬁre extinguisher must be used.

Shipping Information
When transporting lithium-ion batteries, the following regulatory guidelines are followed:
Section II of Packing Instructions PI965 for Lithium Ion Battery Pack.
UN manual of Tests and Criteria, Part III, sub-section 38.3 (withstanding a 1.2m drop test).
The content of Lithium is less than 100Wh per battery.
The quantity per package is less then 10kg (gross) for UN3480. Thus the consignment is not
classiﬁed as dangerous goods.
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